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Section 1
Introduction

This manual describes the switch management tools which include the SANbox® 
Manager application (version 2.0) and the Command Line Interface (CLI) for the 
SANbox2®-64 Fibre Channel switch (firmware version 2.0). The SANbox 
Manager switch management application is the primary focus of this manual 
which is organized as follows:

Section 1 describes the intended audience for this manual, related 
materials, and technical support.
Section 2 describes how to use SANbox Manager, its menus, and its 
displays.
Section 3 describes fabric management tasks.
Section 4 describes switch management tasks.
Section 5 describes I/O blade management tasks.
Section 6 describes port and device management tasks.
Appendix A describes the Telnet command line interface.
Appendix B describes the optional performance monitoring application, 
Fabric View.

A glossary of terms and an index are also provided.

1.1
Intended Audience

This manual introduces the switch management products and explains their 
installation and use. It is intended for users responsible for installing and using 
switch management tools.

1.2
Related Materials

Refer to the following manuals for information about switch hardware and 
installation.

SANbox2-64 Fibre Channel Switch Installation Guide, publication number 
59043-02.
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1.3
Technical Support

Customers should contact their authorized maintenance provider for technical 
support of their QLogic switch products. QLogic-direct customers may contact 
QLogic Technical Support; others will be redirected to their authorized 
maintenance provider.

Visit the QLogic support Web site listed in Contact Information for the latest 
firmware and software updates.

1.3.1
Availability

QLogic Technical Support is available from 7:00 AM to 7:00 PM Central Standard 
Time, Monday through Friday, excluding QLogic-observed holidays.

1.3.2
Training

QLogic offers certification training for the technical professional for both the 
SANblade HBAs and the SANbox2 switches. From the training link at 
www.qlogic.com, you may choose Electronic-Based Training or schedule an 
intensive "hands-on" Certification course.

Technical Certification courses include installation, maintenance and 
troubleshooting QLogic SAN products. Upon demonstrating knowledge using live 
equipment, QLogic awards a certificate identifying the student as a Certified 
Professional. The training professionals at QLogic may be reached by email at 
tech.training@qlogic.com 

1.3.3
Contact Information

Address: QLogic Corporation
6321 Bury Drive
Eden Prairie, Minnesota 55346-1739
USA

Telephone: +1 952-932-4040

Fax: +1 952-932-4018

Email:
Technical Service
Technical Training

support@qlogic.com
tech.training@qlogic.com

QLogic Web Site: www.qlogic.com

Technical Support Web Site: http://support.qlogic.com

support.qlogic.com
http://www.qlogic.com
http://www.qlogic.com
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Section 2
Using SANbox Manager

This section describes how to use the SANbox Manager application and its 
menus. The following topics are covered:

Installing SANbox Manager
Starting SANbox Manager
Exiting SANbox Manager
Changing the password for the default fabric view file
Setting SANbox Manager user preferences
Using online help
SANbox Manager user interface
Using the topology display
Using the faceplate display

2.1
Installing SANbox Manager

The SANbox Manager application requires a management workstation with the 
characteristics described in Figure 2-1.

Table 2-1. Management Workstation Requirements

Operating System Windows® NT, 2000, 95/98
Linux® 7.2 Red Hat®
Solaris™

Memory 128 MB or more

Disk Space 150 MB per installation

Processor 300 MHz or faster

Hardware CD-ROM drive, RS-232 serial port, RJ-45 Ethernet port

Internet Browser Microsoft® Internet Explorer® or Netscape Navigator®
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Your switch was shipped with either a SANsurfer Management Suite Disk or a 
SANbox2 Installation Disk. Refer to the following installation instructions that 
correspond to your situation:

SANsurfer Management Suite Disk - Windows Installation
SANsurfer Management Suite Disk - Linux Installation
SANsurfer Management Suite Disk - Solaris Installation
SANbox2 Installation Disk - Windows Installation
SANbox2 Installation Disk - Linux Installation
SANbox2 Installation Disk - Solaris Installation

2.1.1
SANsurfer Management Suite Disk - Windows Installation

To install the SANbox Manager application on Windows from the SANsurfer® 
Management Suite Disk, do the following:

1. Close all programs currently running, and insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If the 
SANsurfer Management Suite start page does not open in your default 
browser, do the following:
a. Using Windows Explorer, double-click the drive letter which contains 

the SANsurfer Management Suite Disk. 
b. Locate and double-click the Start_Here.htm file to open the SANsurfer 

Management Suite start page in your default browser.
2. On the SANsurfer Management Suite start page, choose the SANbox 

Switch Software button.
3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 

area. 
4. In the Windows column, choose the SANbox Manager link to open the File 

Download window.
5. You have a choice of running the installation file from the CD-ROM or 

downloading the installation file to your hard drive. Choose one of the 
following:

Open the installation file from the CD-ROM and follow the SANbox 
Manager installation instructions.
Specify a location in which to save the 
sansurfer_windows_install.exe file, and choose the Save button. 
Double-click the saved sansurfer_windows_install.exe file and 
follow the SANbox Manager installation instructions.
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2.1.2
SANsurfer Management Suite Disk - Linux Installation

To install the SANbox Manager application on Linux from the SANsurfer 
Management Suite Disk, do the following:

1. Close all programs currently running, and insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If a file browser 
dialog opens showing icons for the contents of the CD-ROM, double-click 
the Start_Here.htm file to open the SANsurfer Management Suite start 
page. If a file browser does not open, double-click the CD-ROM icon on the 
to open the browser. If there is no CD-ROM icon, do the following:
a. Open an xterm or other terminal window.
b. Mount the CD-ROM. From a shell prompt, enter the following 

command:
mount /mnt/cdrom

c. Execute your web browser to view the Start_Here.htm document 
using one of the following commands:
$mozilla file:/mnt/cdrom/Start_Here.htm

or
$netscape file:/mnt/cdrom/Start_Here.htm

d. The SANsurfer Management Suite start page opens in your default 
browser.

2. On the SANsurfer Management Suite start page, choose the SANbox 
Switch Software button.

3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 
area. 

4. In the Linux column, choose the SANbox Manager link to open the Save As 
dialog.

5. Enter a path name to save the sansurfer_linux_install.bin file, and choose 
the Save button.

6. Open a terminal window for the directory in which the 
sansurfer_linux_install.bin file was saved, and enter the following 
command and press the Enter key: 

chmod +x sansurfer_linux_install.bin

7. Enter the following command:
./sansurfer_linux_install.bin

8. Press the Enter key, and follow the SANbox Manager installation 
instructions.



2 – Using SANbox Manager
Installing SANbox Manager

2-4 59048-02 A

Q

2.1.3
SANsurfer Management Suite Disk - Solaris Installation

To install the SANbox Manager application on Solaris from the SANsurfer 
Management Suite CD-ROM, do the following:

1. Close all programs currently running, and insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If the 
SANsurfer Management Suite start page does not open in your default 
browser, do the following: 
a. Right-click the to open the Workshops Menu.
b. Point to and select Files, then select File Manager.
c. In File Manager, double-click the CD-ROM icon, and then double-click 

the Sansurfer folder.
d. In the Sansurfer folder, double-click the Start_Here.htm file to open 

the SANsurfer Management Suite start page in your default browser.
2. On the SANsurfer Management Suite start page, choose the SANbox 

Switch Software button.
3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 

area.
4. In the Solaris column, choose the SANbox Manager link to open the Save 

As dialog.
5. Enter a path name to save the sansurfer_solaris_install.pkg file and 

choose the Save button.
6. Open a terminal window for the directory in which the 

sansurfer_solaris_install.pkg file was saved, and enter the following 
command: 

chmod +x sansurfer_solaris_install.pkg

7. Enter the following command and follow the SANbox Manager installation 
instructions.

pkgadd -d QLGCsol_x.x.yyyy.mm.dd.xx.xx

Note: If you download SANbox Manager from a server, be sure the 
downloaded file has execute permission before installing. 
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2.1.4
SANbox2 Installation Disk - Windows Installation

To install the SANbox Manager application on Windows from the SANbox2 
Installation Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Using Windows Explorer, double-click the drive letter which contains the 
SANbox2 Installation Disk.

3. Double click the SANbox_Manager folder, then double click the Windows 
folder.

4. Double click the executable file and follow the SANbox Manager installation 
instructions.

2.1.5
SANbox2 Installation Disk - Linux Installation

To install the SANbox Manager application on Linux from the SANbox2 Installation 
Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Open the File Manager and double-click on the CD-ROM icon.
3. Double click the SANbox_Manager folder, then double click the Linux folder.
4. Double click the executable file and follow the SANbox Manager installation 

instructions.

2.1.6
SANbox2 Installation Disk - Solaris Installation

To install the SANbox Manager application on Solaris from the SANbox2 
Installation Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Open a terminal window. If the disk isn’t already mounted, enter the 
following command:

mount /mnt/cdrom

3. Move the directory on the disk that contains the executable. Enter the 
following command:

cd cdrom/cdrom0/sanbox~1/solaris

4. Run the executable and follow the SANbox Manager installation instructions. 
Enter the following command:

pkgadd -d sol_pkg
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2.2
Starting SANbox Manager

To start the SANbox Manager application for the first time, choose one of the 
following methods:

For a Windows platform, double-click the SANbox Manager shortcut, or 
select SANbox Manager from Start menu, depending on how you installed 
the SANbox Manager application. From a command line, you can enter the 
SANbox_Manager command:
<install_directory>\SANbox_Manager\sanbox_manager.exe

For a Linux platform, enter the SANbox_Manager command:
/SANbox_Manager/SANbox_Manager

For a Solaris platform, enter the SANbox_Manager command:
/usr/opt/QLGCsol/bin/SANbox_Manager

The application opens with the Initial Start dialog shown in Figure 2-1. If you prefer 
not to see this dialog, Check the Don’t show this dialog again box. This has the 
same effect as disabling the Display Initial Startup Dialog preference. Refer to 
”Setting SANbox Manager Preferences” on page 2-11 for information about 
setting preferences.

Figure 2-1.  Initial Startup Dialog
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Choose Open Existing Fabric to open the Add a New Fabric dialog, which 
prompts you for an fabric name, IP address, account name, and password. 
Refer to ”Adding a Fabric” on page 3-3.
Choose Open Existing Fabric View File to open the Open View dialog 
which prompts you to specify a fabric view file that you saved earlier. Refer 
to ”Opening a Fabric View File” on page 3-4.
Choose Start Application Without Specifying a Fabric to open the 
SANbox Manager window shown in Figure 2-2.

Figure 2-2.  SANbox Manager Window
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2.3
Exiting SANbox Manager

To exit a SANbox Manager application session, open the File menu and select 
Exit. If you have made changes to the view, the Save Default Fabric File dialog, 
shown in Figure 2-3, prompts you to save the view as the default fabric view file. 
You may also enter a password with which to protect the default fabric view file, 
but a password is not required. Refer to ”Changing the SANbox Manager Default 
Fabric File Password” on page 2-10 for information about changing this password. 
Choose one of the following:

Enter a password in the Default File Password field or leave it blank and 
choose the Save View File button. This saves the current set of fabrics in 
the default fabric view file in the working directory.
Choose the Exit Without Saving button to exit the application without 
saving the current fabrics to the default fabric view file.
Choose the Cancel Exit button to cancel the exit operation.

Figure 2-3.  Save Default Fabric File Dialog – SANbox Manager

In your next SANbox Manager session, the Load Default Fabric File dialog shown 
in Figure 2-4 prompts you to load the default fabric view file and to specify its 
password if there is one.

Figure 2-4.  Load Default Fabric File Dialog – SANbox Manager

To prevent SANbox Manager from prompting you to load and save the default 
fabric view file between SANbox Manager sessions, set the View File Auto Save 
and Load preferences setting to Disable (Enable is the default). Refer to ”Setting 
SANbox Manager Preferences” on page 2-11 for more information.
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2.4
Uninstalling SANbox Manager

A program to uninstall SANbox Manager was installed as part of the SANbox 
Manager installation process. The Uninstaller Data folder in the Install folder 
contains the uninstall program (Uninstall SANbox Manager). Also, a shortcut/link 
to the uninstall program was installed in the installation directory during the 
SANbox Manager installation process. The default installation directory is
/QLogic_Corporation/SANbox_Manager.

To uninstall the SANbox Manager application, do the following:

For Windows, browse for the uninstall program file or the shortcut/link that 
points to the uninstall program file. The uninstall program shortcut is in the 
same folder as the program shortcut (Start menu, program group, on, or 
user specified) that is used to start the SANbox Manager application. 
Double-click the uninstall program file or shortcut/link, and follow the 
instructions to uninstall the SANbox Manager application.
For Linux, execute the link to Uninstall_SANbox_Manager. If no links were 
created during the installation, enter the following command where 
INSTALL_DIR is the directory selected for installation:

$INSTALL_DIR/UninstallerData/Uninstall_SANbox_Manager

For Solaris, enter the following command and follow the instructions to 
uninstall the SANbox Manager application:

pkgrm QLGCsol
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2.5
Changing the SANbox Manager Default Fabric File Password

To change the password for the default fabric view file, do the following:

1. Open the File menu and select Change Default File Password to open the 
Set New Password dialog as shown in Figure 2-5.

Figure 2-5.  Set New Password Dialog – SANbox Manager Fabric File

2. Enter the new password in the Default File Password field.
3. Re-enter the same password in the Re-enter Password to Confirm field.
4. Choose the OK button to save the changes.

2.6
Saving and Opening SANbox Manager Fabric View Files

In addition to the SANbox Manager default fabric view file, you can save and open 
your own fabric view files. To save a set of fabrics in a fabric view file, do the 
following:

1. Open the File menu and select Save View As to open the Save View dialog.
2. Enter a name for the fabric file or choose the Browse button to select an 

existing file. Files are saved in the working directory.
3. Enter a password. When you attempt to open this fabric file, you will be 

prompted for this password. If you leave the File Password field blank, no 
password will be required.

To open a fabric view file, do the following:

1. Open the File menu and select Open View File to open the Open View 
dialog.

2. Enter a name for the fabric file or choose the Browse button to select an 
existing file.
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2.7
Setting SANbox Manager Preferences

Using the preferences settings, you can:

Change the location of the working directory in which to save files
Change the location of the browser used to view the online help.
Choose the fabric discovery interval. The fabric discovery interval is how 
often the SANbox Manager application receives information from the fabric. 
Choose 30, 45, or 60 seconds.
Enable or disable the default view file auto save and load feature. Refer to 
”Exiting SANbox Manager” on page 2-8 for more information on the default 
fabric view file.
Enable or disable the use of the Initial Start Dialog at the beginning of a 
SANbox Manager session. Refer to ”Starting SANbox Manager” on page 2-6 
for information about the Initial Start Dialog.
Enable or disable the Event Browser. Refer to ”Displaying the Event 
Browser” on page 3-9.
Choose the default port view when opening the faceplate display. You can 
set the faceplate to reflect the current port mode, port speed, port 
operational state, or port transceiver media. Refer to the corresponding 
subsection for more information:

”Displaying Port Modes” on page 6-2
”Displaying Port Operational States” on page 6-3
”Displaying Port Speeds” on page 6-3
”Displaying Transceiver Media Status” on page 6-4

Figure 2-6.  Preferences Dialog – SANbox Manager
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To set preferences for your SANbox Manager sessions, do the following:

1. Open the File menu, and select Preferences to open the Preferences 
dialog.

2. Enter or browse for paths to the working directory and browser.
3. In the Application-wide Options area, choose the preferences you want.
4. Choose the Apply button to save the changes.

2.8
Using Online Help

Online help is available for the SANbox Manager application and its functions. 
The two ways to open the online help file are: open the Help menu and select 
Help Topics, or choose the Help button in the tool bar. You can also display 
context-sensitive help for all SANbox Manager dialogs by choosing the Help 
button in the dialog.

2.9
Viewing Software Version and Copyright Information

To view SANbox Manager software version and copyright information, open the 
Help menu and select About.... 

2.10
SANbox Manager User Interface

The SANbox Manager application uses two basic displays to manage the fabric 
and individual switches: the topology display and the faceplate display. The 
topology display shows all switches that are able to communicate and all 
connections between switches. The faceplate display shows the front of a single 
switch and its ports. Both displays share some common elements as shown in 
Figure 2-7.
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Figure 2-7.  SANbox Manager Display Elements

2.10.1
Menu Bar

The Menu Bar presents the SANbox Manager menus as shown in Figure 2-8. The 
menus and the tasks offered in them vary depending on the display. For example, 
the Port menu and many of the Switch menu selections, shown in gray, appear 
only in the faceplate display.

Menu 
Bar

Faceplate 
Display

Data Window 
Tabs

Topology 
Display

Tool Bar

Working Status 
Indicator

Data 
Window
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Figure 2-8.  SANbox Manager Menu Structure

In addition to the menu bar, both the topology and faceplate displays have context 
sensitive menus that pop up when you click in the graphic window with the right 
mouse button. Refer to ”Opening the Faceplate Display and Topology Popup 
Menus” on page 2-21 for more information about these popup menus.

Delete
Export Name Server
Switch Properties...
Network Properties...
Archive...
Restore...
Load Firmware...
Firmware Fallback...
Set Date/Time...
Hot Swap Wizard...
� Toggle Beacon
Export Alarm Log...
Configure Alarm Thresholds...
Reset Switch
Restore Factory Defaults 

Refresh
Layout Topology
� Toggle Auto Layout
Remember Layout
View Port Modes
View Port States
View Port Speeds
View Port Media

Fabric

Add Fabric...
Remove Fabric
Rediscover Fabric
Start Fabric View

ViewZoningBlade

File

Open View File...
Save View As...
Change Default File Password...
Preferences...
Exit

Help

Help Topics
About...

Blade Properties
Test Blade
Reset Blade

Edit Zoning...
Edit Zoning Config...
Activate Zone Set...
Deactivate Zone Set
Restore Default Zoning

Switch

Port

Port Properties...
Extended Credits...
Reset Port
Port Loopback Test...
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Most menu selections have shortcut keys as shown in Table 2-2.

Table 2-2. Menu Shortcut Keys

Shortcut Selection Shortcut Selection

Ctrl+O
Alt+F+O

File>Open View File Alt+S+F Switch>Firmware Fallback

Alt+F+A File>Save As Alt+S+E Switch>Reset Switch

Alt+F+D File>Change Default File 
Password

Alt+S+S Switch>Restore Factory 
Defaults

Alt+F+P File>Preferences Alt+P+R Port>Port Properties

Alt+F+X File>Exit Alt+P+C Port>Ext Credit Wizard

Alt+B+R Fabric>Remove Fabric Alt+P+N Port>Port Symbolic Name

Alt+B+D Fabric>Rediscover Fabric Alt+P+T Port>Reset Port

Alt+B+E Fabric>Show Event Browser Alt+P+L Port>Port Loopback Test

Alt+S+D Switch>Delete Alt+Z+E Zoning>Edit Zoning

Alt+S+E Switch>Export Name Server Alt+Z+C Zoning>Edit Zoning Config

Alt+S+A Switch>Archive Alt+Z+A Zoning>Activate Zone Set

Alt+S+R Switch>Restore Alt+Z+D Zoning>Deactivate Zone Set

Alt+S+U Switch>User Accounts Alt+Z+R Zoning>Restore Default Zoning

Alt+S+D Switch>Set Date/Time Alt+V+R
F5

View>Refresh

Alt+S+H Switch>Temperature 
Thresholds

Alt+S+W Switch>Switch Properties

Alt+S+N Switch>Network Properties

Alt+S+G Switch>Toggle Beacon

Alt+S+C Switch>Configure Alarm 
Thresholds

Alt+S+L Switch>Load Firmware

Alt+S+V Switch>Activate Firmware
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2.10.2
Tool Bar

The tool bar consists of a row of graphical buttons that you can use to access 
SANbox Manager functions as shown in Table 2-3. The tool bar buttons are an 
alternative method to using the menu bar. The tool bar can be relocated in the 
display by clicking and dragging the handle at the left edge of the tool bar.

Table 2-3. Tool Bar Buttons 

Tool Bar Button Description

Add Fabric button - adds a new fabric. 

Open View File button - opens an existing fabric view file. 

Save View As button - saves the current fabric view to a file.

Refresh button - updates the topology or faceplate display with 
current information.

Events Browser button - opens the events browser.

Help Topics button - opens the online help file.

Edit Zoning button - opens the Edit Zoning dialog (available only in 
faceplate display).

The QLogic logo opens a link to the QLogic web site.
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2.10.3
Fabric Tree

The fabric tree lists the managed fabrics and their switches as shown in 
Figure 2-9. The window width can be adjusted by clicking and dragging the 
moveable window border. An entry handle located to the left of an entry in the tree 
indicates that the entry can be expanded. Click this handle or double-click the 
entry to expand or contract a fabric tree entry. A fabric entry expands to show its 
member switches.

Figure 2-9.  Fabric Tree

Each fabric tree entry has a small icon next to it that uses color to indicate 
operational status.

A green icon indicates normal operation.
A yellow icon indicates that a switch is operational, but may require attention 
to maintain maximum performance.
A red icon indicates a potential failure.
A blue icon indicates that a switch is unknown, unreachable, unmanageable, 
or a switch with security enabled when the fabric management switch has 
security disabled.

The fabric tree provides access to the topology and faceplate displays for any 
fabric or switch.

To open the topology display from the fabric tree, click a fabric entry.
To open the faceplate display from the fabric tree, click a switch entry.

Switch Entries Moveable 
Window Border

Entry Handle

Fabric Entry
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2.10.4
Graphic Window

The graphic window presents graphic information about fabrics and switches such 
as the fabric topology and the switch faceplate. The window length can be 
adjusted by clicking and dragging the window border that it shares with the data 
window.

2.10.5
Data Window and Tabs

The data window presents a table of data and statistics associated with the 
selected tab. Use the scroll bar to browse through the data. The window length 
can be adjusted by clicking and dragging the border that it shares with the graphic 
window.

Adjust the column width by moving the pointer over the column heading border 
shared by two columns until a right/left arrow graphic is displayed. Click and drag 
the arrow to the desired width.

The data window tabs present options for the type of information to display in the 
data window. These options vary depending on the display.

2.10.6
Working Status Indicator

The working status indicator, located in the lower right corner of SANbox Manager 
window, shows when the management workstation is exchanging information with 
the fabric. As conditions change, the fabric forwards this information to the 
management workstation where it is reflected in the various displays.
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2.11
Using the Topology Display

The topology display shown in Figure 2-10 receives information from the selected 
fabric and displays its topology. Switches and inter-switch links (ISL) appear in the 
graphic window and use color to indicate status. Consider the following topology 
display features:

Switch and link status
Working with switches and links
Topology data windows

Figure 2-10.  Topology Display

2.11.1
Switch and Link Status

Switch icon shape and color provide information about the switch and its 
operational state. Lines represent links between switches. The topology display 
uses green to indicate normal operation, yellow to indicate operational with errors, 
red to indicate a potential failure, and blue to indicate unknown, unreachable, or 
unmanageable. Refer to ”Fabric Status” on page 3-7 for more information about 
topology display icons.
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2.11.2
Working with Switches and Links

Switch and link icons are selectable and moveable, and serve as access points for 
other displays and menus. You select switches and links to display information 
about them, modify their configuration, or delete them from the display. The 
context-sensitive popup menus are accessible through the switch and link icons.

2.11.2.1
Selecting Switches and Links

Selected switch icons are highlighted in blue. Selected ISLs are displayed as a 
heavier line. You can select switches and links in the following ways:

To select a switch or a link, click the icon or link.
To select multiple switches or links, hold down the Control key and select.
To select all switches or links, right-click anywhere in the graphic window 
background. Select Select All Switches or Select All Links from the popup 
menu.

To cancel a selection, press and hold the Control key, and select the item again. 
To cancel all selections, click in the graphic window background.

2.11.2.2
Arranging Switches in the Display

You can arrange individual switch icons in the topology display or allow SANbox 
Manager to arrange all switch icons for you:

To move an individual switch icon, click and drag the icon to another location 
in the graphic window. Links stretch or contract to remain connected.
To arrange all switch icons in the topology display automatically, open the 
View menu and select Layout Topology.

By default, the Toggle Auto Layout box in the View menu is checked which 
causes SANbox Manager to arrange the icons when you select Layout 
Topology.

You can save a custom arrangement, or layout, and restore that layout during a 
SANbox Manager session. Begin by arranging the icons, then open the View 
menu and select Remember Layout. To restore the saved layout, open the View 
menu, uncheck the Toggle Auto Layout box, and select Layout Topology.
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2.11.2.3
Opening the Faceplate Display and Topology Popup Menus

The faceplate display shows the front of a single switch and its ports. To open the 
faceplate display when viewing the topology display, click the switch entry/icon in 
the fabric tree, or double-click the switch graphic.

The Topology display also offers a fabric, switch, and a link popup menu:

To open the fabric popup menu, right-click the graphic window background. 
The fabric popup menu presents selections to refresh the fabric, select all 
switches, select all links, or layout topology.
To open the switch popup menu, right-click the switch icon in the graphic 
window. The switch popup menu presents selections to refresh the switch, 
delete the switch from the display, open the Switch Properties dialog, or 
open the Network Properties dialog.
To open the link popup menu, right-click the link. The Link popup menu 
presents a selection to delete the link from the display.

2.12
Topology Data Windows

The topology display provides the following data windows corresponding to the 
data window tabs:

Name Server – displays all devices logged with the name server and their 
addresses within the current fabric configuration. Refer to ”Name Server 
Data Window” on page 4-6 for more information.
Active Zoneset – displays the active zone set for the fabric including zones 
and their member ports. Refer to ”Active Zone Set Data Window” on page 3-
12 for more information about this data window. Refer to ”Zoning a Fabric” 
on page 3-13 for information about zone sets and zones.
Switch – displays current network and switch configuration data for the 
selected switches. Refer to ”Switch Data Window” on page 4-6 for more 
information.
Link – displays information about the inter-switch links. Refer ”Link Data 
Window” on page 4-9 to for more information.
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2.13
Using the Faceplate Display

The faceplate display shown in Figure 2-11 displays the switch name and 
operational state, and port status. Consider the following functional elements of 
the faceplate display:

I/O blades
Port views and status
Working with I/O blades and ports
Faceplate data windows

Figure 2-11.  Faceplate Display

2.13.1
I/O Blades

Figure 2-11 shows how slots appear in the faceplate display with and without 
installed I/O blades. I/O blade failure status is indicated by a status icon as shown 
in Figure 2-11. The SANbox2-64 switch numbers its slots from 0–10 from left to 
right. I/O blades occupy slots 1–4 and 6–9. Ports on an I/O blade are numbered 
from 0–7 from top to bottom in slot 1, 8–15 in slot 2, and so on to 56–63 in slot 9. 
The Blade Info data window assigns blade numbers 0–7 to slot numbers 1–4 and 
6–9.

Empty SlotsI/O Blades I/O Blade 
Status
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2.13.2
Port Views and Status

Port color and text provides information about the port and its operational state. 
Green indicates active; gray indicates inactive. The faceplate display provides the 
following views of port status corresponding to the View menu options in the 
faceplate display. Refer to ”Monitoring Port Status” on page 6-2 for more 
information about these displays.

Port mode
Port state
Port speed
Port media

2.13.3
Working with I/O Blades and Ports

I/O blades and ports are selectable and serve as access points for other displays 
and menus. You select I/O blades and ports to display information about them in 
their respective data windows or to modify them. Context sensitive popup menus 
and properties windows are accessible through the I/O blade and port icons.

2.13.3.1
Selecting I/O Blades and Ports

You can select I/O blades and ports in the following ways. Selected blades are 
highlighted blue.

To select an I/O blade or port, click the I/O blade or port in the faceplate 
display.
To select a range of consecutive I/O blades or ports, select an I/O blade or 
port, then press and hold the shift key and select another. The application 
selects both end I/O blades or ports and those in between in sequence.
To select several non-consecutive I/O blades or ports, hold the Control key 
while selecting.
To select all I/O blades or ports, right-click anywhere in the graphic window. 
Select Select All Blades or Select All Ports from the popup menu.

To cancel a selection, press and hold the Control key and select it again.
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2.13.3.2
Opening the Faceplate Popup Menu

To open the popup menu, right-click anywhere in the graphic window to present 
the following tasks. If no blades or ports are selected, the corresponding tasks will 
be unavailable in the menu.

Refresh the switch
Select all ports
Manage switch properties
Manage network properties
Extended credits wizard
Manage port properties
Change the port symbolic name
Run the port loopback tests
Select all blades
Manage blade properties

To select one or more I/O blades or ports and open the Port popup menu, right-
click an I/O blade or port.

2.13.4
Faceplate Data Windows

The faceplate display provides the following data windows corresponding to the 
data window tabs:

Name Server – displays all devices connected to the switch that are logged 
with the name server.
Switch – displays current switch configuration data.
Port Statistics – displays performance data for the selected ports.
Port Information – displays information for the selected ports.
Blade Information – displays information for the selected I/O blades.
Configured Zonesets – displays all zone sets, zones, and zone membership 
in the zoning database.
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Section 3
Managing Fabrics

This section describes the following tasks that manage fabrics:

Security
Managing the fabric database
Displaying fabric information
Zoning a fabric

3.1
Security

The components of security are:

User authentication
Inter-switch link security
Inband management

3.1.1
User Authentication

User authentication means that the switch validates your account name and 
password when you attempt to add a fabric in SANbox Manager or to log in to a 
switch through Telnet. Your system administrator defines account names, 
passwords, the authority level, and expiration date.

When logging in to a switch through Telnet, you must enter an account name and 
password to access the switch. SANbox Manager, however, does not require an 
account name and password to add a fabric unless fabric security is enabled. The 
switch comes from the factory with fabric security disabled. Fabric security is 
controlled by the SecurityEnabled parameter which is set by the Set Setup 
System command. Fabric security must be configured the same for all switches in 
the fabric. Refer to the ”Set Setup Command” on page A-46 for more information.

When you add a fabric and fabric security is disabled, SANbox Manager ignores 
the account name and password entries and logs you in using the default account 
name and password (admin, password). This account name possesses Admin 
authority which grants full access to all tasks of the SANbox Manager menu 
system. If fabric security is enabled, you must enter an account name and 
password. The switch validates your account name and SANbox Manager grants 
access to its menus according to your authority level. If you do not have Admin 
authority, you are limited to monitoring tasks.
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3.1.2
Inter-Switch Link Security

Inter-switch link security pertains to whether the switches in the fabric are 
configured to permit access to each switch in that fabric. Inter-switch link security 
enables inter-switch links with FC-SW-2 compliant switches, SANbox2 switches 
only, or none regardless of switch type. ISL security should be thought of as the 
parameter with Any, Ours and None being the values. The three ISLSecurity 
parameters are:

Any - links with any FC-SW-2 compliant switch
Ours - links only with another SANbox2 switch
None - the port will not establish an ISL link

Refer to the ”Set Config Command” on page A-32 for more ISL security 
information and a Set Config Port example.

3.1.3
Inband Management

Inband management is the ability to manage switches across inter-switch links 
using SANbox Manager, SNMP, IPFC, management server, or the application 
programming interface. The switch comes from the factory with inband 
management enabled. If you disable inband management on a particular switch, 
you can no longer communicate with that switch by means other than a direct 
Ethernet or serial connection.

To enable Inband Management using SANbox Manager, check the Enable radio 
button on the Switch Properties dialog. Refer to ”Switch Properties” on page 4-15 
for more information. To enable Inband Management using the command line 
interface, set the InbandEnabled parameter to True in the Set Config Switch 
command. Refer to the in the ”Set Config Command” on page A-32 for more ISL 
security information and a Set Config Port example.
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3.2
Managing the Fabric Database

A fabric database contains the set of fabrics that you have added during a 
SANbox Manager session. Initially, the SANbox Manager application opens with 
an empty fabric database.

3.2.1
Adding a Fabric

To add a fabric to the database, do the following:

1. Open the Fabric menu and select Add Fabric to open the Add a New Fabric 
dialog as shown in Figure 3-1.

Figure 3-1.  Add a New Fabric Dialog

2. Enter a fabric name (optional) and the IP address of the switch through 
which to manage the fabric.

3. Enter an account name and password. The factory account name and 
password are (admin, password). The password is for the switch and is 
stored in the switch firmware. If security is turned off (default), you are not 
required to enter an account name or password.

Refer to ”User Authentication” on page 3-1 for information about user 
authentication.
Refer to ”Managing User Accounts” on page 4-1 or the ”User 
Command” on page A-79 for information about creating user accounts.

4. Choose the Add Fabric button.
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3.2.2
Removing a Fabric

To delete a fabric file from the database, do the following:

1. Select a fabric in the fabric tree.
2. Open the Fabric menu and select Remove Fabric.

3.2.3
Opening a Fabric View File

To open an existing view file, do the following:

1. Open the File menu, and select Open View File, or choose the Open 
button. If the fabric you are currently has changed, you will be prompted to 
save the changes to the view file before opening a different view file.

2. In the Open View dialog, enter the name of the file to open.
3. Enter a file password, if necessary. 
4. Choose the Load View File button. If the fabric has changed, you will be 

prompted to save before opening the new view. 

3.2.4
Saving a Fabric View File

To save a view file, do the following:

1. Open the File menu, and select Save View As.
2. In the Save View dialog, enter a new file name.
3. Enter a file password, if necessary. 
4. Choose the OK button.

Note: A switch supports a combined maximum of 19 logins reserved as 
follows:

4 sessions for internal applications such as management 
server and SNMP
15 sessions for SANbox Manager inband and out-of-band 
logins, Application Programming Interface (API) inband and 
out-of-band logins, and Telnet logins. Of these 15, there can 
be a combined maximum of 10 SANbox Manager and API 
logins. Additional logins will be refused.
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3.2.5
Rediscovering a Fabric

After making changes to or deleting switches from a fabric view, it may be helpful 
to again view the actual fabric configuration. The rediscover fabric option clears 
out the current fabric information being displayed, and rediscovers all switch 
information. To rediscover a fabric, open the Fabric menu, and select Rediscover 
Fabric.

3.2.6
Adding a New Switch to a Fabric

If there are no special conditions to be configured for the new switch, simply plug 
in the switch and the switch becomes functional with the default fabric 
configuration. The default fabric configuration settings are:

Fabric zoning is sent to the switch from the fabric.
All ports will be GL_Ports.
The default IP address 10.0.0.1 is assigned to the switch without a gateway 
or boot protocol configured (RARP, BOOTP, and DHCP).

If you are adding a new switch to a fabric and do not want to accept the default 
fabric configuration, do the following:

1. If the switch is not new, reset the switch to the factory configuration before 
adding the switch to the fabric by selecting Restore Factory Defaults in the 
Switch menu. 

2. If you want to manage the switch through the Ethernet port, you must first 
configure the IP address using the Network Properties dialog.

3. Configure any special switch settings. Consider configuring the Default 
Visibility setting to None in the Zoning Config dialog to prevent 
communication with other switches in the fabric until the new switch is 
configured.

4. Plug in the inter-switch links (ISL), but do not connect the devices. 
5. Configure the port types for the new switch (GL_Port, TL_Port, Donor) using 

the Port Properties dialog. 
6. Connect the devices to the switch.
7. Make any necessary zoning changes using the Edit Zoning window.
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3.2.7
Replacing a Failed Switch

The archive/restore works for all switches. However, the Restore menu item is not 
available for the inband switches. You can only restore a switch out-of-band (the 
connection switch). Use the following procedure to replace a failed switch for 
which an archive is available. 

1. At the failed switch:
a. Turn off the power and disconnect the AC cords.
b. Note port locations and remove the interconnection cables and SFPs.
c. Remove the failed switch.

2. At the replacement switch:
a. Mount the switch in the location where the failed switch was removed.
b. Install the SFPs using the same ports as were used on the failed 

switch.

c. Attach the AC cords and power up the switch.
3. Select the failed switch in the topology display. Open the Switch menu and 

select Delete.
4. Restore the configuration from the failed switch to the replacement switch:

a. Open the faceplate display for the replacement switch. Open the 
Switch menu and select Restore.

b. In the Restore dialog, enter the archive file from the failed switch or 
browse for the file.

c. Choose the Restore button.
5. Reconnect the inter-switch links, target devices, and initiator devices to the 

replacement switch using the same ports as were used on the failed switch.
6. Reset the replacement switch to activate the configuration formerly 

possessed by the failed switch including the domain ID and the zoning 
database. Open the Switch menu and select Reset Switch.

CAUTION! Do not reconnect inter-switch links, target devices, and 
initiator devices at this time. Doing so could invalidate 
the fabric zoning configuration.
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3.2.8
Deleting Switches and Links

The SANbox Manager application does not automatically delete switches or links 
that have failed or have been physically removed from the Fibre Channel network. 
In these cases, you can delete switches and links to bring the display up to date. If 
you delete a switch or a link that is still active, the SANbox Manager application 
will restore it automatically. You can also refresh the display. To delete a switch 
from the topology display, do the following:

1. Select one or more switches in the topology display.
2. Open the Switch menu and select Delete.
To delete a link, do the following:

1. Select one or more links in the topology display.
2. Open the Switch menu and select Delete.

3.3
Displaying Fabric Information

The topology display is your primary tool for monitoring a fabric. The graphics 
window of the topology display provides status information for switches, inter-
switch links, and the Ethernet connection to the management workstation.

The data window tabs show name server, switch, and active zone set information. 
The Active Zoneset tab shows the zone definitions for the active zone set. Refer 
to ”Name Server Data Window” on page 4-6 and ”Switch Data Window” on 
page 4-6 for information about the Name Server and Switch data windows.

3.3.1
Fabric Status

The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the display status, or you can refresh the display at any time. To refresh 
the topology display, do one of the following:

Choose the Refresh button.
Open the View menu and select Refresh.
Press the F5 key.
Right-click anywhere in the background of the topology display and select 
Refresh Fabric from the popup menu.
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The topology display uses switch and status icons to provide status information 
about switches, inter-switch links, and the Ethernet connection. The switch status 
icons, displayed on the left side of a switch, vary in shape and color. Switches 
controlled by an Ethernet Internet Protocol have a colored Ethernet icon displayed 
on the right side of the switch. A green Ethernet icon indicates normal operation, 
yellow indicates a condition that may require attention to maintain maximum 
performance, and red indicates a potential failure. Table 3-1 shows the different 
switch icons and their meanings.

Table 3-1. Topology Display Switch and Status Icons 

Switch Icon Description

SANbox2-64 switch
Normal operation (Green)
Warning–operational with errors (Yellow)
Critical–potential failure (Red)
Unknown–communication status unknown, 
unreachable, or unmanageable (Blue)

Fabric Management Switch
Ethernet connection normal (Green)
Ethernet connection warning (Yellow)
Ethernet connection critical (Red)

SANbox2-16 Fibre Channel switch

SANbox2-8c Fibre Channel switch

Non-QLogic Switch, or a QLogic Switch with different 
security than the fabric management switch.
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3.3.2
Displaying the Event Browser

The Event Browser is a compilation of messages that have been generated by the 
switches in the fabric in response to various events. The event format consists of 
a severity, time stamp, source, type, and description. The Event Browser shown in 
Figure 3-2, displays the event log and provides an opportunity to filter, sort, and 
export the contents to a file. To display the Event Browser, open the Fabric menu 
and select Show Event Browser or choose the Events button. If the Show 
Event Browser selection or the Events button is grayed-out, you must first 
enable the Events Browser preference. Refer to ”Setting SANbox Manager 
Preferences” on page 2-11.

Figure 3-2.  Events Browser

Column Sorting 
Buttons

Severity 
Column
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Severity is indicated in the severity column using icons as described in Table 3-2.

Table 3-2. Severity Levels 

Severity 
Icon Description

Alarm – An event generated by the switch that specifically requests 
attention. Alarms are generated by several switch processes. Some 
alarms are configurable. Refer to ”Configuring Alarms” on page 4-11.

Critical – An event that indicates a potential failure.

Warning – An event that indicates errors or other conditions that may 
require attention to maintain maximum performance.

Normal – An event that indicates a transition from a non-normal to 
normal operation.

None Informative – An unclassified event that provides supporting 
information.
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3.3.2.1
Filtering the Event Browser

Filtering the Event Browser enables you to display only those events that are of 
interest based on the event severity, timestamp, source, type, and description. To 
filter the Event Browser, open the Filter menu and select Filter Entries. This 
opens the Filter Events dialog shown in Figure 3-3. The Event Browser displays 
those events that meet the criteria in the Filter Events dialog.

Figure 3-3.  Filter Events Dialog

You can filter the event browser in the following ways:

Severity – Check one or more of the corresponding check boxes to display 
alarm events, critical events, warning events, normal events, or informative 
events.
Date/Time – Check one or both of the From: and To: check boxes. Enter the 
bounding timestamps (MM/dd/yyyy hh:mm:ss) to display only those events 
that fall within those times.
Text – Check one or more of the corresponding check boxes and enter a text 
string for event source, type, and description. The Event Browser displays 
only those events that contain the specified text string in the Source, Type, 
or Description columns.
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3.3.2.2
Sorting the Event Browser

Sorting the Event Browser enables you to display the events in alphanumeric 
order based on the event severity, timestamp, source, type, or description. Initially, 
the Event Browser is sorted in ascending order by timestamp. To sort the Event 
Browser, click the severity, Timestamp, Source, Type, or Description column 
buttons. You can also open the Sort menu and select By Severity, By 
Timestamp, By Source, By Type, or By Description. Successive sort 
operations of the same type alternate between ascending and descending order.

3.3.2.3
Save the Event Browser to a File

To save the Event Browser to a file, do the following:

1. Filter and sort the Event Browser to obtain the desired display.
2. Open the File menu and select Save As.
3. Select a folder and enter a file name in which to save the event log and 

choose the Save button. The file is saved in XML format and can be opened 
with an internet browser.

3.3.3
Active Zone Set Data Window

The Active Zoneset data window displays the zone membership for the active 
zone set that resides on the fabric management switch. The active zone set is the 
same on all switches in the fabric – you can confirm this by adding a fabric 
through another switch and comparing Active Zone Set displays.

To open the Active Zoneset data window, choose the Active Zoneset tab below 
the data window in the topology display. Refer to ”Configured Zonesets Data 
Window” on page 4-10 for information about the zone set definitions on a 
particular switch. Refer to ”Zoning a Fabric” on page 3-13 for more information 
about zone sets and zones.

The Active Zoneset data window, shown in Figure 3-4, uses display conventions 
for expanding and contracting entries that are similar to the fabric tree. An entry 
handle located to the left of an entry in the tree indicates that the entry can be 
expanded. Click this handle or double-click the following entries:

A zone set entry expands to show its member zones.
A zone entry expands to show its member port/devices.
WWN and FC devices that are zoned, but no longer part of the fabric, are 
grayed-out.
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Figure 3-4.  Active Zone Set Data Window

3.4
Zoning a Fabric

Zoning enables you to divide the ports and devices of the fabric into zones for 
more efficient and secure communication among functionally grouped nodes. This 
subsection addresses the following topics:

Zoning concepts
Using the Zoning Config dialog
Restoring default zoning
Using the Edit Zoning window
Merging fabrics and zoning
Managing zone sets
Managing zones
Managing aliases

Active Zoneset 
Data Window
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3.4.1
Zoning Concepts

The following zoning concepts provide some context for the zoning tasks 
described in this section:

Zones
Aliases
Zone sets
Zoning database
Zoning configuration

3.4.1.1
Zones

A zone is a named group of ports or devices that can communicate with each 
other. Membership in a zone can be defined by domain ID and port number, 
device Fibre Channel address, or device World Wide Name (WWN). Zone 
members can communicate only with members of the same zone.

Three types of zones are supported. The following zone types define increasingly 
restrictive levels of communication.

Soft zone
Access Control List (ACL) - hard zone
Virtual Private Fabric (VPF) - hard zone

3.4.1.1.1
Soft Zones

Soft zoning divides the fabric for purposes of controlling discovery. Members of 
the same soft zone automatically discover and communicate freely with all other 
members of the same zone. The soft zone boundary is not secure; traffic across 
soft zones can occur if addressed correctly. Soft zones that include members from 
multiple switches need not include the ports of the inter-switch links. Soft zone 
boundaries yield to ACL and VPF zone boundaries. Soft zones can overlap; that 
is, a port can be a member of more than one soft zone. Zone membership can be 
defined by Fibre Channel address, domain ID and port number, worldwide name, 
or a combination. Soft zoning supports all port modes.
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3.4.1.1.2
Access Control List Hard Zones

Access Control List (ACL) zoning divides the fabric for purposes of controlling 
discovery and inbound traffic. ACL zoning is a type of hard zoning that is 
hardware enforced. This type of zoning is useful for controlling access to certain 
devices without totally isolating them from the fabric. Members can communicate 
with each other and transmit outside the ACL zone, but cannot receive inbound 
traffic from outside the zone. The ACL zone boundary is secure against inbound 
traffic. ACL zones can overlap; that is, a port can be a member of more than one 
ACL zone. ACL zones that include members from multiple switches need not 
include the ports of the inter-switch links. ACL zone boundaries supersede soft 
zone boundaries, but yield to VPF zone boundaries. Membership can be defined 
only by domain ID and port number. ACL zoning supports all port modes except 
TL_Ports.

3.4.1.1.3
Virtual Private Fabric Hard Zones

Virtual Private Fabric (VPF) zoning divides the fabric for purposes of controlling 
discovery and both inbound and outbound traffic. This type of zoning is useful for 
providing security and reserving paths between devices to guarantee bandwidth. 
VPF zoning is a type of hard zoning that is hardware enforced. Members can only 
transmit to and receive from members of the same VPF zone. The VPF zone 
boundary is secure against both inbound and outbound traffic. VPF zones that 
include members from multiple switches must include the ports of the inter-switch 
links. VPF zones cannot overlap; that is, a port can be a member of only one VPF 
zone. VPF zone boundaries supersede both soft and ACL zone boundaries. 
Membership can be defined only by domain ID and port number. VPF zoning 
supports all port modes.

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID and port number pairs or Fibre Channel addresses to define 
their membership. Be sure to reconfigure zones that are affected by a 
domain ID change. To prevent zoning definitions from becoming invalid 
when the membership is defined by domain ID/port number or Fibre 
Channel address, you must lock domain IDs. Refer to ”Domain ID and 
Domain ID Lock” on page 4-16 and ”Set Config Command” on page A-
32 for more information.
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3.4.1.2
Aliases

To make it easier to add a group of ports or devices to one or more zones, you can 
create an alias. An alias is a named set of ports or devices that are grouped 
together for convenience. Unlike zones, aliases impose no communication 
restrictions between its members. You can add an alias to one or more zones. 
However, you cannot add a zone to an alias, nor can an alias be a member of 
another alias.

3.4.1.3
Zone Sets

A zone set is a named group of zones. A zone can be a member of more than one 
zone set. All zones that are not members of a zone set belong to the orphan zone 
set. The orphan zone set is saved on the switch. Each switch in the fabric 
maintains its own zoning database containing one or more zone sets. This zoning 
database resides in non-volatile or permanent memory and is therefore retained 
after a reset. Refer to ”Configured Zonesets Data Window” on page 4-10 for 
information about displaying the zoning database.

To apply zoning to a fabric, choose a zone set and activate it. When you activate a 
zone set, the switch distributes that zone set and its zones, excluding aliases, to 
every switch in the fabric. This zone set is known as the active zone set. Refer to 
”Active Zone Set Data Window” on page 3-13 for information about displaying the 
active zone set.

3.4.1.4
Zoning Database

Each switch has its own zoning database. The zoning database is made up of all 
aliases, zones, and zone sets that have been created on the switch or received 
from other switches. The switch maintains two copies of the zoning database: one 
copy is maintained in temporary memory for editing purposes; the second copy is 
maintained in permanent memory. Zoning database edits are made on an 
individual switch basis and are not propagated to other switches in the fabric when 
saved. The zoning limits for a fabric are as follows:

Maximum number of zonesets is 256
Maximum number of zones per zone set is 256
Maximum total number of zones is 1000
Maximum number of aliases is 256
Maximum number of members per zone is 2000
Maximum number of members per alias is 2000
Maximum total number of zone and alias members is 2000
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3.4.1.5
Zoning Configuration

You can set the FC-SW-2 Auto Save and Default Visibility zoning configuration 
parameters using SANbox Manager or the Set Config Zoning command. The Auto 
Save parameter determines whether changes to the active zone set that a switch 
receives from other switches in the fabric will be saved to permanent memory on 
that switch. The Default Visibility parameter permits or prohibits communication 
among ports/devices when there is no active zone set. Refer to ”Using the Zoning 
Config Dialog” on page 3-17 for information about zoning configuration using 
SANbox Manager. Refer also to the ”Set Config Command” on page A-32 for 
information about zoning configuration using the CLI.

3.4.2
Using the Zoning Config Dialog

Use the Zoning Config dialog to change the Auto Save and Default Visibility 
configuration parameters. In the faceplate display, open the Zoning menu and 
select Edit Zoning Config to open the Zoning Config dialog shown in 
Figure 3-5. After making changes, choose the OK button to put the new values 
into effect.

Figure 3-5.  Zoning Config Dialog

3.4.2.1
FC-SW-2 Auto Save

The FC-SW-2 Auto Save parameter determines whether changes to the active 
zone set that a switch receives from other switches in the fabric will be saved to 
permanent memory on that switch. Changes are saved when an updated zone set 
is activated. Zoning changes are always saved to temporary memory. However, if 
Auto Save is enabled, the switch firmware saves changes to the active zone set in 
both temporary and permanent memory. If Auto Save is disabled, changes to the 
active zone set are stored only in temporary memory which is cleared when the 
switch is reset.
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3.4.2.2
Default Visibility

Default visibility determines the level of communication that is permitted among 
ports/devices when there is no active zone set. The default visibility parameter 
can be set differently on each switch. When default visibility is enabled (ALL) on a 
switch, all ports/devices on the switch can communicate with all ports/devices on 
switches that also have default visibility enabled. When Default Visibility is 
disabled (NONE), none of the ports/devices on that switch can communicate with 
any other port/device in the fabric.

3.4.3
Restoring Default Zoning

Restoring the default zoning clears the switch of all zoning definitions.

To restore the default zoning for a switch:

1. In the faceplate display, open the Zoning menu and select Restore Default 
Zoning.

2. Choose the OK button to confirm that you want to restore default zoning and 
save changes to the zoning database.

3.4.4
Merging Fabrics and Zoning

If you join two fabrics with an inter-switch link, the active zone sets from the two 
fabrics attempt to merge. The fabrics may consist of a single switch or many 
switches already connected together. The switches in the two fabrics attempt to 
create a new active zone set containing the union of each fabric's active zone set. 
The propagation of zoning information only affects the active zone set, not the 
configured zone sets.

CAUTION! This command will deactivate the active zone set.
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3.4.4.1
Zone Merge Failure

If a zone merge is unsuccessful, the inter-switch links between the fabrics will 
isolate due to a zone merge failure, which will generate an alarm. The reason for 
the E_Port isolation can also be determined by viewing the port information. Refer 
to ”Port Information Data Window” on page 6-7 and the ”Show Command” on 
page A-50 (Port keyword).

A zone merge will fail if the two active zone sets have member zones with 
identical names that differ in membership or type. For example, consider Fabric A 
and Fabric B each with a soft zone named “ZN1” in its active zone set. Fabric A 
"ZN1" contains a member specified by Domain ID 1 and Port 1; Fabric B “ZN1” 
contains a member specified by Domain ID 1 and Port 2. In this case, the merge 
will fail because the two zones have the same name, but different membership. 
The zone merge will also fail if Fabric A “ZN1” is a soft zone and the Fabric B 
“ZN1” is an ACL zone.

3.4.4.2
Zone Merge Failure Recovery

When a zone merge failure occurs, the conflict that caused the failure must be 
resolved. You can correct a failure due to a zone conflict by deactivating one of 
the active zone sets or by editing the conflicting zones so that their membership 
and zone type (soft, ACL, VPF) are the same. You can deactivate the active zone 
set on one fabric if the active zone set on the other fabric accurately defines your 
zoning needs. If not, you must edit the zone memberships, and reactivate the 
zone sets. After correcting the zone membership, reset the isolated ports to allow 
the fabrics to join.

Refer to ”Managing Zones” on page 3-25 for information about adding and 
removing zone members. Refer to ”Resetting a Port” on page 6-14 for information 
about resetting a port.

Note: If you deactivate the active zone set in one fabric and the Auto Save 
parameter is enabled, the active zone set from the second fabric will 
propagate to the first fabric and replace all zones with matching names 
in the configured zone sets.
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3.4.5
Using the Edit Zoning Window

To edit the zoning database for a particular switch, open the Zoning menu from 
the faceplate display and select Edit Zoning to open the Edit Zoning window 
shown in Figure 3-6. Changes can only be made to inactive zone sets, which are 
stored in flash (non-volatile) memory and retained after resetting a switch.

The Edit Zoning window has a Zone Sets tree on the left and a Port/Device (or 
members) tree on the right. Both trees use display conventions similar to the 
fabric tree for expanding and contracting zone sets, zones, and ports. An 
expanded port shows the port Fibre Channel address; an expanded address 
shows the port worldwide name. You can select zone sets, zones, and ports in the 
following ways:

Click a zone, zone set, or port icon.
Right-click to select a zone set or zone, and open the corresponding popup 
menu.
Hold down the Shift key while clicking several consecutive icons.
Hold down the Control key while clicking several non-consecutive icons.

Figure 3-6.  Edit Zoning Window

After defining zoning changes, choose the OK button to implement those changes 
and exit the Edit Zoning window. Choose the Apply button to save changes 

Port/Device 
Tree

Zone Sets 
Tree
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without closing the Edit Zoning window. Before zoning changes are implemented, 
SANbox Manager checks for and reports the following zoning conflicts:

Empty zone sets
Empty zones
Empty aliases
ACL or VPF zones with non-domain ID/port number membership
VPF zones that share port/device members
Members in the same ACL zone that are segmented by VPF zoning. 

Using tool bar buttons, popup menus, or a drag-and-drop method, you can create 
and manage zone sets and zones in the zoning database. The Apply button 
saves changes to the zoning database without closing the window. The OK button 
saves the zoning changes to the database and closes the window. Table 3-3 
describes the zoning tool bar operations.

Table 3-3. Edit Zoning Window Tool Bar Buttons 

Tool Bar Button Description

Create Zone Set button - create a new zone set

Create Zone button - create a new zone

Create Alias button - create another name for a set of objects

Add Member button - add the selected zone to a zone set, or 
add the selected port/device to a zone

Remove Member button - delete the selected zone from a zone 
set, or delete the selected port/device from a zone
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3.4.6
Managing Zone Sets

Zoning a fabric involves creating a zone set, creating zones as zone set members, 
then adding devices as zone members. The zoning database supports multiple 
zone sets to serve the different security and access needs of your storage area 
network, but only one zone set can be active at one time. Managing zone sets 
consists of the following tasks:

Creating zone sets
Activating and deactivating zone sets
Copying a zone to a zone set
Removing a zone from one zone set or from all zone sets
Removing a zone set
Removing all zoning definitions

3.4.6.1
Creating a Zone Set

To create a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Zone Set to open the Create Zone 
Set dialog.

3. Enter a name for the zone set, and choose the OK button. The new zone set 
name is displayed in the Zone Sets dialog. A zone set name must begin with 
a letter and be no longer than 64 characters. Valid characters are 0-9, A-Z, 
a-z, _, -, ^, and $.

4. To create new zones in a zone set, do one of the following:
Right-click a zone set and select Create A Zone from the popup menu. 
In the Create a Zone dialog, enter a name for the new zone, and 
choose the OK button. The new zone name is displayed in the Zone 
Sets dialog.
Copy an existing zone by dragging a zone into the new zone set. Refer 
to ”Copying a Zone to a Zone Set” on page 3-23.

5. Choose the Apply button to save changes to the zoning database.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.
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3.4.6.2
Activating and Deactivating a Zone Set

You must activate a zone set to apply its zoning definitions to the fabric. Only one 
zone set can be active at one time. When you activate a zone set, the switch 
distributes that zone set to the temporary zoning database on every switch in the 
fabric. If Auto Save is enabled, the new active zone set is saved in the permanent 
zoning database also. Refer to ”FC-SW-2 Auto Save” on page 3-17.

The purpose of the deactivate function is to suspend all fabric zoning which 
results in free communication fabric wide or no communication depending on the 
default visibility setting. Refer to ”Default Visibility” on page 3-18 for more 
information. It is not necessary to deactivate the active zone set before activating 
a new one.

To activate a zone set, open the Zoning menu and select Activate Zone Set 
to open the Activate Zone Set dialog. Select a zone set from the Select Zone 
Set pull-down menu, and choose the Activate button.
To deactivate the active zone set, open the Zoning menu, select Deactivate 
Zone Set. Acknowledge the warning about traffic disruption, and choose the 
Yes button to confirm that you want to deactivate the active zone set.

3.4.6.3
Copying a Zone to a Zone Set

To copy an existing zone and its membership from one zone set to another, select 
the zone and drag it to the chosen zone set. Choose the Apply button to save 
changes to the zoning database.

3.4.6.4
Removing a Zone from a Zone Set or from All Zone Sets

You can remove a zone from a zone set or from all zone sets in the database.

1. In the Faceplate Display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window.

2. In the Zone Sets tree, select the zone(s) to be removed.
3. Open the Edit menu, and select Remove to remove the zone from the zone 

set, or select Remove from All Zones to remove the zone from all zone 
sets.

4. Choose the Apply button to save changes to the zoning database.
Alternatively, you may use shortcut menus to remove a zone from a zone set or 
from all zone sets in the database.
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3.4.6.5
Removing a Zone Set

Removing a zone set from the database affects the member zones in the following 
ways.

Member zones that are members of other zone sets are not affected.
Member zones that are not members of other zone sets become members 
of the orphan zone set. The orphan zone set is saved on the switch.

To delete a zone set from the database, do the following:

1. In the faceplate display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window. 

2. In the Zone Sets tree, select the zone set to be removed.
3. Open the Edit menu, and select Remove to remove the zone set.
4. Choose the Apply button to save changes to the zoning database.
Alternatively, you may use shortcut menus to remove a zone set from the 
database.

3.4.6.6
Removing All Zoning Definitions

To clear all zone and zone set definitions from the zoning database, choose one of 
the following:

Open the Edit menu and select Remove All. In the Remove All dialog, 
choose the Yes button to confirm that you want to delete all zones and zone 
sets. 
Right-click the Zone Sets heading at the top of the Zone Sets tree, and 
select Clear Zoning from the popup menu. Choose the Yes button to 
confirm that you want to delete all zone sets and zones.
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3.4.7
Managing Zones

Managing zones involves the following:

Creating a zone in a zone set
Adding zone members
Renaming a zone or a zone set
Removing a zone member
Removing a zone from a zone set
Removing a zone from all zone sets
Changing zone types

3.4.7.1
Creating a Zone in a Zone Set

When a zone is created, its zone type is soft. To change the zone type to a hard 
zone, refer to ”Changing Zone Types” on page 3-28 for more information. Refer to 
”Zones” on page 3-14 for information on zone types (soft and hard). To create a 
zone in a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window. 

2. Open the Edit menu and select Create a Zone. 
3. In the Create a Zone dialog, enter a name for the new zone, and choose the 

OK button. The new zone name is displayed in the Zone Sets dialog. A zone 
name must begin with a letter and be no longer than 64 characters. Valid 
characters are 0-9, A-Z, a-z, _, and -.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.

Note: If you enter the name of a zone that already exists in the 
database, the SANbox Manager application will create a copy of 
that zone and its membership in the zone set.
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4. To add ports or devices to the zone, do one of the following:
In the zone set tree, select the zone set. In the graphic window, select 
the port to add to the zone. Open the Edit menu and select Add 
Members. 
Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree, and drag it into the zone.
Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.

5. Choose the Apply button to save changes to the zoning database.

3.4.7.2
Adding Zone Members

Adding a zone member to a zone will affect every zone set in which that zone is a 
member. To add member ports/devices to a zone, do one of the following:

Select a port by port number, Fibre Channel address, or worldwide name in 
the Port/Device tree, and drag it into the zone. To select and drag multiple 
ports/devices, press and hold the Control key while dragging.
Select one or more ports by port number, Fibre Channel address, or 
worldwide name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.
Open the Edit menu or right click on the selected zone and select Create 
Members. Choose the WWN, Domain/Port, or FC address radio button and 
enter the port hex value.

Choose the Apply button to save changes to the zoning database.

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID/port number pair to define their membership. Be sure to 
reconfigure zones that are affected by a domain ID change.
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3.4.7.3
Renaming a Zone or a Zone Set

To rename a zone, do the following:

1. In the Zone Sets tree of the Edit Zoning window, click the zone/zone set to 
be renamed.

2. Open the Edit menu and select Rename.
3. In the Rename Zone/Rename Zone Set dialog, enter a new name for the 

zone/zone set.
4. Choose the OK button.

3.4.7.4
Removing a Zone Member

Removing a zone member will affect every zone and zone set in which that zone 
is a member. To remove a member from a zone:

1. In the Edit Zoning window, select the zone member to be removed.
2. Open the Edit menu and select Remove.
3. Choose the OK button to save changes and close the Edit Zoning window.

3.4.7.5
Removing a Zone from a Zone Set

Zones that are no longer members of any zone set are moved to the orphan zone 
set. The orphan zone set is saved on the switch. To remove a zone from a zone 
set:

1. In the Edit Zoning window, select the zone to be removed. The selected 
zone will be removed from that zone set only.

2. Open the Edit menu and select Remove.
3. Choose the OK button to save changes and close the Edit Zoning window.

3.4.7.6
Removing a Zone from All Zone Sets

Zones that are no longer members of any zone set are moved to the orphan zone 
set. The orphan zone set is saved on the switch. To remove a zone from all zone 
sets, do the following:

1. In the Edit Zoning window, select the zone to be removed.
2. Open the Edit menu and select Remove Zone from All Sets.
3. Choose the OK button to save changes and close the Edit Zoning window.
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3.4.7.7
Changing Zone Types

To change a zone type, do the following:

1. In the faceplate display, select the switch with the zone type to change.
2. Choose the Zoning button to open the Edit Zoning window.
3. In the Zone Sets tree, select the zone to change.
4. Open the Edit menu and select Set Zone Type to open the Set Zone Type 

dialog.
5. Open the Zone Type pull-down menu and select Soft, ACL, or VPF. 

Soft zoning is the least restrictive type of zoning.
ACL zoning is hard zoning and is enforced by hardware and defines 
access to a given port. ACL zones need not include inter-switch links.
VPF zoning is hard zoning that defines ports that can communicate 
with each other. VPF zones must include inter-switch links. On a
SANbox2-64 switch, a VPF zone cannot extend beyond the ports of a 
single I/O blade.

3.4.8
Managing Aliases

An alias is a collection of objects that can be zoned together. An alias is not a 
zone, and can not have a zone or another alias as a member.

3.4.8.1
Creating an Alias

To create an alias, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Alias to open the Create Alias 
dialog.

3. Enter a name for the alias, and choose the OK button. The alias name is 
displayed in the Zone Sets dialog. An alias name must begin with a letter 
and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, $, 
^, and -.

4. Choose the OK button to save the alias name to the zoning database.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.
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3.4.8.2
Adding a Member to an Alias

You can add a member to an alias in the following ways:

Drag-and-drop method.
Select the alias in the left pane and the member in the right pane to add to 
that alias, and choose the Insert button.
Select the alias in the left pane and the member in the right pane to add to 
that alias, and open the Edit menu and select Add Members.

To add a member to an alias using the drag-and-drop method, do the following:

1. In the right pane, click and hold down the mouse button on the member to 
be added to the alias.

2. Drag the selected member from the right pane to the alias in the left pane.
To add a member to an alias using the menu options, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. In the left pane, select an alias.
3. In the right pane, select the member to add to the selected alias.
4. Choose one of the following: 

Open the Edit menu and select Add Members.
Choose the Insert button.

5. Choose the OK button to save changes and close the Edit Zoning window.

3.4.8.3
Removing an Alias from All Zones

To remove an alias from all zones, do the following:

1. In the Zone Sets tree in the Edit Zoning window, select the alias to be 
removed.

2. Open the Edit menu, and select Remove Alias from All Zones.
3. Choose the Yes button in the Remove dialog.
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Notes
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Section 4
Managing Switches

This section describes the following tasks that manage switches in the fabric.

Managing user accounts
Displaying switch information
Managing alarms
Exporting name server information to a file
Paging a switch
Resetting a switch
Setting the date and time
Configuring a switch
Archiving a switch
Restoring a switch
Managing firmware
Restoring the factory default configuration

4.1
Managing User Accounts

A user account consists of the following:

Account name
Password
Authority level
Expiration date

Switches come from the factory with the following user accounts:

The Admin account is for configuring the switch for the first time. After creating 
your own user accounts, consider changing the password for this account. The 
Admin account has Admin authority which means that this account can view and 

Table 4-1. Factory User Accounts

Account Name Password Admin Authority Expiration

admin password True Permanent

images images False Permanent
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modify the switch and its configuration both with SANbox Manager and the Telnet 
command line interface. Without Admin authority, you are limited to viewing switch 
status and configuration. The Images account is for exchanging files with the 
switch using FTP.

The factory switch configuration does not enforce user accounts and passwords. 
This means that no account name and password are required to add a fabric and 
modify switch configurations using SANbox Manager. To enforce user accounts 
and authority, set the SecurityEnabled parameter to True using the Set Setup 
System command in the Telnet command line interface. Refer to ”Set Setup 
Command” on page A-46.

To create, remove, and modify user accounts, open the Switch menu in the 
faceplate display, and select User Accounts.... If fabric security is enabled, your 
account must have Admin authority to manage user accounts.

4.1.1
Creating User Accounts

To create a user account on a particular switch, open the faceplate display and 
select User Accounts.... This displays the User Account Administration dialog 
shown in Figure 4-1. Choose the Add Account tab. A switch can have a 
maximum of 15 user accounts.

Figure 4-1.  Account Administration – Add
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1. Enter an account name in the New Account Login field. Account names are 
limited to 15 characters.

2. If the account is to have the ability to modify switch configurations, check the 
Admin Authority Enabled box.

3. Enter a password in the New Password field and enter it again in the Verify 
Password field. A password must have a minimum of 4 characters and no 
more than 20.

4. If this account is to be permanent with no expiration date, choose the 
Permanent Account radio button. Otherwise, choose the Account Will 
Expire button and enter the number days in which the account will expire.

If you want to change the authority or the expiration date for an account, you must 
remove the account and recreate it. Refer to ”Removing a User Account” on 
page 4-3.

4.1.2
Removing a User Account

To remove a user account on a particular switch, open the faceplate display and 
select User Accounts.... Choose the Remove Account tab in the dialog to 
present the display shown in Figure 4-2. Select the account name from the list of 
accounts at the top of the dialog and choose the Remove Account button.

Figure 4-2.  Account Administration – Remove
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4.1.3
Changing a User Account Password

To change the password for an account on a particular switch, open the faceplate 
display and select User Accounts.... Choose the Change Password tab in the 
dialog to present the display shown in Figure 4-3. Select the account name from 
the list of accounts at the top of the dialog, then enter the old password, the new 
password, and verify the new password in the corresponding fields. Choose the 
Change Password button.

Figure 4-3.  Account Administration – Change Password
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4.2
Displaying Switch Information

The faceplate display and data windows provide the following specific switch 
information:

Name server information
Switch specifications and addresses
Configuration parameters
Performance statistics
Configured zone sets

Figure 4-4 shows the faceplate display for the SANbox2-64 switch.

Figure 4-4.  Faceplate Display

The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the switch status, or you can refresh the display at any time. To refresh 
switch status in the display, do one of the following:

Choose the Refresh button.
Open the View menu and select Refresh.
Press the F5 key.
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Right-click a switch in the topology display and select Refresh Switch from 
the popup menu.
Right-click in the graphic window of the faceplate display, and select 
Refresh Switch from the popup menu.

4.2.1
Name Server Data Window

The Name Server data window displays information about the devices that are 
logged into the fabric. Choose the Name Server tab below the data window to 
display name server information for all devices that are logged into the selected 
fabric. To narrow the display to devices that are logged into specific switches, 
select one or more switches in the fabric tree or the topology display. Refer to 
Table 4-2 for a description of the entries in the Name Server data window. Refer to 
”Exporting Name Server Information to a File” on page 4-13 for exporting name 
server information.

4.2.2
Switch Data Window

The Switch data window displays current network and switch information for the 
selected switches. Refer to ”Configuring a Switch” on page 4-14 for more 
information about the Switch data window. To open the Switch data window, select 
one or more switches in the topology display and choose the Switch tab below 
the window. You can also open the Switch data window in the faceplate display. 
Table 4-3 describes the Switch data window entries.

Table 4-2. Name Server Data Window Entries

Entry Description

Target/Initiator Device type: target or initiator

Switch Switch name

Port Port number (0–63)

Address Fibre Channel address

Type Node type

WWNN Node worldwide name

WWPN Port worldwide name

Vendor Host Bus Adapter/Device Vendor

FC-4 Types Device Fibre Channel protocol types

Active Zones The active zone to which the device belongs
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Table 4-3. Switch Data Window Entries 

Entry Description

FcAddress Switch Fibre Channel address

World Wide Name Switch worldwide name

Reason for Status Additional status information

User Name Account name

Login Level Authority level

Security Enabled Enforcement of account names and authority

Vendor Switch manufacturer

Firmware Version Active firmware version

Inactive Firmware Version Inactive firmware version

Pending Firmware Version Firmware version that will be activated at the next reset

PROM/Flasher Version PROM firmware version

MAC Address Media Access Control address

IP Address Internet Protocol address

Subnet Mask Mask that determines the IP address subnet

Gateway Gateway address

Negotiated Domain ID The domain ID currently being used by the fabric

Configured Domain ID The domain ID defined by network administrator

Domain ID Lock Domain ID lock status. Prevents (True) or permits (False) 
dynamic domain ID reassignment.

Number of Ports Number of ports on the switch

Switch Type Switch model

Operational State Switch operational state: Online, Offline, Diagnostic

Administrative State Current switch administrative state

Configured Admin State Switch administrative state that is stored in the switch 
configuration

RA Timeout Resource allocation timeout value

ED Timeout Error detect timeout value
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FC-SW-2 Compliant Zoning merge status. If True, changes to the active zone 
set are propagated throughout the fabric. If false, changes 
to the zoning database are propagated throughout the 
fabric.

LegacyAddressFormat Legacy port addressing status. Enabled only for 
interoperability with non-FC-SW-2 switches.

FC-SW-2 Auto Save Zoning auto save status. Saves zoning updates in 
temporary and permanent memory (True) or only in 
temporary memory (False).

Zoning Default Visibility Zoning visibility status. Permits (All) or prevents (None) 
communication with other switches in the absence of an 
active zone set.

Temperature Internal switch temperature °C

Fan 1 Status Fan 1 status

Fan 2 Status Fan 2 status

Fan 3 Status Fan 3 status

Power Supply 1 Status Power supply 1 status

Power Supply 2 Status Power supply 2 status 

Beacon Status Beacon status. Switch LEDs are blinking (On) or not (off).

Broadcast Support Broadcast support status. Broadcast support is enabled or 
disabled (default).

Inband Enabled Inband management status. Permits (True) or prevents 
(False) a switch from being managed over an ISL.

Temp Failure Port 
Shutdown

Not applicable.

Warning Temperature Not applicable.

Failure Temperature Not applicable.

Table 4-3. Switch Data Window Entries (Continued)

Entry Description
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4.2.3
Link Data Window

The Link data window displays information about all switch links in the fabric or 
selected links. This information includes the switch name, the port number at the 
end of each link, and the link status. To open the Link data window, choose the 
Link tab below the window.

4.2.4
Port Statistics Data Window

The Port Statistics data window displays port performance data for the selected 
ports. To open the Port Statistics data window, choose the Port Stats tab below 
the data window in the faceplate display. Refer to Table 6-5 for a description of the 
Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. 
Choose the Clear Baseline button to set the current baseline.

4.2.5
Port Information Data Window

The Port Information data window displays port detail information for the selected 
ports. To open the Port Statistics data window, choose the Port Info tab below the 
data window in the faceplate display. Refer to Table 6-6 for a description of the 
Port Information data window entries.
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4.2.6
Configured Zonesets Data Window

The Configured Zonesets data window displays all zone sets, zones, and zone 
membership in the zoning database, as shown in Figure 4-5. To open the 
Configured Zonesets data window, choose the Configured Zonesets tab below 
the data window in the faceplate display.

The Configured Zonesets data window uses display conventions for expanding 
and contracting entries that are similar to the fabric tree. An entry handle located 
to the left of an entry in the tree indicates that the entry can be expanded. Click 
this handle or double-click the following entries to expand or contract them:

A zone set entry expands to show its member zones.
A zone entry expands to show its members by port number, worldwide 
name, or Fibre Channel address.

Figure 4-5.  Configured Zonesets Data Window
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4.3
Configuring Alarms

You can configure the switch to generate alarms for selected events. Configuring 
an alarm involves choosing an event type, rising and falling thresholds, a 
sampling interval, and finally enabling or disabling the alarm. To configure alarms, 
do the following:

1. In the faceplate display, open the Switch menu and select Configure Alarm 
Thresholds.

2. The Alarm Threshold Configuration dialog shown in Figure 4-6 prompts you 
to enable or disable all alarms, select an event, set thresholds, set a 
sampling interval and enable or disable an individual alarm.

Figure 4-6.  Alarm Threshold Configuration Dialog

3. Check the Enable All Alarm Thresholds box to enable monitoring for all 
the individual alarm types that are enabled. The Enable All Alarm 
Thresholds box is the master control for the individual alarms. For example, 
the switch will monitor CRC errors only if both the CRC Error Enable box 
and the Enable All Alarm Thresholds box are checked.

4. Select an event type from the Alarm Threshold pull-down menu. Choose 
from the following options:

CRC error monitoring
Decode error monitoring
ISL monitoring
Device login monitoring
Device logout monitoring
Loss of signal monitoring

5. Enter a value for the falling threshold. A falling threshold alarm is generated 
when the event count descends below the falling threshold.
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6. Enter a value for the rising threshold. A rising threshold alarm is generated 
when the event count exceeds the rising threshold. The switch will not 
generate another rising threshold alarm for that event until the count 
descends below the falling threshold and rises again above the rising 
threshold. Consider the example in Figure 4-7.

Figure 4-7.  Alarm Threshold Example

7. Enter a sample interval in seconds. The sample interval defines the period of 
time in which to count events.

8. Check the Enable box to make the alarm eligible for use. Repeat steps 3 
through 8 for each alarm you want to configure or enable. You must also 
check the Enable All Alarm Thresholds box, which is the master control for 
all alarm configurations.

9. Choose the OK button to save all changes.

Note: The switch will down a port if a rising threshold alarm is not 
cleared after three consecutive sample intervals.

Rising 
Threshold

Falling 
Threshold

Event 
Count

Sample Interval

Generate falling 
threshold alarm; 
eligibility is reset

Generate rising 
threshold alarm; 
eligibility ends

Generate rising 
threshold alarm; 
eligibility ends
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4.4
Exporting Name Server Information to a File

To save name server information to a file, open the topology display and do the 
following:

1. Select one or more switches. If no switches are selected, name server 
information is gathered for the all switches.

2. Open the Switch menu and select Export Name Server.
3. In the Save dialog, enter a file name.
4. Choose the Save button.

4.5
Paging a Switch

You can use the beacon feature to page a switch. The beacon feature causes all 
Port Status LEDs to flash, making it easier to recognize. To page a switch, open 
the Switch menu in the faceplate display and enable the Toggle Beacon 
selection. To cancel the beacon, reselect Toggle Beacon.

4.6
Setting the Date and Time

To set the date and time on a switch, do the following:

1. Select a switch in the topology display, and open the faceplate display.
2. Open the Switch menu, and select Set Date/Time....
3. Enter the year, month, day and time in the Switch Date and Time dialog, 

then click OK. The new date and time take effect immediately.
4.7
Resetting a Switch

Resetting a switch reboots the switch using configuration parameters in memory. 
Depending on the type, a switch reset may or may not include power-on self test 
or it may or may not disrupt traffic. Table 4-4 describes the types of switch resets:
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To reset a switch using SANbox Manager, do the following:

1. Select the switch to be reset and open the faceplate display.
2. Open the Switch menu and select the Reset Switch pull-down menu:

Select Hot Reset to perform a hot reset.
Select Reset to perform a standard reset.
Select Hard Reset to perform a hard reset.

4.8
Configuring a Switch

Switch configuration is divided into two areas: chassis configuration and network 
configuration. Chassis configuration specifies switch-wide Fibre Channel settings. 
Network configuration specifies Ethernet and SNMP settings.

To open the Switch Properties dialog, open the Switch menu and select Switch 
Properties. You may also right-click a switch graphic in the topology display or 
faceplate display, and select Switch Properties from the popup menu.

Table 4-4. Switch Resets

Type Description

Hot Reset Resets a switch without a power-on self test. This reset activates 
the pending firmware, but does not disrupt switch traffic. You can 
perform this reset using SANbox Manager or the Hotreset 
command. Refer to ”Hotreset Command” on page A-16.

Reset without 
POST

Resets a switch without a power-on self test. This reset activates 
the pending firmware and it is disruptive to switch traffic. You can 
perform this type of reset using the following:

SANbox Manager
Reset Switch command. Refer to ”Reset Command” on 
page A-25.
Maintenance button. Refer to your switch Installation Guide.

Hard Reset Resets a switch with a power-on self test. This reset activates the 
pending firmware and it is disruptive to switch traffic. You can 
perform this type of reset by using or doing the following:

SANbox Manager
Hardreset command. Refer to the ”Hardreset Command” on 
page A-13.
Power cycle the switch.
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4.8.1
Switch Properties

Use the Switch Properties dialog to change the following switch configuration 
parameters:

Symbolic name
Administrative state
Domain ID and domain ID lock
Broadcast support (TCP/IP)
Inband management
FC-SW-2 compliance for zoning
Legacy port address format

The timeout values are displayed only for reference purposes when the switch is 
online; they become active when the switch is taken offline. After making changes, 
choose the OK button to put the new values into effect.

Figure 4-8.  Switch Properties Dialog
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4.8.1.1
Symbolic Name

A user-defined name of up to 63 characters that identifies the switch.

4.8.1.2
Switch Administrative States

The switch administrative state determines the operational state of the switch. The 
switch administrative state exists in two forms: the configured administrative state 
and the current administrative state.

The configured administrative state is the state that is saved in the switch 
configuration and is preserved across switch resets. SANbox Manager 
always makes changes to the configured administrative state.
The current administrative state is the state that is applied to the switch for 
temporary purposes and is not retained across switch resets. The current 
administrative state is set using the Set Switch command. Refer to the ”Set 
Command” on page A-30.

Table 4-5 describes the administrative state values.

4.8.1.3
Domain ID and Domain ID Lock

The domain ID is a unique Fibre Channel identifier for the switch. The Fibre 
Channel address consists of the domain ID, port ID, and the Arbitrated Loop 
Physical Address (ALPA). The maximum number of switches within a fabric is 239 
with each switch having a unique domain ID.

Switches come from the factory with the domain IDs unlocked. This means that if 
there is a domain ID conflict in the fabric, the switch with the highest principal 
priority, or the principal switch, will reassign any domain ID conflicts and establish 
the fabric. If you lock the domain ID on a switch and a domain ID conflict occurs, 
one of the switches will isolate as a separate fabric and the Port Status LEDs on 
both switches will flash to show the affected ports. Refer to the ”Set Config 
Command” on page A-32 for information about the switch keyword and the 
Domain ID Lock and Principal Priority parameters.

If you connect a new switch to an existing fabric with its domain ID unlocked, and 
a domain conflict occurs, the new switch will isolate as a separate fabric. 

Table 4-5. Switch Administrative States

Parameter Description

Online The switch is available.

Offline The switch is unavailable.

Test The switch is in diagnostics mode and is unavailable.
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However, you can remedy this by resetting the new switch or taking it offline then 
back online. The principal switch will reassign the domain ID and the switch will 
join the fabric.

4.8.1.4
Broadcast Support

Broadcast is supported on the SANbox2 which allows for TCP/IP support. 
Broadcast is implemented using the proposed standard specified in Multi-Switch 
Broadcast for FC-SW-3, T11 Presentation Number T11/02-031v0. FSPF is used 
to setup a fabric spanning tree used in transmission of broadcast frames. 
Broadcast frames are retransmitted on all ISLs indicated in the spanning tree and 
all online F/FL_Ports. Broadcast zoning is supported with Access Control List 
(ACL) and Virtual Private Fabric (VPF) hard zones. When a broadcast frame is 
received, these hard zones are enforced at the F/FL_Port. If the originator of the 
broadcast is in a hard zone, the frame is retransmitted on all online F/FL_Ports 
within the hard zone. If the originator of the broadcast frame is not in a hard zone, 
the frame is retransmitted on online F/FL_Ports that are not in a hard zone.

4.8.1.5
Inband Management

Inband management is the ability to manage switches across inter-switch links 
using SANbox Manager, SNMP, IPFC, management server, or the application 
programming interface. The switch comes from the factory with inband 
management enabled. If you disable inband management on a particular switch, 
you can no longer communicate with that switch by means other than a direct 
Ethernet or serial connection.

4.8.1.6
FC-SW-2 Compliance for Zoning

When a zone set is activated, SANbox2 switches and other FC-SW-2 compliant 
switches propagate the active zone set to all switches in the fabric. Some non-FC-
SW-2 compliant switches propagate not only the active zone set, but the entire 
zoning database. Disabling this parameter causes the SANbox2 switch to 
propagate the zoning database, and therefore, interoperate with non-FC-SW-2 
switches. For FC-SW-2 compliant fabrics, this parameter should be enabled.

Note: Domain ID reassignment is not reflected in zoning that is defined by 
domain ID and port number pair. You must reconfigure zones that are 
affected by domain ID reassignment.

Note: The FC-SW-2 Compliant setting must be the same on all switches in 
the fabric, otherwise the inter-switch links will not connect.
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4.8.1.7
Legacy Port Address Format

Legacy Address Format should be enabled only to permit interoperation with 
certain older non-FC-SW-2, non-QLogic switches. Enabling this setting under 
other circumstances will disable zoning that is defined by domain ID and port 
number. This setting is available only when the FC-SW-2 Compliant setting is 
disabled. Contact your authorized maintenance provider for assistance in using 
this feature.

4.8.1.8
Timeout Values

The switch timeout values determine the timeout values for all ports on the switch. 
Table 4-6 describes the switch timeout parameters. The timeout values must be 
the same for all switches in the fabric.

Note: The Legacy Address Format setting must be the same on all 
switches in the fabric, otherwise the inter-switch links will not connect.

Note: Timeout values can only be changed if the switch is offline.

Table 4-6. Timeout Values

Parameter Description

R_A_TOV Resource Allocation Timeout: Represents the maximum time a frame 
could be delayed in the Fabric and still be delivered. The default is 
10000 milliseconds.

E_D_TOV Error Detect Timeout: Represents the maximum round trip time that 
an operation between two N_Ports could require. The default is 2000 
milliseconds.
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4.8.2
Network Properties

Use the Network Properties dialog shown in Figure 4-9 to change IP and SNMP 
configuration parameters. After making changes, choose the OK button to put the 
new values into effect. To open the Network Properties dialog, open the Switch 
menu and select Network Properties.

Figure 4-9.  Network Properties Dialog

Note: Since Read Community, Trap Community, and Write Community 
settings are like passwords, they are write-only fields; the current 
settings are not displayed.
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4.8.2.1
IP Configuration

The IP configuration identifies the switch on the Ethernet network and determines 
which network discovery method to use. Table 4-7 describes the IP configuration 
parameters.

Table 4-7. IP Configuration Parameters

 Parameter Description

Network 
Discovery

Choose one of the following methods by which to assign the IP 
address:

Static - Uses the IP configuration parameters entered in the 
Switch Properties dialog.
BootP - Acquires the IP configuration from a BootP server.
RARP (Reverse Address Resolution Protocol) - Acquires the IP 
address from an RARP server. An RARP request is broadcast 
with up to three retries, each at 5 second intervals. If no IP 
address is obtained, the switch reverts to the previously 
configured IP address. 
DHCP (Dynamic Host Configuration Protocol) - Acquires the IP 
configuration from a DHCP server. If no satisfactory lease is 
obtained, the DHCP client attempts to use the previously 
configured lease. If the previous lease cannot be used, no IP 
address will be assigned to this switch in order to avoid an IP 
address conflict. The DHCP server must then be made available.

If a BootP, RARP, or DHCP server is not available, the switch will 
attempt to use a previously assigned valid lease. If no lease was 
ever assigned, the switch will attempt to use the previously assigned 
static IP address.

IP Address Internet Protocol (IP) address for the Ethernet port. The default value 
is 10.0.0.1.

Subnet mask Subnet mask address for the Ethernet port. The default value is 
255.0.0.0.

Gateway IP gateway address. The default value is 10.0.0.254.
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4.8.2.2
SNMP Configuration

The SNMP configuration defines how authentication traps are managed.
Table 4-8 describes the SNMP configuration parameters.

Table 4-8. SNMP Configuration Parameters 

 Parameter Description

SNMP Proxy SNMP proxy. Enables or disables SNMP communication with other 
switches in the fabric.

Contact Specifies the name (up to 32 characters) of the person who is to be 
contacted to respond to trap events. The default is “undefined”.

Read 
Community

Read community password (up to 32 characters) that authorizes an 
SNMP agent to read information from the switch. This is a write-only 
field. The value on the switch and the SNMP management server 
must be the same. The default is “public”.

Trap Community Trap community password (up to 32 characters) that authorizes an 
SNMP agent to receive traps. This is a write-only field. The value on 
the switch and the SNMP management server must be the same. 
The default is “public”.

Location Specifies the name (up to 32 characters) for the switch location. The 
default is “undefined”.

Authentication 
Trap

Enables or disables the reporting of SNMP authentication failures. If 
enabled, a notification trap is sent when incorrect community string 
values are used. The default value is False.

Write 
Community

Write community password (up to 32 characters) that authorizes an 
SNMP agent to write information to the switch. This is a write-only 
field. The value on the switch and the SNMP management server 
must be the same. The default is “private”.
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4.8.2.3
SNMP Trap Configuration

The SNMP trap configuration defines how traps are set. Choose from the tabs 
Trap1 – Trap 5 and configure the trap. Table 4-9 describes the SNMP 
configuration parameters.

4.8.2.4
Remote Logging

The Remote Logging (syslog) feature enables saving of the log information to a 
remote host that supports the syslog protocol. When enabled, the log entries are 
sent to the syslog host at the IP address that you specify in the Logging Host IP 
Address field. Log entries are saved in the internal switch log whether this feature 
is enabled or not.

To save log information to a remote host, you must edit the syslog.conf file and 
then restart the syslog daemon. The syslog.conf file on the remote host must 
contain an entry that specifies the name of the log file in which to save error 
messages. Add the following line to the syslog.conf file. A <tab> separates the 
selector field (local0.info) and action field which contains the log file path name (/
var/adm/messages/messages.name).

local0.info <tab> /var/adm/messages.name

Table 4-9. SNMP Trap Configuration Parameters

 Parameter Description

Trap Version Specifies the SNMP version (1 or 2) with which to format traps.

Trap Enabled Enables or disables the trap.

Trap Address1

1Trap address (other than 0.0.0.0) and trap port combinations must be unique. For example, if trap 1 
and trap 2 have the same address, then they must have different port values. Similarly, if trap 1 and 
2 have the same port value, they must have different addresses.

Specifies the IP address to which SNMP traps are sent. A maximum 
of 5 trap addresses are supported. The default address for trap 1 is 
10.0.0.254. The default address for traps 2–5 is 0.0.0.0.

Trap Port1 The port number on which the trap is sent. The default is 162.

Trap Severity Specifies a severity level to assign to the trap. Open the pull-down 
menu and choose a level. Traps must be enabled to access this pull-
down menu. Trap severity levels include Unknown, Emergency, 
Alert, Critical, Error, Warning, Notify, Info, Debug, and Mark
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4.9
Archiving a Switch

You can create an .XML archive file containing the configuration parameters. 
Archived parameters include the following:

Switch properties and statistics
IP configuration
SNMP configuration
Port properties and statistics
Alarm configuration
Zoning configuration

This archive file can be used to restore the configuration on the same switch or on 
a replacement switch. You can also use the archive file as a template for 
configuring new switches to add to a fabric. Security settings and user account 
information are not archived. The archive can be used later to restore the switch. 
Refer to ”Restoring a Switch” on page 4-24 for more information.

To archive a switch, do the following:

1. Open the Switch menu and select Archive.
2. In the Save dialog, enter a file name.
3. Choose the Save button.
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4.10
Restoring a Switch

Restoring a switch loads the archived switch configuration parameters to the 
switch. The switch configuration must be archived before it can be restored. 
Furthermore, the switch archive must be compatible with the switch to be 
restored; that is, you cannot restore a SANbox2-64 switch with a SANbox2-16 
archive. Refer to ”Archiving a Switch” on page 4-23 for more information.

To restore a switch, do the following:

1. Log in to the fabric through the switch you want to restore. You cannot 
restore a switch over an ISL.

2. Open the Switch menu and select Restore to display the Restore dialog 
shown in Figure 4-10. The Restore dialog offers a Full Restore and a 
Selective Restore tab.

Figure 4-10.  Restore Dialogs – Full and Selective

3. Enter the archive file name or browse for the file. This archive file must be 
one that was produced by the SANbox Manager Archive function. 
Configuration backup files created with the Config Backup command are not 
compatible with the SANbox Manager Restore function.

4. To restore all configuration settings, choose the Full Restore tab, then 
choose the Restore button. To restore selected configuration settings, 
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choose the Selective Restore tab and check one or more of the following 
boxes, then choose the Restore button:

Network Properties: Restores all settings presented in the Network 
properties dialog except the IP address. Refer to ”Network Properties” 
on page 4-19.
IP Address: Restores switch IP address in addition to the other 
network properties.
Switch Properties: Restores all settings presented in the Switch 
properties dialog except the domain ID. Refer to ”Switch Properties” on 
page 4-15.
Domain ID: Restores switch domain ID in addition to the other switch 
properties.
Port Properties: Restores all settings presented in the Port properties 
dialog. Refer to ”Configuring Ports” on page 6-9.
Configured Zoning: Restores all zone sets, zones, and aliases in the 
switch’s zoning database.
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4.11
Managing Firmware

The switch memory is partitioned for two firmware images. One of these partitions 
contains the active firmware; that is, the firmware version that is in use. The other 
partition contains the inactive firmware which is not in use. The pending firmware 
is the firmware that will be activated at the next switch reset. The pending 
firmware can be the active firmware or the inactive firmware. When you install new 
firmware, that image becomes the inactive firmware and the pending firmware. 
Upon resetting the switch, this image becomes both the active and pending 
firmware.

Firmware management tools enable you to do the following:

Install and activate new firmware
Activate the pending firmware
Change the pending firmware

4.11.1
Installing Firmware

Installing firmware involves loading, unpacking, and activating the firmware image 
on the switch. SANbox Manager does this in one operation.

To install firmware, do the following:

1. In the faceplate display, open the Switch menu and select Load Firmware.
2. In the Firmware Upload dialog, choose the Select button to browse and 

select the firmware file to be uploaded.
3. Choose the Start button to begin the firmware load process.
4. When the loading is complete, choose the Close button to close the 

Firmware Upload dialog.
5. If a non-disruptive activation is not possible, SANbox Manager prompts you 

to reset the switch. Choose the OK button to reset the switch and activate 
the new firmware.

Note: To provide consistent performance throughout the fabric, ensure that 
all switches are running the same version of firmware.

Note: For firmware versions that follow the initial release of version 2.0, you 
have the ability to install and activate new firmware without resetting 
the switch, and therefore, without disrupting traffic. SANbox Manager 
will attempt a non-disruptive firmware installation and activation 
whenever possible.
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4.11.2
Activating the Pending Firmware

To activate firmware that is both inactive and pending, open the Switch menu in 
the faceplate display and select Activate Firmware. SANbox Manager attempts a 
non-disruptive activation if the active and pending firmware versions are 2.0 or 
greater. Otherwise, SANbox Manager prompts you reset the switch to activate the 
pending firmware.

4.11.3
Changing the Pending Firmware

To change the pending firmware to the alternate image, do the following:

1. In the faceplate display, open the Switch menu and select Firmware 
Fallback.

2. The Firmware Fallback dialog prompts you to confirm the firmware version 
that is to become the pending firmware. Choose the Yes button to select the 
fallback firmware or No to cancel.

3. SANbox Manager attempts a non-disruptive activation if the active and 
pending firmware versions are 2.0 or greater. Otherwise, SANbox Manager 
prompts you reset the switch to activate the pending firmware.

4.12
Restoring the Factory Default Configuration

You can restore the switch and port configuration settings to the factory default 
values. To restore the factory configuration on a switch, open the Switch menu 
and select Restore Factory Defaults. Table 4-10 lists the factory default switch 
configuration settings.

Restoring the switch to the factory default configuration does not restore the 
account name and password settings. To restore user accounts, you must select 
Reset Password File option in the maintenance menu. Refer to “Recovering a 
Switch” in the Installation Guide for your switch for information about maintenance 
mode and the maintenance menu.

Table 4-10. Factory Default Configuration Settings 

Setting Value

Symbolic name SANbox2

Administrative state Online

Domain ID 1

Domain ID Lock False

Inband Management True
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Broadcast Support Enable

Resource Allocation Timeout (RA TOV) 10000 milliseconds

Error Detect Timeout (ED TOV) 2000 milliseconds

IP address 10.0.0.1

Subnet mask address 255.0.0.0

Gateway address 10.0.0.254

Network Discovery Static

Remote Logging False

Remote Logging host IP address 10.0.0.254

Contact Undefined

Location Undefined

Trap enabled False

Trap port 162

Trap address Trap 1: 10.0.0.254; Traps 2-5: 0.0.0.0

Trap community Public

Read community Public

Write community Private

Port state Online

Port speed Auto-detect

Port mode GL

Table 4-10. Factory Default Configuration Settings (Continued)

Setting Value
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Section 5
Managing I/O Blades

An I/O blade is a component switch of the larger SANbox2-64 switch. When you 
configure an I/O blade and its ports you are really configuring the slot. Because 
this configuration is saved on the switch CPU, any I/O blade that you install in that 
slot will acquire that configuration. This section describes the following I/O blade 
management tasks:

Displaying I/O blade information
Changing the blade administrative state
Testing a blade
Resetting a blade
Hot Swap Wizard

5.1
Displaying I/O Blade Information

The Blade Information data window displays information for the selected I/O 
blades. To open the Blade Information data window, choose the Blade Info tab 
below the data window in the faceplate display. Table 5-1 describes the Blade 
Information data window entries.

Table 5-1. Blade Information Data Window Entries

Entry Description

State Functional status

Configured Administrative State I/O blade administrative state stored in the 
switch configuration

Operational Administrative State I/O blade operational state: online, offline, 
diagnostics, or down.

Diagnostic Status Results of the most recent diagnostic test

Temperature Status Operational status based on internal 
temperature

Temperature Internal switch temperature reported by 
this I/O blade

Credit Pool Number of credits in the credit pool

Zircon Version Zircon processor firmware version
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5.2
Changing the I/O Blade Administrative State

The I/O blade administrative state determines the operational status of the I/O 
blade and its ports. The I/O blade administrative state exists in two forms: the 
configured administrative state and the current administrative state.

The configured administrative state is the state that is saved in the switch 
configuration and is preserved across switch resets. SANbox Manager 
always makes changes to the configured administrative state.
The current administrative state is the state that is applied to the I/O blade 
for temporary purposes and is not retained across switch resets. The current 
administrative state is set using the Set Blade command. Refer to the ”Set 
Command” on page A-30.

Table 5-2 describes the administrative state values. To change the I/O blade 
administrative state, do the following:

1. Open the faceplate display and click on one or more of the I/O blades.
2. Open the Blade menu and select Blade Properties. Table 5-2 describes the 

administrative state values. In the Blade Properties dialog, choose the radio 
button that corresponds to the state you want, and choose the OK button.

5.3
Testing an I/O Blade

Testing an I/O blade performs a register test of the ASIC and a SerDes level 
loopback test of all ports. To test an I/O blade, do the following:

1. Select an I/O blade.
2. Open the Blade menu and select Blade Properties.
3. Click the Test radio button in the Blade Properties dialog to place the I/O 

blade in test mode. Choose the OK button.
4. Open the Blade menu and select Test Blade.
5. Choose the Start button in the Test Blade dialog.

Table 5-2. Switch Administrative States

Parameter Description

Online The I/O blade is available.

Offline The I/O blade is unavailable.

Diagnostics The I/O blade is in diagnostics mode and is unavailable.
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5.4
Resetting an I/O Blade

Resetting an I/O blade reinitializes the I/O blade using the saved configuration. To 
reset an I/O blade, do the following:

1. Select one or more blades in the faceplate display.
2. Open the Blade menu and select Reset Blade.

5.5
Hot Swap Wizard

The Hot Swap Wizard is a series of dialogs that walk you through the process of 
replacing, removing, or inserting an I/O blade while the switch is running. Each 
type of hot swap procedure uses its own set of dialogs within the Hot Swap 
Wizard. The current step in the hot swap procedure is highlighted in the left side of 
the Hot Swap Wizard dialog.

To start the Hot Swap Wizard, open the Switch menu in the faceplate display, and 
select Hot Swap Wizard. Following is an overview of each of hot swap procedure:

Replacing an I/O Blade
1. Select the Replace a Blade hot swap procedure
2. Select and confirm the slot in which to replace the blade.
3. The Port Status LEDs will flash green to positively identify the I/O 

blade. Remove the I/O blade and confirm.
4. Install the new I/O blade and confirm. The Port Status LEDs will flash 

amber in port number sequence, then green.
Inserting an I/O Blade 
1. Select the Insert a Blade hot swap procedure
2. Select and confirm the slot in which to insert the blade.
3. Install the new I/O blade and confirm. The Port Status LEDs will flash 

amber in port number sequence, then green.

Note: The Hot Swap Wizard is only available to the out-of-band switch. You 
can not use the Hot Swap Wizard over an inter-switch link.
Always perform the hot swap procedure as prompted by the wizard, 
otherwise the switch will become unresponsive. For example, if you 
install a blade in the wrong slot, proceed as though no mistake had 
been made and follow the rest of the hot swap procedure. When 
complete, perform the operation again with the correct slot. If the 
switch becomes unresponsive, you must power cycle the switch.
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Removing an I/O Blade 
1. Select the Remove a Blade hot swap procedure 
2. Select and confirm the slot from which to remove the blade.
3. The Port Status LEDs will flash green to positively identify the I/O 

blade. Remove the I/O blade and confirm.
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Section 6
Managing Ports

This section describes the following tasks that manage ports and devices:

Displaying port information
Configuring ports
Testing ports

6.1
Displaying Port Information

Port information is available primarily in the faceplate display shown in Figure 6-1. 
The faceplate display data windows provide information and statistics for switches 
and ports. Use the topology display to show the status information for links 
between switches.

Figure 6-1.  Faceplate Display – Port Information
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6.1.1
Monitoring Port Status

The faceplate display provides the following port related information:

Port mode
Port operational state
Port speed
Port media

To display port number and status information for a port, position the cursor over a 
port on the faceplate display. The status information changes depending on the 
View menu option selected.

6.1.1.1
Displaying Port Modes

To display port mode status, from the faceplate display, open the View menu, and 
select View Port Modes. Table 6-1 lists the possible port modes and their 
meanings.

Table 6-1. Port Modes

Mode Description

F Fabric port

FL Fabric loop port

TL Translated loop port

G Generic port

GL Generic fabric loop port

E Expansion port (inter-switch link)

D Donor port
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6.1.1.2
Displaying Port Operational States

To display the operational state on each port in the faceplate display, open the 
View menu and select View Port States. Table 6-2 lists the possible operational 
states and their meanings. The port operational state refers to actual port state 
and not the administrative state you may have assigned.

6.1.1.3
Displaying Port Speeds

To display the speed of each port in the faceplate display, open the View menu 
and select View Port Speeds. Table 6-3 lists the possible speeds.

Table 6-2. Port Operational States

State Description

On Online – port is active and ready to send data.

Ia Inactive – port operational state is offline, but administrative state is 
online.

Iso Isolated – E_Port has lost its connection.

Off Offline – port is active, can receive signal, but cannot accept a device 
login.

Tst Diagnostics – port is in diagnostics mode in preparation for testing

Dn Down – the port is inactive or shut off, not receiving a signal, and can’t 
be logged in.

Table 6-3. Port Speeds

State Description

Au Auto-detect

1Gb 1 Gbps transmission speed

2Gb 2 Gbps transmission speed
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6.1.1.4
Displaying Transceiver Media Status

To display transceiver media status, open the View menu and select View Port 
Media. Table 6-2 lists the possible media states and their meanings.

6.1.2
Port Statistics Data Window

The Port Statistics data window displays statistics about port performance. To 
open the Port Statistics window, select one or more ports in the faceplate display 
and choose the Port Stats tab below the data window. Table 6-5 describes the 
Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. When 
viewing baseline statistics, choose the Clear Baseline button to set the current 
baseline.

Table 6-4. Transceiver Media View

Media Icon Description

Optical SFP, Online (Green)

Optical SFP, Offline (Gray)

None Empty port, no transceiver installed

Table 6-5. Port Statistics Data Window Entries 

Entry Description

Start Time The beginning of the period over which the statistics apply. The 
start time for the Absolute view is not applicable. The start time 
for the Rate view is the beginning of polling interval. The start 
time for the Baseline view is the last time the baseline was set.

End Time The last time the statistics were updated on the display.

Total Time Total time period from start time to end time.

Login Count Number of device logins that have occurred on the switch.
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Logout Count Number of device logouts that have occurred on the switch.

Al Init Count Number of times the port entered the initialization state.

Invalid Destination 
Address

Number of address identifier (S_ID, D_ID) errors. AL_PA 
equals 0 on FL_Port or non-zero AL_PA found on F_Port.

Total LIP Received Number of loop initialization primitive frames received.

LIP(f7,f7) Count A loop initialization primitive frame used to acquire an AL_PA.

LIP(f7,f8) Count Currently not used.

LIP(f7,AL_PS) Count This LIP is used to reinitialize the loop. An L_port, identified by 
AL_PS, may have noticed a performance degradation and is 
trying to restore the loop.

LIP(f8,AL_PS) Count This LIP denotes a loop failure detected by the L_port 
identified by AL_PS.

LIP (AL_PD,AL_PS) 
Count

Number of F7, AL_PS LIPs, or AL_PD (vendor specific) resets, 
performed.

AL Init Errors Number of times the port entered initialization and the 
initialization failed. Increments count when port has a sync 
loss.

Class 2 In Frames Number of class 2 frames received by this port.

Class 2 Out Frames Number of class 2 frames transmitted by this port.

Class 2 Words In Number of class 2 words received by this port.

Class 2 Words Out Number of class 2 words transmitted by this port.

Class 3 In Frames Number of class 3 frames received by this port.

Class 3 Out Frames Number of class 3 frames transmitted by this port.

Class 3 Words In Number of class 3 words received by this port.

Class 3 Words Out Number of class 3 words transmitted by this port.

Decode Error Count Number of invalid transmission words detected during 
decoding. Decoding is from the 10-bit characters and special K 
characters.

Loss Of Sync Count Number of synchronization losses (>100 ms) detected by this 
port. A loss of synchronization is detected by receipt of an 
invalid transmission word.

Table 6-5. Port Statistics Data Window Entries (Continued)

Entry Description
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Invalid CRC Count Number of invalid Cyclic Redundancy Check (CRC) frames 
detected.

Tx Wait Count Number of times the port entered a wait state because it didn't 
receive credit to transmit from the attached device.

Class 3 Toss Count Number of class 2 and class 3 sequences that were discarded 
by this port. A sequence can be discarded because of 
detection of a missing frame (based on SEQ_CNT), detection 
of an E_D_TOV timeout, receiving a reject frame, receiving 
frames for a stopped sequence, or other causes.

FReject Count Number of frames, from devices, that have been rejected. 
Frames can be rejected for any of a large number of reasons.

FBusy Count Number of class 2 and class 3 fabric busy (F_BSY) frames 
generated by this port in response to incoming frames. This 
usually indicates a busy condition on the fabric or N_port that 
is preventing delivery of this frame.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization or by loss of signal while not 
in the offline state. A loss of signal causes the switch to 
attempt to re-establish the link. If the link is not re-established, 
a link failure is counted. A link reset is performed after a link 
failure.

Primitive Sequence 
Errors

Number of bad primitives received by the port.

Rx Link Resets Number of link reset primitives received from an attached 
device.

Tx Link Resets Number of link reset primitives sent from this port to an 
attached port.

Rx Offline Sequences Number of offline sequence primitives received by the port.

Tx Offline Sequences Number of offline primitives transmitted by the port.

Total Errors Total number of primitive and non-primitive port link errors.

Total Tx Frames Total number of frames transmitted by the port.

Total Rx Frames Total number of frames received by the port.

Total Tx Words Total number of words transmitted by the port.

Total Rx Words Total number of words received by the port.

Table 6-5. Port Statistics Data Window Entries (Continued)

Entry Description
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6.1.3
Port Information Data Window

The Port Information data window displays port detail information for the selected 
port. To open the Port Information data window, choose the Port Info tab below 
the data window in the faceplate display.

Total Link Resets Number of link-reset primitives the transmitted by the port.

Total Offline 
Sequences

Total number of offline sequences transmitted and received by 
the port.

Flow Error Count Number of times a frame is received and all the switch ports 
receive buffers are full. The normal Fabric Login exchange of 
flow control credit should prevent this from occurring. The 
frame will be discarded.

LP_TOV Timeout 
Count

Number of loop timeouts.

E_Port Connections Number of E_Port logins.

Framing Errors Number of frames that were truncated due to a loss of sync or 
the frame didn't end with an EOF.

Table 6-6. Port Information Data Window Entries 

Entry Description

Port Address Port Fibre Channel address.

Administrative Port Mode The port mode before auto-configuration 
occurs.

Operational Port Mode The current port mode.

Administrative Port State Current port administrative state.

Operational Port State Port operational state: online, offline, 
diagnostics, or down.

Configured Administrative Port State Port administrative state that is stored in 
the switch configuration.

Logged In Indicates whether logged in or not.

E Port Connection Status Whether E_Port connection is enabled.

E Port Isolation Reason Why E_Port is isolated. 

Table 6-5. Port Statistics Data Window Entries (Continued)

Entry Description
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6.1.4
Name Server Data Window

The Name Server data window displays information about the port and the 
connected device. To open the Name Server data window, select one or more 
switches in the topology display and choose the Name Server tab below the data 
window. You can also open the Name Server data window in the faceplate display. 
Refer to Table 4-2 for a description of the Name Server data window entries.

MFS Mode Port tuning indicator.

I/O Stream Guard Whether RSCN suppression is enabled or 
disabled.

Administrative Port Speed The speed requested by the user.

Operational Port Speed The speed actually being used by the port.

BB Credits Whether buffer-to-buffer credits have been 
set.

Symbolic name Port symbolic name

Ext Credits Requested Whether extended credits have been 
requested for ports.

Medium The transceiver type.

Table 6-6. Port Information Data Window Entries (Continued)

Entry Description
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6.2
Configuring Ports

The port settings or characteristics are configured using the Port Properties dialog 
shown in Figure 6-2. To open the Port Properties dialog, select one or more ports, 
open the Port menu and select Port Properties.

Figure 6-2.  Port Properties Dialog

The Port Properties dialog displays the switch name and the selected port(s). Use 
the Port Properties dialog to change the following parameters:

Port state
Port speed
Port mode
Port buffer credits
I/O Stream Guard (RSCN Suppression)
Device scan
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6.2.1
Changing Port Administrative States

The port administrative state determines the operational state of a port. The port 
administrative state exists in two forms: the configured administrative state and 
the current administrative state.

The configured administrative state is the state that is saved in the switch 
configuration and is preserved across switch resets. SANbox Manager 
always makes changes to the configured administrative state.
The current administrative state is the state that is applied to the port for 
temporary purposes and is not preserved across switch resets. The current 
administrative state is set using the Set Port command. Refer to the ”Set 
Port Command” on page A-45.

Table 6-7 describes the port administrative states. To change port administrative 
state, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties to open the Port Properties 

dialog.
3. Choose the Port States radio button that corresponds to the port state you 

want.
4. Choose the OK button to write the new port state to the switch.

Table 6-7. Port Administrative States

State Description

Online Activates and prepares port to send data.

Offline Prevents port from receiving signal and accepting a device login.

Test Prepares port for testing and prevents the port from accepting a 
device login.

Down Disables the port.
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6.2.2
Changing Port Speeds

The SANbox2 switch ports are capable of transmitting and receiving at 1 or 2 
Gbps. The ports can be configured for either transmission speed or to sense the 
transmission speed of the device to which it is connected. Table 6-8 describes the 
port speeds. To change the port speed, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties.
3. Choose the radio button that corresponds to the port speed you want.
4. Choose the Apply button to write the new port speed to the switch.

6.2.3
Changing Port Modes

The SANbox2 switch ports support both public and private devices as single 
devices or in loops. The ports can be configured to self-discover the proper mode 
to match the device or switch to which it is connected. Table 6-9 describes the port 
modes. To change the port mode, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties to open the Port Properties 

dialog.
3. Choose the Port Modes radio button that corresponds to the port mode you 

want.
4. Choose the OK button to write the new port mode to the switch.

Table 6-8. Port Speeds

State Description

Auto-Detect Matches the transmission speed of the connected device. This is the 
default. 

1Gb Sets the transmission speed to 1 Gbps.

2Gb Sets the transmission speed to 2 Gbps.
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6.2.4
Changing Buffer-to-Buffer Credits

SANbox2 switches negotiate with other switches to resolve differences in the 
number of port buffer credits. However, certain non-FC-SW-2-compliant switches 
do not negotiate and will isolate when connected. To remedy this situation, 
disconnect the switches, then reconfigure the SANbox2 E_Port to match the 
number of port buffer credits on the other switch.

To change buffer-to-buffer credits to permit interoperability with non-compliant 
switches, do the following:

1. Determine the number of credits per port for the non-compliant switch:
If the credits per port is equal to 12, stop here – no changes are 
needed.
If the credits per port is less than 12, proceed to step 2.
If the credits per port is greater than 12, you must extend credits for the 
affected SANbox2 port to increase the number of credits to match that 
of the non-standard switch. Refer to ”Extending Port Credits” on 
page 6-13.

Table 6-9. Port Modes

State Description

F_Port Fabric port - Supports a single public device (N_Port).

FL_Port Fabric loop port - Self discovers a single device (N_Port) or a loop of up 
to 126 public devices (NL_Port).

TL_Port Translated loop port - Supports a loop of up to 124 private target devices 
capable of communicating with up to 63 off-loop initiator devices. Refer to 
the installation guide for your switch for more information about TL_Ports.

G_Port Generic port - Self discovers as an F_Port or an E_Port.

GL_Port Generic loop port - Self discovers as an F_Port, FL_Port, or an E_Port. 
GL_Port is the default port mode. A single device on a public loop will 
attempt to configure as an F_Port first, then if that fails, as an FL_Port.

Donor Donor port - Allows buffer credits to be used by another port.

Note: Changing buffer-to-buffer credits is necessary only for E_Ports that are 
connected to non-FC-SW-2-compliant switches. Contact your 
authorized maintenance provider for assistance in using this feature.
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2. Select the SANbox2 switch ports in the faceplate display that are to serve as 
links to the non-compliant switch.

3. Open the Port menu and select Port Properties.
4. In the E_Port BB Credits field, enter the number of credits per port of the 

non-compliant switch and choose the OK button.
5. Connect the switches.

6.2.5
I/O Stream Guard

The I/O Stream Guard feature suppresses the generation of Registered State 
Control Notification (RSCN) messages on a port basis. Choose Enable in the Port 
Properties dialog to suppress the generation of RSCN messages for the selected 
port.

6.2.6
Scan Device

The Device Scan feature queries the connected device during login for FC-4 
descriptor information. Disable this parameter only if the scan creates a conflict 
with the connected device.

6.2.7
Extending Port Credits

Each port is supported by a data buffer with a 12 credit capacity; that is, 12 
maximum sized frames. For fiber optic cables, this enables full bandwidth service 
over a distance of 20 kilometers at 1 Gbps (0.6 credits/Km), or 10 kilometers at 2 
Gbps (1.2 credits/Km). Longer distances can be spanned at full bandwidth by 
borrowing credits from designated donor ports thus pooling the buffer capacities. 
This is called credit extension. Each donor port contributes 11 credits to the pool 
from which the recipient ports can draw. For example, one donor port contributes 
11 credits to the pool from which a recipient draws for a total of 23 credits (11+12). 
This provides approximately 38 Km at 1 Gbps (23÷0.6) or 19 Km at 2 Gbps 
(23÷1.2).

To extend credits, open the Port menu and select Ext Credit Wizard. The 
Extended Credit Wizard leads you through the following process to extend credits 
based on transmission distance requirements:

1. Extended Distance on SANbox2: Explains the concepts and principles of 
extending port credits. Choose Next.

2. Extended Distance Requirements: Specify speed and distance requirements 
for each port then choose Next.
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3. Designate Donor Ports: Select available ports and choose >> to move the 
port into the Selected Donor Port column shown in Figure 6-3. Match the 
number of ports needed with the number of designated donor ports. The port 
receiving the credits and the donor ports must reside on the same I/O blade. 
Choose Next.

Figure 6-3.  Designate Donor Ports

4. Verify Requested Changes: Review the extended distance requests and the 
selected donor ports. Choose Finish.

5. Apply changes: Redistribute credits as requested.
6. Changes complete.

6.2.8
Resetting a Port

The Reset Port option reinitializes the port using the saved configuration. To reset 
a port, do the following:

1. In the Faceplate Display, select the port(s) to be reset.
2. Open the Port menu and select Reset Port.

Note: As credits are used, the Port Status LEDs on the corresponding donor 
ports illuminate continuously. In addition, donor port Activity LEDs will 
reflect the same traffic as the recipient port. Donor ports whose credits 
are being used are unavailable to devices that are connected to them.
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6.3
Testing Ports

The port loopback tests verify correct port operation by sending a frame out 
through the loop, and then verifying that the frame received matches the frame 
that was sent. Only one port can be tested at a time for each type of test. The Port 
Loopback Test dialog shown in Figure 6-4 presents the following loopback tests:

Figure 6-4.  Port Loopback Test Dialog

SerDes level (Internal) - The SerDes level test verifies port circuitry. The 
SerDes level test sends a test frame from the ASIC through the SerDes chip 
and back to the ASIC for the selected ports. The port passes the test if the 
frame that was sent by the ASIC matches the test frame that was received. 
This test requires that the port be in diagnostics mode, and therefore, 
disrupts communication.
SFP level (External) - The SFP level test verifies port circuitry. The SFP 
level test sends a test frame from the ASIC through the SerDes chip, 
through the SFP transceiver fitted with an external loopback plug, and back 
to the ASIC for the selected ports. The port passes the test if the test frame 
that was sent by the ASIC matches the test frame that was received. This 
test requires that the port be in diagnostics mode, and therefore, disrupts 
communication.
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Node-to-Node (Online) - The Node-to-Node test verifies communications 
between the port and its device node or device loop. The port being tested 
must be online and connected to a remote device. The port passes the test if 
the frame that was sent by the ASIC matches the frame that was received. 
This test does not disrupt communication on the selected port. This test 
requires that the port be online, and therefore, does not disrupt 
communication.

To run the internal, external, or online port loopback test on a port, do the 
following:

1. In the faceplate display, select the port to be tested.
2. Open the Port menu and select Port Loopback Test to open the Port 

Loopback Test dialog.
3. In the Test Selection area, choose the radio button for the type of loopback 

test to be run (Internal, External, or Online). If you choose the internal or 
external test, SANbox Manager will prompt you to confirm that the port state 
needs to be changed to the diagnostic state. Choose the OK button and 
SANbox Manager will change the port state.

4. Enter the frame count, frame size, and choose a test pattern radio button. 
You may use the default pattern or enter an 8-digit pattern (hex). For online 
test, you can select the Terminate Test Upon Error check box if you want 
the test to stop should it encounter an error.

5. Choose the Start Test button to begin the test. The Test Results area 
displays the test status, number of frames sent, and number of errors found.

6. To test another port, open the Select Port pull-down menu and select 
another port (number) and test type (Internal, External, or Online) in the Test 
Selection area.

7. Choose the Start Test button to begin the next test. Observe the results in 
the Test Results area.
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Appendix A
Command Line Interface

Each switch contains a Telnet server. This server allows a Telnet client to establish 
a Telnet session with the switch to retrieve information or to configure parameters 
using the Command Line Interface (CLI). The CLI enables you to perform a 
variety of fabric and switch management tasks through an Ethernet or a serial port 
connection.

A.1
Logging On to a Switch

To log on to a switch using Telnet, open a command line window on the 
management workstation and enter the Telnet command followed by the switch IP 
address:

/> telnet 123.45.67.89

A Telnet window opens prompting you for a login. Enter an account name and 
password. Switches come from the factory with the following user account already 
defined:

Account name: admin
Password: password
Authority: Admin

This user account provides full access to the switch and its configuration. After 
planning your fabric management needs and creating your own user accounts, 
consider changing the password for this account. Refer to ”Commands” on 
page A-3 for more information about authority levels. Refer to the ”User 
Command” on page A-79 for information about creating user accounts.

Note: A switch supports a combined maximum of 19 logins reserved as 
follows:

4 sessions for internal applications such as management server 
and SNMP
15 sessions for SANbox Manager inband and out-of-band logins, 
Application Programming Interface (API) inband and out-of-band 
logins and Telnet logins. Of these 15, there can be a combined 
maximum of 10 SANbox Manager and API logins. Additional logins 
will be refused.
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A.2
Command Syntax

The command syntax is as follows:

command
keyword
keyword [value]
keyword [value1] [value2]

The Command is followed by one or more keywords. Consider the following rules 
and conventions:

Commands and keywords are lowercase and case sensitive.
Commands with keywords require one of those keywords.
Required keyword values appear in standard font: [value]. Optional values 
are shown in italics: [value].
Underlined portions of the keyword in the command format indicate the 
abbreviated form that can be used. For example the Delete keyword can be 
abbreviated Del.

A command-line completion feature makes entering and repeating commands 
easier. Table A-1 describes the command-line completion keystrokes.

Table A-1. Command-Line Completion

Keystroke Effect

Tab Completes the command line. Enter at least one character and press 
the tab key to complete the command line. If more than one possibility 
exists, press the Tab key again to display all possibilities.

Up Arrow Scrolls backward through the list of previously entered commands.

Down Arrow Scrolls forward through the list of previously entered commands.

Control-A Moves the cursor to the beginning of the command line

Control-E Moves the cursor to the end of the command line.
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A.3
Commands

The command set provides for User and Admin authority levels.

User authority grants viewing access to the fabric and switches using the 
Show command and other read-only commands.
Admin authority includes the User authority and grants permission to use the 
Admin command. The Admin Start command opens an admin session which 
provides access to the commands that change switch and fabric 
configurations. Refer to the ”Admin Command” on page A-4.

The commands and their page numbers are listed by authority level in Table A-2.

Table A-2. Commands Listed by Authority Level

User Authority Commands Admin Authority Command

Help
History
Ping
Ps
Quit
Show
Show Config
Show Log
Show Perf
Show Setup
Uptime
Whoami

(A-14)
(A-15)
(A-22)
(A-23)
(A-24)
(A-50)
(A-64)
(A-67)
(A-69)
(A-71)
(A-78)
(A-81)

Admin (A-4)

Admin Session Commands

Alias1

Config1

Date1

Fallback
Hardreset
Hotreset
Hotswap
Image
Lip
Passwd
Reset
Set1

Set Config
Set Log
Set Port
Set Setup
Shutdown
Test
User1

Zone1

Zoneset1

Zoning1

1Some keywords are available with User authority.

(A-5) 

(A-7) 

(A-11) 

(A-12)
(A-13)
(A-16)
(A-17)
(A-19)
(A-20)
(A-21)
(A-25)
(A-30) 

(A-32)
(A-42)
(A-45)
(A-46)
(A-74)
(A-75)
(A-79) 

(A-82) 

(A-86) 

(A-89) 
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Admin Command
Opens and closes an Admin session. The Admin session provides commands 
that change the fabric and switch configurations. Only one Admin session can be 
open on the switch at any time. An inactive Admin session will time out after a 
period of time which can be changed using the Set Setup System command. 
Refer to the ”Set Setup Command” on page A-46.

Authority Admin
Syntax admin

start (or begin)
end (or stop)
cancel

Keywords start (or begin)
Opens the admin session.

end (or stop)
Closes the admin session. The Hardreset, Hotreset, Logout, Shutdown, and 
Reset Switch commands will also end an admin session.

cancel
Terminates an Admin session opened by another user. Use this keyword with care 
because it terminates the Admin session without warning the other user and 
without saving pending changes.

Notes Closing a Telnet window during an admin session does not release the session. In 
this case, you must either wait for the admin session to time out, or use the Admin 
Cancel command.

Examples The following example shows how to open and close an Admin session:
SANbox2 #> admin start

SANbox2 (admin) #>

.

.

.

SANbox2 (admin) #> admin end
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Alias Command
Creates a named set of ports/devices. Aliases make it easier to assign a set of 
ports/devices to many zones. An alias can not have a zone or another alias as a 
member.

Authority Admin

Syntax alias
add [alias] [members]
copy [alias_source] [alias_destination]
create [alias]
delete [alias]
list
members [alias]
remove [alias] [members]
rename [alias_old] [alias_new]

Keywords add [alias] [members]
Specifies one or more ports/devices given by [members] to add to the alias named 
[alias]. An alias can have a maximum of 2000 members. [members] can have one 
of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.

The application verifies that the [alias] format is correct, but does not validate that 
such a port/device exists.
copy [alias_source] [alias_destination]
Creates a new alias named [alias_destination] and copies the membership into it 
from the alias given by [alias_source].
create [alias]
Creates an alias with the name given by [alias]. An alias name must begin with a 
letter and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, $, 
^, and -. The zoning database supports a maximum of 256 aliases.
delete [alias]
Deletes the specified alias given by [alias] from the zoning database. If the alias is 
a member of the active zone set, the alias will not be removed from the active 
zone set until the active zone set is deactivated.
list
Displays a list of all aliases. This keyword is valid for User authority and does not 
require a zoning edit session or an admin session. 
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members [alias]
Displays all members of the alias given by [alias]. This keyword is available with 
User authority and does not require a zoning edit session or an admin session.
remove [alias] [members]
Removes the ports/devices given by [members] from the alias given by [alias]. 
[members] can have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) for the device with 
the format xx:xx:xx:xx:xx:xx:xx:xx.

rename [alias_old] [alias_new]
Renames the alias given by [alias_old] to the alias given by [alias_new].
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Config Command
Manages the Fibre Channel configurations on a switch. For information about 
setting the port and switch configurations, refer to the ”Set Config Command” on 
page A-32.

Authority Admin for all keywords except List
Syntax config

activate [config]
backup
cancel
copy [config_source] [config_destination]
delete [config]
edit [config]
list
restore
save [config]

Keywords activate [config]
Activates the configuration given by [config]. If you omit the configuration, the 
currently active configuration is used. Only one configuration can be active at a 
time.
backup
Creates a file named configdata, which contains the system configuration 
information. To download this file, open an FTP session, log in with account name/
password of “images” for both, and type “get configdata”. Refer to Examples.
cancel
Terminates the current configuration edit session without saving changes that 
were made.
copy [config_source] [config_destination]
Copies the configuration given by [config_source] to the configuration given by 
[config_destination]. The switch supports up to 10 configurations including the 
default configuration.
delete [config]
Deletes the specified configuration file where [config] is a file name.
edit [config]
Opens an edit session for the configuration given by [config]. If you omit the 
configuration name, the currently active configuration is used.
list
Displays a list of all available configurations. This keyword is available with User 
authority.
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restore
Restores configuration settings to an out-of-band switch from a backup file named 
configdata, which must be first uploaded on the switch using FTP. You create the 
backup file using the Config Backup command. Use FTP to load the backup file 
on a switch, then enter the Config Restore command. Refer to Examples.

save [config]
Saves changes made during a configuration edit session in the configuration 
given by [config]. If you omit the configuration name value, the configuration you 
chose for the Config Edit command is used. The switch supports up to 10 
configurations including the default configuration.

Notes If you edit the active configuration, changes will be held in suspense until you 
reactivate the configuration or activate another configuration.

Examples The following shows an example of how to open and close a Config Edit session:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

.

.

SANbox2 (admin-config) #> config cancel

  Configuration mode will be canceled. Please confirm (y/n): [n] y

SANbox2 (admin) #> admin end

Note: If the restore process changes the IP address, all management 
sessions are terminated. Use the Set Setup System command to 
return the IP configuration to the values you want. Refer to the ”Set 
Setup Command” on page A-46.
Configuration archive files created with the SANbox Manager 
Archive function are not compatible with the Config Restore 
command.
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The following is an example of how to create a backup file (configdata) and 
download the file to the workstation.
SANbox2 #> admin start

SANbox2 (admin) #> config backup

SANbox2 (admin) #> admin end

SANbox2 #> exit

#>ftp symbolic_name or ip_address

user: images

password: images

ftp> bin

ftp> get configdata

ftp> quit
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The following is an example of how to upload a configuration backup file 
(configdata) from the workstation to the switch, and then restore the configuration.
#> ftp symbolic_name or ip_address

user: images

password: images

ftp> bin

ftp> put configdata

ftp> quit

SANbox2 #> admin start

SANbox2 (admin) #> config restore

The switch will be reset after restoring the configuration.

  Please confirm (y/n): [n] y

  Alarm Msg: [Tue Jun 10 09:25:56.938 2003][A1005.0021][SM][Configuration is being      
restored -  this could take several minutes !]

  Alarm Msg: [Tue Jun 10 09:26:19.266 2003][A1000.000A][SM][The switch will be 
reset in 3 seconds due to a config restore]

SANbox2 (admin) #> 

  Alarm Msg: [Tue Jun 10 09:26:22.296 2003][A1000.0005][SM][The switch is being 
reset]

Good bye.
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Date Command
This command displays or sets the system date and time. To set the date and time 
the information string must be provided in this format: MMDDhhmmCCYY. The 
new date and time takes effect immediately.

Authority Admin to change the date; User to display the date.
Syntax date

[MMDDhhmmCCYY]
Keywords [MMDDhhmmCCYY]

Specifies the date – this requires an admin session. If you omit 
[MMDDhhmmCCYY], the current date is displayed – this is available with User 
authority.

Examples The following is an example of the Date command:
SANbox2 #> date

  Mon Apr 07 07:51:24 2003
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Fallback Command
Assigns the pending firmware status back and forth between the active and 
inactive firmware images stored in switch memory.

Authority Admin
Syntax fallback
Notes The Show Switch command displays the two firmware images, active 

firmware, inactive firmware, and pending firmware versions.
After executing the Fallback command, reset the switch to activate the 
pending firmware. Use the Hotreset command for a non-disruptive 
activation. Otherwise, you can use the Reset Switch command.

Examples The following is an example of the Fallback command:
SANbox2 #> admin start

SANbox2 (admin) #> fallback

  Reverting to previous software image.  Please confirm (y/n): [n] y
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Hardreset Command
Resets the switch and performs a power-on self test. This reset activates the 
pending firmware and disrupts traffic.

Authority Admin
Syntax hardreset
Notes To reset the switch without a power-on self test, refer to the ”Reset Command” on 

page A-25.

To reset the switch without disrupting traffic, refer to the ”Hotreset Command” on 
page A-16.



A – Command Line Interface
Help Command

A-14 59048-02 A

Q

Help Command
Displays a brief description of the specified command and its keywords.

Authority User

Syntax help [command] [keyword]
Keywords [command]

Displays a summary of the command given by [command] and its keywords. If you 
omit [command], the system displays all available commands from which to 
choose.
[keyword]
Displays a summary of the keyword given by [keyword] belonging to the 
command given by [command]. If you omit [keyword], the system displays the 
available keywords for the specified command.
all
Displays a list of all available commands (including command variations).

Examples The following is an example of the Help Set command:
SANbox2 #> help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set alarm

    set beacon

    set blade

    set config blade

    set config port

    set config ports

    set config switch

    set config threshold

    set config zoning

    set log

    set pagebreak

    set port

    set setup snmp

    set setup system

    set switch

The following is an example of the Help Set Beacon command:
SANbox2 #> help set beacon

set beacon On | Off

This command allows the LEDs on the front of the switch to flash.

The On option will start and the Off option will stop the flashing.
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History Command
Displays a numbered list of the previously entered commands from which you can 
re-execute selected commands.

Authority User
Syntax history
Notes Use the History command to provide context for the ! command:

Enter ![command] to re-enter the most recent execution of that command.
Enter ![line number] to re-execute the corresponding command from the 
History display
Enter ![partial command string] to re-execute a command that matches the 
command string.
Enter !! to re-execute the most recent command.

Examples The following is an example of the History command:
SANbox2 #> history

   1 show switch

   2 date

   3 help set

   4 history

SANbox2 #> !3

help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set alarm

    set beacon

    set blade

    set config blade

    set config port

    set config ports

    set config switch

    set config threshold

    set config zoning

    set log

    set pagebreak

    set port

    set setup snmp

    set setup system

    set switch
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Hotreset Command
Resets the switch for the purpose of activating the pending firmware without 
disrupting traffic. This command terminates all management sessions and saves 
all configuration information. After the pending firmware is activated, the 
configuration is recovered. This process takes less than 80 seconds.

Authority Admin
Syntax hotreset
Notes Non-disruptive firmware activation is possible under the following conditions:

The active firmware must be version 2.0 or greater and the new firmware to 
be activated must be a version greater than 2.0.
The fabric must be stable. This means that no configuration changes can be 
in progress, and switch and device connections are not being added or 
removed. Furthermore, a non-disruptive activation cannot occur if any port in 
the fabric is in the diagnostic operational state.

This command clears the event log and all counters.
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Hotswap Command
This command prompts you step-by-step through the procedure to replace an I/O 
blade, insert an I/O blade, or remove an I/O blade while the switch is running.

Authority Admin
Syntax hotswap
Notes The Hotswap command automatically starts and ends an Admin session in the 

presence of admin authority.

Always perform the hot swap procedure as prompted, otherwise the switch will 
become unresponsive. For example, if you install a blade in the wrong slot, 
proceed as though you no mistake had been made and follow the rest of the 
procedures. When complete, perform the operation again with the correct slot. If 
the switch becomes unresponsive, you must power cycle the switch.

After you select an I/O blade to remove and press the Enter key, all Port Status 
LEDs will flash green to identify the selected I/O blade.

After you install an I/O blade and press the Enter key, the Port Status LEDs will 
flash amber in sequence by port number, then the Port Status LEDs will flash 
green.

Examples The following is an example of the Hotswap Replace command:
SANbox2 #> hotswap

This command will guide you through the hotswap process. If this process is not 
followed exactly, then a seamless transition cannot be guaranteed and a switch 
power cycle will be required.

The following procedures may be performed:

1) Replace installed IO blade

2) Insert an IO blade

3) Remove an IO blade

4) Exit this process

Which procedure above do you want to initiate? (1-4): [4]  1

  Blade  Slot

  Type   Number

  -----  ------

  IO-0     1

  IO-1     2

  IO-2     3

  IO-3     4

  IO-4     6

  IO-5     7

  IO-6     8

  IO-7     9

Which IO blade (indexed by slot number) do you want
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to replace? (1,2,3,4,6,7,8,9): [1] 6

    o Remove all connections from the IO blade in slot 6.

    o Remove the IO blade in slot 6 from the chassis.

  Have the above operations been completed? (y = proceed / n = cancel)  y

  Hotswap IO blade removal sub-procedure successfully completed.

  If you wish to continue with the replacement procedure please note

  that after the blade has been successfully inserted:

    o Diagnostics will be performed on the IO blade.

    o The diagnostics results will be posted.

    o The IO blade will be initialized to its configured state.

    o All ports on the blade will be initialized to their configured state.

  Do you want to continue with the replacement procedure? (y=proceed/n=cancel) y

    o Insert the replacement IO blade into the chassis in slot 6.

    o Attach all connections, if any, to the IO blade in slot 6.

  Have the above operations been completed? (y = proceed / n = cancel)  y

  Hotswap IO blade process successfully completed.

  Diagnostics has been run on the IO blade in slot 6: Passed

  WARNING: Multiple alarms were posted during this process.

  Execute the 'show alarm' command to see all alarms.

SANbox2 (admin) #>

  Alarm Msg: [9][Fri Jun 13 01:14:42.468 2003][A3015.0001][SM][I/O blade in slot 6 
has been inserted 
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Image Command
Manages and installs switch firmware.

Authority Admin

Syntax image
cleanup
fetch [account_name] [ip_address] [file_source] [file_destination]
list
unpack [file]

Keywords cleanup
Removes all firmware image files from the switch. All firmware image files are 
removed automatically each time the switch is reset.
fetch [account_name] [ip_address] [file_source] [file_destination]
Retrieves image file given by [file_source] and stores it on the switch with the file 
name given by [file_destination]. The image file is retrieved from the device with 
the IP address given by [ip_address] and an account name given by 
[account_name]. If an account name needs a password to access the device, the 
system will prompt you for it.
list
Displays the list of image files that reside on the switch.
unpack [file]
Installs the firmware file given by [file]. After unpacking the file, a message 
appears confirming successful unpacking. The switch must be reset for the new 
firmware to take effect.

Notes To provide consistent performance throughout the fabric, ensure that all switches 
are running the same version of firmware.

Use the Hotreset command to perform a non-disruptive activation for firmware 
versions that follow version 2.0.
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Lip Command
Reinitializes the specified loop port.

Authority Admin

Syntax lip [port_number]
Keywords [port_number]

The number of the port to be reinitialized.
Examples The following is an example of the Lip command:

SANbox2 (admin) #> lip 2
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Passwd Command
Changes a user account’s password.

Authority Admin to change another account’s password; User to change your own.

Syntax passwd [account_name]
Keywords [account_name]

The user account name. You must open an admin session to change the 
password for an account name other than your own. If you omit [account_name], 
you will be prompted to change the password for the current account name.

Examples The following is an example of the Passwd command:
SANbox2 (admin) #> passwd user2

      Press 'q' and the ENTER key to abort this command.

  account OLD password               :

  account NEW password (4-20 chars)  :

  please confirm account NEW password:

  password has been changed.
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Ping Command
Initiates an attempt to communicate with another switch in the fabric and reports 
the result.

Authority User
Syntax Ping

ip_address
Keywords ip_address

The IP address of the switch to query.

Examples The following is an example of a successful Ping command:
SANbox2 #> ping 10.20.11.57

  Ping command issued. Waiting for response...

SANbox2 #>

  Response successfully received from 10.20.11.57.

This following is an example of an unsuccessful Ping command:
SANbox2 #> ping 10.20.10.100

  Ping command issued. Waiting for response...

  No response from 10.20.10.100. Unreachable.
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Ps Command
Displays current system process information.

Authority User

Syntax ps
Examples The following is an example of the Ps command:

SANbox2 #> ps

PID  PPID %CPU     TIME     ELAPSED COMMAND

338   327  0.0 00:00:00  3-01:18:35 cns

339   327  0.0 00:00:01  3-01:18:35 ens

340   327  0.0 00:00:21  3-01:18:35 dlog

341   327  0.1 00:05:35  3-01:18:35 ds

342   327  0.2 00:11:29  3-01:18:35 mgmtApp

343   327  0.0 00:00:04  3-01:18:35 fc2

344   327  0.0 00:02:16  3-01:18:35 nserver

345   327  0.0 00:02:44  3-01:18:35 mserver

346   327  0.8 00:35:12  3-01:18:35 util

347   327  0.0 00:00:29  3-01:18:35 snmpservicepath

348   327  0.0 00:02:46  3-01:18:34 eport

349   327  0.0 00:00:21  3-01:18:34 PortApp

350   327  5.6 04:08:24  3-01:18:34 port_mon

351   327  0.0 00:01:38  3-01:18:34 zoning

352   327  0.0 00:00:01  3-01:18:34 diagApp

404   327  0.0 00:00:04  3-01:18:27 snmpd

405   327  0.0 00:00:02  3-01:18:27 snmpmain

406   405  0.0 00:00:00  3-01:18:26 snmpmain
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Quit Command
Closes the Telnet session.

Authority User

Syntax quit, exit, or logout
Notes You can also enter Control-D to close the Telnet session.
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Reset Command
Resets the switch configuration parameters. If you omit the keyword, the default is 
Reset Switch.

Authority Admin
Syntax reset

blade [slot_number]
config [config_name]
factory
port [port_number]
snmp
switch (default)
system
zoning

Keywords blade [slot_number]
Resets the I/O or cross-connect blade that occupies the slot given by 
[slot_number]. I/O blade slot numbers are 1–4 and 6–9; cross-connect slot 
numbers are 11–12.
config [config_name]
Resets the configuration given by [config_name] to the factory default values for 
switch, port, alarm threshold, and zoning configuration. If [config_name] does not 
exist on the switch, a configuration with that name will be created. If you omit 
[config_name], the active configuration is reset. You must activate the 
configuration for the changes to take effect. Refer to Table A-3 through Table A-6 
for switch, port, and alarm threshold configuration default values.
factory
Resets switch configuration, port configuration, alarm threshold configuration, 
zoning configuration, SNMP configuration, system configuration, and zoning to 
the factory default values. The switch configuration is activated automatically. 
Refer to Table A-3 through Table A-8.
port [port_number]
Reinitializes the port given by [port_number]. Ports are numbered beginning 
with 0.
snmp
Resets the SNMP configuration settings to the factory default values. Refer to 
Table A-7 for SNMP configuration default values.
switch
Resets the switch without a power-on self test. This reset disrupts traffic and 
activates the pending firmware. This command also closes all management 
sessions. This is the default. To reset the switch with a power-on self test, refer to 
the ”Hardreset Command” on page A-13. To reset the switch without disrupting 
traffic, refer to the ”Hotreset Command” on page A-16.
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system
Resets the system configuration settings to the factory default values. Refer to 
Table A-8 for system configuration default values.
zoning
Clears the zoning database and deactivates the active zone set. The zoning 
configuration values (autosave, default visibility) remain unchanged.

Notes The following tables specify the various factory default settings:

Table A-3. Switch Configuration Defaults

Parameter Default

Admin State Online

Broadcast Enabled True

InbandEnabled True

Domain ID 1 (0x Hex)

Domain ID Lock False

Symbolic Name SANbox2

R_A_TOV 10000

E_D_TOV 2000

Principal Priority 254

Configuration Description QLogic SANbox2 FC Switch

Configuration Last Saved By Initial

Configuration Last Saved On Initial

Table A-4. Port Configuration Defaults 

Parameter Default

Admin State Online

Link Speed Auto

Port Type GL

ISL Security Any

Symbolic Name Port

ALFairness False

DeviceScanEnabled True
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ForceOfflineRSCN False

ARB_FF False

InteropCredit 0

ExtCredit 0

FANEnable True

LCFEnable False

MFSEnable True

MFS_TOV 10

MSEnable True

NoClose False

IOStreamGuard Disabled

VIEnable False

CheckAlps False

Table A-5. Alarm Threshold Configuration Defaults 

Parameter Default

ThresholdMonitoringEnabled False

CRCErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
25
1
10

DecodeErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
200
0
10

ISLMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
2
0
10

Table A-4. Port Configuration Defaults (Continued)

Parameter Default
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LoginMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

LogoutMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

LOSMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
100
5
10

Table A-6. Zoning Configuration Defaults

Parameter Default

FC-SW-2 AutoSave True

Default All

Table A-7. SNMP Configuration Defaults

Parameter Default

Contact <syscontact undefined>

Location <sysLocation undefined>

Description QLogic SANbox2 FC Switch

Trap [1-5] Address Trap 1: 10.0.0.254; Traps 2–5: 0.0.0.0

Trap [1-5] Port 162

Trap [1-5] Severity Warning

Trap [1-5] Version 2

Trap [1-5] Enabled False

ObjectID 1.3.6.1.4.1.1663.1.1.1.1.12

Table A-5. Alarm Threshold Configuration Defaults (Continued)

Parameter Default
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AuthFailureTrap False

ProxyEnabled True

Table A-8. System Configuration Defaults

Parameter Default

Ethernet Network Discovery Static

Ethernet Network IP Address 10.0.0.1

Ethernet Network IP Mask 255.0.0.0

Ethernet Gateway Address 10.0.0.254

Fibre Channel Network Discovery Static

Fibre Channel Network IP Address 0.0.0.0

Fibre Channel Network IP Mask 255.0.0.0

Fibre Channel Gateway Address 10.0.0.254

Admin Timeout 30 minutes

SecurityEnabled False

LocalLogEnabled True

RemotelogEnabled False

RemoteLogHostAddress 10.0.0.254

Temp Monitoring Warning 65

Temp Monitoring Failure 70

Temp Failure Port Shutdown False

Table A-7. SNMP Configuration Defaults

Parameter Default
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Set Command
Sets a variety of switch parameters.

Authority Admin for all keywords except Alarm Clear, Beacon, and Pagebreak which are 
available with User authority.

Syntax set
alarm clear
beacon [state]
blade [slot_number] [state]
config [option]
log [option]
pagebreak [state]
port [option]
setup [option]
switch [state]

Keywords alarm clear
Clears the alarm log. This keyword is available with User authority.
beacon [state]
Enables or disables the flashing of the Port Status LEDs according to [state]. This 
keyword is available with User authority. [state] can be one of the following:

on
Enables the flashing beacon.
off
Disables the flashing beacon.

blade [slot_number] [state]
Temporarily changes the administrative state given by [state] for all ports on the I/
O or cross-connect blade occupying the slot given by [slot_number]. The previous 
Set Config Switch settings are restored after a switch reset or a reactivation of a 
switch configuration. [slot_number] is a number in the ranges 1–4 and 6–9. [state] 
can be one of the following:

online
Places the I/O blade and its ports online.
offline
Places the I/O blade and its ports offline.
diagnostics
Prepares the I/O blade and its ports for testing.
down
Disables the I/O blade and its ports.

config [option]
Sets switch, blade, port, alarm threshold, and zoning configuration parameters. 
Refer to the ”Set Config Command” on page A-32.
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log [option]
Specifies the type of entries to be entered in the event log. Refer to the ”Set Log 
Command” on page A-42.
pagebreak [state]
Specifies how much information is displayed on the screen at a time according to 
the value given by [state]. This keyword is available with User authority. [state] can 
be one of the following:

on
Limits the display of information to 20 lines at a time. The page break 
functions affects the following commands: Alias (List, Members), Show 
(Alarm, Log), Zone (List, Members), Zoneset (List, Zones), Zoning (Active, 
List).
off
Allows continuous display of information without a break.

port [option]
Sets port state and speed for the specified port temporarily until the next switch 
reset or new configuration activation. Refer to the ”Set Port Command” on 
page A-45.
setup [option]
Changes SNMP and system configuration settings. Refer to the ”Set Setup 
Command” on page A-46.
switch [state]
Temporarily changes the administrative state for all ports on the switch to the state 
given by [state]. The previous Set Config Switch settings are restored after a 
switch reset or a reactivation of a switch configuration. [state] can be one of the 
following:

online
Places all ports online
offline
Places all ports offline.
diagnostics
Prepares all ports for testing.

Examples The following examples enables and disables the beacon:
SANbox2 #> set beacon on

  Command succeeded.

SANbox2 $> set beacon off

  Command succeeded.
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Set Config Command
Sets switch, blade, port, alarm threshold, and zoning configuration parameters.

Authority Admin authority and a Config Edit session

Syntax set config
blade [slot_number]
port [port_number]
ports [port_number]
switch
threshold
zoning

Keywords blade [slot_number]
Initiates an edit session in which to change configured administrative state for an 
I/O or cross-connect blade occupying the slot given by [slot_number]. If you omit 
[slot_number], the system begins with slot 1 and proceeds in order through slot 
12. Slots 1–4 and 6–9 are I/O blades; slots 11–12 are cross-connect blades. Enter 
a new value or press the Enter key to accept the current value shown in brackets. 
Enter “q” to end the configuration for one blade, or “qq” to end the configuration for 
all blades.
port [port_number]
Initiates an edit session in which to change configuration parameters for the port 
number given by [port_number]. If you omit [port_number], the system begins with 
port 0 and proceeds in order through the last port. For each parameter, enter a 
new value or press the Enter key to accept the current value shown in brackets. 
Enter “q” to end the configuration for one port, or “qq” to end the configuration for 
all ports. Table A-9 describes the port parameters.
ports [port_number]
Initiates an editing session in which to change configuration parameters for all 
ports based on the configuration for the port given by [port_number]. If you omit 
[port_number], port 0 is used. For each parameter, enter a new value or press the 
Enter key to accept the current value shown in brackets. Enter “q” to end the 
configuration. Table A-9 describes the port parameters.

Table A-9. Set Config Port Parameters 

Parameter Description

AdminState Port administrative state: online, offline, 
diagnostics, or down. The default is online.

LinkSpeed Transmission speed: 1Gb/sec, 2 Gb/sec, 
or Auto. The default is Auto.

PortType Port mode: TL, GL, G, F, FL, Donor. The 
default is GL.
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ISLSecurity E_Port security. Determines which 
switches a port will establish a link with.

Any - link with any FC-SW-2 compliant 
switch. This is the default.
Ours - link only with an FC-SW-2 
compliant QLogic switch.
None - reject the link.

SymbolicPortName Descriptive name. The default is Port.

ALFairness Arbitration loop fairness. Enables (True) or 
disables (False) the switch’s priority to 
arbitrate on the loop. The default is False.

DeviceScanEnabled Enables (True) or disables (False) the 
scanning of the connected device for FC-4 
descriptor information during login. The 
default is True.

ForceOfflineRSCN Enables (False) or disables (True) the 
immediate transmission of RSCN 
messages when communication between 
a port and its device is interrupted. If 
enabled, the RSCN message is queued 
for 200 ms. The default is False. This 
parameter is ignored if IOStreamGuard is 
enabled.

ARB_FF Send ARB_FF (True) instead of IDLEs 
(False) on the loop. The default is False.

InteropCredit Interoperability credit. The number of 
buffer-to-buffer credits per port. 0 means 
the default (12) is unchanged.

ExtCredit Extended credits. The number of port 
buffer credits that this port can acquire 
from donor ports. The default is 0.

FANEnable Fabric address notification. Enables (True) 
or disables (False) the communication of 
the FL_Port address, port name, and node 
name to the logged-in NL_Port. The 
default is True.

Table A-9. Set Config Port Parameters (Continued)

Parameter Description
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LCFEnable Link control frame preference routing. 
Enables (True) or disables (False) 
preferred routing of frames with R_CTL = 
1100 (Class 2 responses). The default is 
False. Enabling LCFEnable will disable 
MFSEnable.

MFSEnable Multi-Frame Sequence bundling. Prevents 
(True) or allows (False) the interleaving of 
frames in a sequence. The default is True. 
Enabling MFSEnable disables LCFEnable 
and VIEnable.

MSEnable Management server enable. Enables 
(True) or disables (False) management 
server on this port. The default is True.

NoClose Loop circuit closure prevention. Enables 
(True) or disables (False) the loop’s ability 
to remain in the open state indefinitely. 
True reduces the amount of arbitration on a 
loop when there is only one device on the 
loop. The default is False.

IOStreamGuard I/O Stream Guard. Enable (Enable) or 
disables (Disable) the suppression of 
RSCN messages. The default is Disable.

VIEnable Enables (True) or disables (False) VI 
preference routing. The default is False. 
Enabling VIEnable will disable 
MFSEnable.

CheckAlps Enables (True) or disables (False) the 
loop’s ability to close more often. Enable 
only for TL_Ports that are having problems 
with a specific device. The default is False.

Table A-9. Set Config Port Parameters (Continued)

Parameter Description
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switch
Initiates an editing session in which to change switch configuration settings. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets.

Table A-10. Set Config Switch Parameters 

Parameter Description

AdminState Switch administrative state: online, offline, 
or diagnostics. The default is Online.

BroadcastEnabled Broadcast. Enables (True) or disables 
(False) forwarding of broadcast frames. 
The default is True.

InbandEnabled Inband management. Enables (True) or 
disables (False) the ability to manage the 
switch over an ISL. The default is True.

DefaultDomainID Default domain ID. The default is 1.

DomainIDLock Prevents (True) or allows (False) dynamic 
reassignment of the domain ID. The 
default is False.

SymbolicName Descriptive name. The default is 
SANbox2.

R_A_TOV Resource Allocation Timeout Value. The 
number of milliseconds the switch waits to 
allow two ports to allocate enough 
resources to establish a link. The default is 
10000.

E_D_TOV Error Detect Timeout Value. The number 
of milliseconds a port is to wait for errors to 
clear. The default is 2000.

PrincipalPriority The priority used in the FC-SW-2 principal 
switch selection algorithm. 1 is high, 255 is 
low. The default is 254.

ConfigDescription The name for the configuration. The 
default is undefined.
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threshold
Initiates a configuration session by which to generate and log alarms for selected 
events. The system displays each event, its thresholds, and sampling interval one 
line at a time and prompts you for a value. For each parameter, enter a new value 
or press the Enter key to accept the current value shown in brackets. These 
parameters must be saved in a configuration and activated before they will take 
effect. Refer to the ”Config Command” on page A-7 for information about saving 
and activating a configuration. Table A-11 describes the Set Config Threshold 
parameters. The switch will down a port if an alarm condition is not cleared within 
three consecutive sampling intervals (by default 30 seconds). Reset the port to 
bring it back online. An alarm is cleared when the threshold monitoring detects 
that the error rate has fallen below the falling threshold.

FC-SW-2 Compliant Propagates just the active zone set 
throughout the fabric (True, compliant) or 
the entire zoning database (False, non-
compliant). The default is True.

LegacyAddressFormat Available only when the FC-SW-2 
Compliant parameter is False, this 
parameter enables (True) or disables 
(False) the use of legacy address 
formatting for interoperating with non-FC-
SW-2 switches. Refer to ”FC-SW-2 
Compliant” on page A-36. The default is 
False.

Table A-11. Set Config Threshold Parameters 

Parameter Description

Threshold Monitoring Enabled Master enable/disable parameter for all events. 
Enables (True) or disables (False) the generation 
of all enabled event alarms. The default is False.

CRCErrorsMonitoringEnabled
DecodeErrorsMonitoringEnabled
ISLMonitoringEnabled
LoginMonitoringEnabled
LogoutMonitoringEnabled
LOSMonitoringEnabled

The event type enable/disable parameter. 
Enables (True) or disables (False) the generation 
of alarms for each of the following events:

CRC errors
Decode errors
ISL connection count
Device login errors
Device logout errors
Loss-of-signal errors

Table A-10. Set Config Switch Parameters (Continued)

Parameter Description
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zoning
Initiates an editing session in which to change switch zoning attributes. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets.

Rising Trigger The event count above which a rising threshold 
alarm is logged. The switch will not generate 
another rising threshold alarm for that event until 
the count descends below the falling threshold 
and again exceeds the rising threshold.

Falling Trigger The event count below which a falling threshold 
alarm is logged. The switch will not generate 
another falling threshold alarm for that event until 
the count exceeds the rising threshold and 
descends again below the falling threshold.

Sample Window The period of time in seconds in which to count 
events.

Table A-12. Set Config Zoning Parameters

Parameter Description

FC-SW-2 AutoSave Available only when the FC-SW-2 
Compliant parameter is True, this 
parameter enables (True) or disables 
(False) the saving of changes to active 
zone set in the switch’s permanent 
memory. Refer to ”FC-SW-2 Compliant” on 
page A-36. The default is True.

Default Enables (All) or disables (None) 
communication among the switch’s ports/
devices and the fabric in the absence of an 
active zone set. The default is All.

Table A-11. Set Config Threshold Parameters (Continued)

Parameter Description
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Examples The following is an example of the Set Config Blade command:
SANbox2-64 108 (admin-config) #> set config blade 1

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the default value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'qq' and the ENTER key to do so.

 

  Configuring Blade in Slot Number:  1

  ---------------------------------

 

  AdminState    (1=Online, 2=Offline, 3=Diagnostics, 4=Down) [Online]

Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.



A – Command Line Interface
Set Config Command

59048-02 A A-39

Q

The following is an example of the Set Config Port command:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config port 1

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  Configuring Port Number:  1

  ------------------------

  AdminState    (1=Online, 2=Offline, 3=Diagnostics, 4=Down)       [Online]

  LinkSpeed     (1=1Gb/s, 2=2Gb/s, 3=Auto)                         [Auto  ]

  PortType      (TL / GL / G / F / FL / Donor)                     [GL    ]

  ISLSecurity   (Any /  Ours / None)                               [Any   ]

  SymPortName   (string, max=32 chars)                             [Port2 ]

  ALFairness    (True / False)                                     [False ]

  DeviceScanEnable (True / False)                                  [True    ]

  ForceOfflineRSCN (True / False)                                  [False   ]

  ARB_FF        (True / False)                                     [False ]

  InteropCredit (decimal value, 0-255)                             [0     ]

  ExtCredit     (dec value, increments of 11, non-loop only)       [0     ]

  FANEnable     (True / False)                                     [True  ]

  LCFEnable     (True / False)                                     [False ]

  MFSEnable     (True / False)                                     [False ]

  MSEnable      (True / False)                                     [True  ]

  NoClose       (True / False)                                     [False ]

  IOStreamGuard (Enable / Disable)                                 [Disable]

  VIEnable      (True / False)                                     [False ]

  CheckAlps     (True / False)                                     [False ]

  

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.
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The following is an example of the Set Config Switch command:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config switch

  A list of attributes with formatting and default values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  AdminState         (1=Online, 2=Offline, 3=Diagnostics) [Online       ]

  BroadcastEnable    (True / False)                       [False        ]

  InbandEnabled      (True / False)                       [False        ]

  DefaultDomainID    (decimal value, 1-239)               [11           ]

  DomainIDLock       (True / False)                       [True         ]

  SymbolicName       (string, max=32 chars)               [SANbox2 switch]

  R_A_TOV            (decimal value, 100-100000 msec)     [10000        ]

  E_D_TOV            (decimal value, 10-20000 msec)       [2000         ]

  PrincipalPriority  (decimal value, 1-255)               [254          ]

  ConfigDescription  (string, max=32 chars)               [             ]

  FC-SW-2 Compliant  (True / False)                       [True         ]

The following is an example of the Set Config Threshold command:
SANbox2 #> admin start

SANbox2  (admin) #> config edit

SANbox2 (admin-config) #> set config threshold

A list of attributes with formatting and current values will follow.

Enter a new value or simply press the ENTER key to accept the current value.

If you wish to terminate this process before reaching the end of the list

press 'q' or 'Q' and the ENTER key to do so.

  

ThresholdMonitoringEnabled     (True / False)              [False]

  

CRCErrorsMonitoringEnabled     (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [25 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

DecodeErrorsMonitoringEnabled  (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [200 ]

  FallingTrigger               (decimal value, 0-1000)     [0 ]
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  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

ISLMonitoringEnabled           (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [2 ]

  FallingTrigger               (decimal value, 0-1000)     [0 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

LoginMonitoringEnabled         (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [5 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

LogoutMonitoringEnabled        (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [5 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

  

LOSMonitoringEnabled           (True / False)               [True]

  RisingTrigger                (decimal value, 1-1000)      [100 ]

  FallingTrigger               (decimal value, 0-1000)      [5 ]

  SampleWindow                 (decimal value, 1-1000 sec)  [10 ]

  

Finished configuring attributes.
This configuration must be saved (see config save command) and
activated (see config activate command) before it can take effect.
To discard this configuration use the config cancel command.

The following is an example of the Set Config Zoning command.
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config zoning

A list of attributes with formatting and current values will follow.

Enter a new value or simply press the ENTER key to accept the current value.

If you wish to terminate this process before reaching the end of the list press 'q' 
or 'Q' and the ENTER key to do so.

  FC-SW-2 AutoSave  (True / False)  [True]

  Default           (All / None)    [All ]

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.
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Set Log Command
Specifies the type of entries to be entered in the event log. The log consists of six 
files contained on the switch: logfile, and logfile.1 – logfile.5. Each file can hold a 
maximum of 200 entries. The switch begins writing entries to logfile. When logfile 
is full, its contents are moved into logfile.1, and logging continues in logfile. When 
logfile.1 is full, its contents are moved into logfile.2, and so on. When logfile.5 
becomes full, its contents are discarded. Log entries are created for ports, 
components, and event severity levels.

Authority Admin
Syntax set log

archive
clear
component [list]
level [level]
port [port_list]
restore
save
start (default)
stop

Keywords archive
Concatenates the individual event log files (logfile, logfile.1, logfile.2, logfile.3, 
logfile.3, logfile.4, logfile.5) and stores the result in new file named logfile that is 
maintained in another part of switch memory where it can be downloaded from the 
switch using FTP. To download logfile, open an FTP session, log in with account 
name/password of “images” for both, and type “get logfile”.
clear
Clears all log entries.
component [list]
Specifies one or more components to monitor for events. Use spaces to delimit 
values in the list. Choose one or more of the following values:

All
Monitors all components. To maintain optimal switch performance, do not 
use this setting with the Level keyword set to Info.
Blade
Monitors modular circuit boards in cabinets, racks, and high-port-count 
switches.
Chassis
Monitors chassis hardware components such as fans and power supplies.
Eport
Monitors all E_Ports.
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Mgmtserver
Monitors management server status.
Nameserver
Monitors name server status.
None
Monitor none of the component events.
Other
Monitors other miscellaneous events.
Port
Monitors all port events
Switch
Monitors switch management events.
Zoning
Monitors zoning conflict events.

level [level]
Specifies the severity level given by [level] to use in monitoring events for the 
specified components or ports. [level] can be one of the following values:

Critical
Monitors critical events.
Warn
Monitors warning events.
Info
Monitors informational events. To maintain optimal switch performance, do 
not use this setting with the Component keyword set to All.
None
Monitors none of the severity levels.

port [port_list]
Specifies one or more ports to monitor for events. Choose one of the following 
values:

[port_list]
Specifies port or ports to monitor. Use spaces to delimit values in the list. 
Ports are numbered beginning with 0.
All
Specifies all ports.
None
Disables monitoring on all ports.

restore
Restores and saves the port, component, and level settings to the default values.
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save
Saves the log settings for the component, level, and port. These settings remain 
in effect after a switch reset. The log settings can be viewed using the Show Log 
Settings command. To export log entries to a file, use the Set Log Archive 
command.
start
Starts the logging of events based on the Port, Component, and Level keywords 
assigned to the current configuration. The logging continues until you enter the 
Set Log Stop command.
stop
Stops logging of events.

Notes To maintain optimal switch performance, do not set the Component keyword to All 
and the Level keyword to Info at the same time.
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Set Port Command
Sets port state and speed for the specified port temporarily until the next switch 
reset or new configuration activation. This command also clears port counters.

Authority Admin
Syntax set port [port_number]

bypass [alpa]
clear 
enable
speed [transmission_speed]
state [state]

Keywords [port_number]
Specifies the port. Ports are numbered beginning with 0.
bypass [alpa]
Sends a Loop Port Bypass (LPB) to a specific Arbitrated Loop Physical Address 
(ALPA) or to all ALPAs on the arbitrated loop. [alpa] can be a specific ALPA or the 
keyword ALL to choose all ALPAs.
clear
Clears the counters on the specified port.
enable
Sends a Loop Port Enable (LPE) to all ALPAs on the arbitrated loop.
speed [transmission_speed]
Specifies the transmission speed for the specified port. Choose one of the 
following port speed values:

1Gb/s
One gigabit per second.
2Gb/s
Two gigabits per second.
Auto
The port speed is automatically detected.

state [state]
Specifies one of the following administrative states for the specified port:

Online
Places the port online.
Offline
Places the port offline.
Diagnostics
Prepares the port for testing.
Down
Disables the port.
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Set Setup Command
Changes SNMP and system configuration settings. The switch maintains one 
SNMP configuration and one system configuration.

Authority Admin
Syntax set setup

snmp
system

Keywords snmp
Prompts you in a line-by-line fashion to change SNMP configuration settings. 
Table A-13 describes the SNMP fields. For each parameter, enter a new value or 
press the Enter key to accept the current value shown in brackets.

Table A-13. SNMP Configuration Settings 

Entry Description

Contact Specifies the name of the person to be contacted to respond to 
trap events. The default is undefined.

Location Specifies the name of the switch location. The default is 
undefined.

Trap [1-5] Address Specifies the workstation IP address to which SNMP traps are 
sent. The default address for trap 1 is 10.0.0.254.  The default 
address for traps 2–5 is 0.0.0.0. Addresses, other than 0.0.0.0, 
for all traps must be unique.

Trap [1-5] Port Specifies the workstation port to which SNMP traps are sent. 
The default is 162.

Trap [1-5] Severity Specifies the severity level to use when monitoring trap events. 
The default is Warning

Trap [1-5] Version Specifies the SNMP version (1 or 2) to use in formatting traps. 
The default is 2.

Trap [1-5] Enabled Specifies whether traps (event information) are enabled or 
disabled (default).

ReadCommunity Read community password that authorizes an SNMP agent to 
read information from the switch. This is a write-only field. The 
value on the switch and the SNMP management server must 
be the same. The default is “public”.

WriteCommunity Write community password that authorizes an SNMP agent to 
write information to the switch. This is a write-only field. The 
value on the switch and the SNMP management server must 
be the same. The default is “private”.
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system
Prompts you in a line-by-line fashion to change system configuration settings. 
Table A-14 describes the system configuration fields. For each parameter, enter a 
new value or press the Enter key to accept the current value shown in brackets.

TrapCommunity Trap community password that authorizes an SNMP agent to 
receive traps. This is a write-only field. The value on the switch 
and the SNMP management server must be the same. The 
default is “public”.

AuthFailureTrap Enables (True) or disables (False) the generation of traps in
response to trap authentication failures. The default is False.

ProxyEnabled Enables (True) or disables (False) SNMP communication with 
other switches in the fabric. The default is True.

Note: Changing the IP address will terminate all Ethernet management 
sessions.

Table A-14. System Configuration Settings 

Entry Description

Eth0NetworkDiscovery Ethernet boot method: 1 - Static, 2 - Bootp, 3 - DHCP, 
4 - RARP. The default is 1 - Static.

Eth0NetworkAddress Ethernet Internet Protocol (IP) address. The default is 
10.0.0.1.

Eth0NetworkMask Ethernet subnet mask address.

Eth0GatewayAddress Ethernet IP address gateway.

FCNetworkDiscovery Fibre Channel boot method: 1 - Static, 3 - DHCP. The 
default is 1 - Static.

FCNetworkAddress Fibre Channel Internet Protocol (IP) address for the 
Ethernet port. The default is 0.0.0.0.

FCNetworkMask Fibre Channel subnet mask address. The default is 
255.0.0.0.

FCGatewayAddress Fibre Channel IP address gateway. The default is 
10.0.0.254.

Table A-13. SNMP Configuration Settings (Continued)

Entry Description
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Examples The following is an example of the Set Setup SNMP command:
SANbox2 #> admin start

SANbox2 (admin) #> set setup snmp

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  Trap Severity Options

  ---------------------

  unknown, emergency, alert, critical, error, warning, notify, info, debug, mark

  Contact             (string, max=32 chars)       [<sysContact undefined]

  Location            (string, max=32 chars)       [sysLocation undefined]

  Trap1Address        (dot-notated IP Address)     [10.20.71.15      ]

  Trap1Port           (decimal value)              [162              ]

  Trap1Severity       (see allowed options above)  [warning          ]

  Trap1Version        (1 / 2)                      [2                ]

  Trap1Enabled        (True / False)               [False            ]

  Trap2Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap2Port           (decimal value)              [162              ]

  Trap2Severity       (see allowed options above)  [warning          ]

  Trap2Version        (1 / 2)                      [2                ]

AdminTimeout Specifies the amount of time in minutes the switch 
waits before terminating an idle Admin session. Zero 
(0) disables the time out threshold. The default is 30, 
the maximum is 1440.

SecurityEnabled Enables (True) or disables (False) the enforcement of 
account names and passwords. The default is False.

LocalLogEnabled Enables (True) or disables (False) the saving of log 
information on the switch. The default is True.

RemoteLogEnabled Enables (True) or disables (False) the recording of 
the switch event log on a remote host that supports 
the syslog protocol. The default is False.

RemoteLogHostAddress The IP address of the host that will receive the switch 
event log information if remote logging is enabled. 
The default is 10.0.0.254.

Table A-14. System Configuration Settings (Continued)

Entry Description
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  Trap2Enabled        (True / False)               [False            ]

  Trap3Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap3Port           (decimal value)              [162              ]

  Trap3Severity       (see allowed options above)  [warning          ]

  Trap3Version        (1 / 2)                      [2                ]

  Trap3Enabled        (True / False)               [False            ]

  Trap4Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap4Port           (decimal value)              [162              ]

  Trap4Severity       (see allowed options above)  [warning          ]

  Trap4Version        (1 / 2)                      [2                ]

  Trap4Enabled        (True / False)               [False            ]

  Trap5Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap5Port           (decimal value)              [162              ]

  Trap5Severity       (see allowed options above)  [warning          ]

  Trap5Version        (1 / 2)                      [2                ]

  Trap5Enabled        (True / False)               [False            ]

  ReadCommunity       (string, max=32 chars)       [public           ]

  WriteCommunity      (string, max=32 chars)       [private          ]

  TrapCommunity       (string, max=32 chars)       [public           ]

  AuthFailureTrap     (True / False)               [False            ]

  ProxyEnabled        (True / False)               [True             ]

The following is an example of the Set Setup System command:
SANbox2 (admin) #> set setup system

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

Eth0NetworkDiscovery    (1=Static, 2=Bootp, 3=Dhcp, 4=Rarp)  [Static       ]

Eth0NetworkAddress      (dot-notated IP Address)             [10.0.0.1     ]

Eth0NetworkMask         (dot-notated IP Address)             [255.255.255.0]

Eth0GatewayAddress      (dot-notated IP Address)             [10.0.0.254   ]

FCNetworkDiscovery      (1=Static, 3=Dhcp)                   [Static       ]

FCNetworkAddress        (dot-notated IP Address)             [0.0.0.0      ]

FCNetworkMask           (dot-notated IP Address)             [255.0.0.0    ]

FCGatewayAddress        (dot-notated IP Address)             [10.0.0.254   ]

AdminTimeout            (dec value 0-1440 minutes, 0=never)  [30           ]

SecurityEnabled         (True / False)                       [False        ]

LocalLogEnabled         (True / False)                       [True         ]

RemoteLogEnabled        (True / False)                       [False        ]

RemoteLogHostAddress    (dot-notated IP Address)             [10.0.0.254   ]
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Show Command
Displays fabric, switch, and port operational information.

Authority User

Syntax show
about
alarm
blade
broadcast
chassis
config [option]
domains
donor
fabric
interface
log [option]
lsdb
mem [count]
ns [option]
pagebreak
panel
perf [option]
port [port_number]
post log
setup [option]
slot [slot_number]
steering [domain_id]
support
switch
topology
users
version

Keywords about
Displays an introductory set of information about operational attributes of the 
switch. This keyword is equivalent to the Version keyword.
alarm
Displays the last 200 alarm entries.
blade
Displays information about the I/O blades and cross-connect modules.
broadcast
Displays the broadcast tree information and all ports that are currently transmitting 
and receiving broadcast frames.
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chassis
Displays chassis component status and temperature.
config [option]
Displays switch, port, and zoning configuration attributes. Refer to the ”Show 
Config Command” on page A-64.
domains
Displays list of each domain and its worldwide name in the fabric.
donor
Displays list of current donor configuration for all ports.
fabric
Displays list of each domain, symbolic name, worldwide name, node IP address, 
and port IP address.
interface
Displays the status of the active network interfaces.
log [option]
Displays log entries. Refer to the ”Show Log Command” on page A-67.
lsdb
Displays Link State database information.
mem [count]
Displays information about memory activity for the number of seconds given by 
[count]. If you omit [count], the value 1 is used. Displayed memory values are in 
1K block units.

ns [option]
Displays name server information for the specified [option]. If you omit [option], 
name server information for the local domain ID is displayed. [option] can have the 
following values:

all
Displays name server information for all switches and ports.
[domain_id]
Displays name server information for the switch given by [domain_id]. 
[domain_id] is a switch domain ID.
[port_id]
Displays name server information for the port given by [port_id]. [port_id] is a 
port Fibre Channel address.

Note: This keyword will display memory activity updates until [count] is 
reached – it cannot be interrupted. Therefore, avoid using large values 
for [count].
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pagebreak
Displays the current pagebreak setting. The pagebreak setting limits the display of 
information to 20 lines (On) or allows the continuous display of information without 
a break (Off).
panel
Displays the hardware configuration and port mapping for a switch. The 
representation of the faceplate indicates power supply modules (PS), I/O blades 
(IO), and CPU module (CPU).
perf [option]
Displays performance information for all ports. Refer to the ”Show Perf Command” 
on page A-69.
port [port_number]
Displays operational information for the port given by [port_number]. Ports are 
numbered beginning with 0. If [port number] is omitted, information is displayed for 
all ports. Table A-15 describes the port parameters.

Table A-15. Show Port Parameters 

Entry Description

AIinit Incremented each time the port begins AL initialization.

AIinitError Number of times the port entered initialization and the 
initialization failed.

Bad Frames Number of frames that have framing errors.

ClassXFramesIn Number of class x frames received by this port.

ClassXFramesOut Number of class x frames sent by this port.

ClassXWordsIn Number of class x words received by this port.

ClassXWordsOut Number of class x words sent by this port.

ClassXToss Number of times an SOFi3 or SOFn3 frame is tossed from 
TBUF.

DecodeError Number of decode errors detected

EpConnects Number of times an E_Port connected through ISL 
negotiation.

FBusy Number of times the switch sent a F_BSY because Class 2 
frame could not be delivered within ED_TOV time. Number of 
class 2 and class 3 fabric busy (F_BSY) frames generated by 
this port in response to incoming frames. This usually 
indicates a busy condition on the fabric or N_Port that is 
preventing delivery of this frame.
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Flowerrors Received a frame when there were no available credits.

FReject Number of frames from devices that were rejected.

InvalidCRC Invalid CRC detected.

InvalidDestAddr Invalid destination address detected.

LIP ALPD ALPS Number of F7, AL_PS LIPs, or AL_PD (vendor specific) 
resets, performed.

LIPF7ALPS This LIP is used to reinitialize the loop. An L_Port, identified 
by AL_PS, may have noticed a performance degradation and 
is trying to restore the loop.

LIPF8ALPS This LIP denotes a loop failure detected by the L_Port 
identified by AL_PS.

LIPF7F7 A loop initialization primitive frame used to acquire a valid 
AL_PA.

LIPF8F7 A loop initialization primitive frame used to indicate that a loop 
failure has been detected at the receiver.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization or by loss of signal while 
not in the offline state. A loss of signal causes the switch to 
attempt to re-establish the link. If the link is not re-established, 
a link failure is counted. A link reset is performed after a link 
failure.

Login Number of device logins

Logout Number of device logouts

LoopTimeouts A two (2) second timeout as specified by FC-AL-2.

LossOfSync Number of synchronization losses (>100 ms) detected by this 
port. A loss of synchronization is detected by receipt of an 
invalid transmission word.

PrimSeqErrors Primitive sequence errors detected.

RxLinkResets Number of link reset primitives received from an attached 
device.

RxOfflineSeq Number of offline sequences received. An OLS is issued for 
link initialization, a Receive & Recognize Not_Operational 
(NOS) state, or to enter the offline state.

TotalErrors Total number of errors detected.

Table A-15. Show Port Parameters (Continued)

Entry Description
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post log
Displays the Power On Self Test (POST) log which contains results from the 
POST.
setup [option]
Displays setup attributes for the system, SNMP, and the switch manufacturer. 
Refer to the ”Show Setup Command” on page A-71.
slot [slot_number]
Displays the hardware attributes for the slot given by [slot_number]. [slot_number] 
can be 0–12. If you omit [slot_number], the hardware configuration for all slots is 
displayed.
steering [domain_id]
Displays the routes that data takes to the switch given by [domain_id]. If you omit 
[domain_id], the system displays routes for all switches in the fabric.
support
Executes a series of commands that display a complete description of the switch, 
its configuration, and operation. The display can be captured from the screen and 
used for diagnosing problems. This keyword is intended for use at the request of 
your authorized maintenance provider. The commands that are executed include 
the following:

TotalLIPsRecvd Number of loop initialization primitive frames received by this 
port.

TotalLIPsXmitd Number of loop initialization primitive frames transmitted by 
this port.

TotalLinkResets Total number of link reset primitives. 

TotalOfflineSeq Total number of Offline Sequences issued by this port. 

TotalRxFrames Total number of frames received by this port.

TotalRxWords Total number of words received by this port.

TotalTxFrames Total number of frames issued by this port.

TotalTxWords Total number of words issued by this port.

TxLinkResets Number of Link Resets issued by this port.

TxOfflineSeq Total number of Offline Sequences issued by this port. 

TxWaits Time waiting to transmit when blocked with no credit. 
Measured in FC Word times.

Table A-15. Show Port Parameters (Continued)

Entry Description
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Alias List
Config List
Date
History
Ps
Show (About, Alarm, Backtrace, Chassis, Config Port, Config Switch, Config 
Threshold, Dev, Dev Settings, Domains, Donor, Fabric, Log, Log Settings, 
Lsdb, Mem, Ns, Perf, Port, Setup Mfg, Setup Snmp, Setup System, 
Steering, Switch, Topology, Users)
Uptime
User Accounts
Whoami
Zoneset (Active, List)
Zoning (History, Limits, List)

switch
Displays switch operational information.
topology
Displays all connected devices.
users
Displays a list of logged-in users. This is equivalent to the User List command.
version
Displays an introductory set of information about operational attributes of the 
switch. This keyword is equivalent to the About keyword.

Examples The following is an example of the Show Blade command:
SANbox2-64 N108 #> show blade

  Blade  Slot   Port  Admin         Oper         Diag         Temp        Credit

  Type   Number Range State         State        Status       Status      Pool

  -----  ------ ----- -----         -----        ------       ------      ------

  IO-0   1       0-7  Online        Online       Compromised  Normal      0

  IO-1   2       8-15 Online        Online       Passed       Normal      0

  IO-2   3      16-23 Online        NotInstalled NotInstalled Normal      0

  IO-3   4      24-31 Online        NotInstalled NotInstalled Normal      0

  IO-4   6      32-39 Online        Online       Compromised  Normal      0

  IO-5   7      40-47 Online        Online       Passed       Normal      0

  IO-6   8      48-55 Online        NotInstalled NotInstalled Normal      0

  IO-7   9      56-63 Online        NotInstalled NotInstalled Normal      0

  CC-0   11       *   Online        Online       Passed       Normal      *

  CC-1   12       *   Online        Online       Passed       Normal      *
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The following is an example of the Show Chassis command:
SANbox2 #> show chassis

    Chassis Information

  -------------------

  FanStatus (1)                     Good

  FanStatus (2)                     Good

  FanStatus (3)                     Good

  PowerSupplyStatus (1)             NotInstalled

  PowerSupplyStatus (2)             NotInstalled

  HeartBeatCode                     1

  HeartBeatStatus                   Normal

  User Ports Map

  --------------

  (displays Non Real-Time data for slot # and blade type-instance)

  SL#0  SL#1  SL#2  SL#3  SL#4  SL#5  SL#6  SL#7  SL#8  SL#9  SL#10

  PS-0  IO-0  IO-1  IO-2  IO-3  CPU-0 IO-4  IO-5  IO-6  IO-7  PS-1

  ------------------------------------------------------------------

   *     0     8     16    24    *     32    40    48    56    *

   *     1     9     17    25    *     33    41    49    57    *

   *     2     10    18    26    *     34    42    50    58    *

   *     3     11    19    27    *     35    43    51    59    *

   *     4     12    20    28    *     36    44    52    60    *

   *     5     13    21    29    *     37    45    53    61    *

   *     6     14    22    30    *     38    46    54    62    *

   *     7     15    23    31    *     39    47    55    63    *

The following is an example of the Show Domains command:
SANbox2 #> show domains

  Principal switch is (remote): 10:00:00:60:69:50:0b:6c

  Upstream Principal ISL is   : 1

  Domain ID List:

        Domain 97  (0x61)  WWN = 10:00:00:c0:dd:00:71:ed

        Domain 98  (0x62)  WWN = 10:00:00:60:df:22:2e:0c

        Domain 99  (0x63)  WWN = 10:00:00:c0:dd:00:72:45

        Domain 100 (0x64)  WWN = 10:00:00:c0:dd:00:ba:68

        Domain 101 (0x65)  WWN = 10:00:00:60:df:22:2e:06

        Domain 102 (0x66)  WWN = 10:00:00:c0:dd:00:90:ef

        Domain 103 (0x67)  WWN = 10:00:00:60:69:50:0b:6c

        Domain 104 (0x68)  WWN = 10:00:00:c0:dd:00:b8:b7
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The following is an example of the Show Fabric command:
SANbox2 #> show fabric

 Domain     WWN                     Enet IP Addr    FC IP Addr      SymbolicName

 ------     ---                     ------------    ----------      ------------

 16 (0x10)  10:00:00:c0:dd:00:77:81 10.20.68.11     0.0.0.0         gui sb1 .11

 17 (0x11)  10:00:00:c0:dd:00:6a:2d 10.20.68.12     0.0.0.0         sw12

 18 (0x12)  10:00:00:c0:dd:00:c3:04 10.20.68.160    0.0.0.0         sw .160

 19 (0x13)  10:00:00:c0:dd:00:bc:56 10.20.68.108    0.0.0.0         Sb2 .108

The following is an example of the Show Panel command:
SANbox2 #> show panel

  User Ports Map

  --------------

  (displays Non Real-Time data for slot # and blade type-instance)

  SL#0  SL#1  SL#2  SL#3  SL#4  SL#5  SL#6  SL#7  SL#8  SL#9  SL#10

  PS-0  IO-0  IO-1  IO-2  IO-3  CPU-0 IO-4  IO-5  IO-6  IO-7  PS-1

  ------------------------------------------------------------------

   *     0     8     16    24    *     32    40    48    56    *

   *     1     9     17    25    *     33    41    49    57    *

   *     2     10    18    26    *     34    42    50    58    *

   *     3     11    19    27    *     35    43    51    59    *

   *     4     12    20    28    *     36    44    52    60    *

   *     5     13    21    29    *     37    45    53    61    *

   *     6     14    22    30    *     38    46    54    62    *

   *     7     15    23    31    *     39    47    55    63    *

The following is an example of the Show NS (local domain) command:
SANbox2 #> show ns

  Seq Domain    Port   Port

  No  ID        ID     Type COS PortWWN                 NodeWWN

  --- ------    ------ ---- --- -------                 -------

  1   19 (0x13) 1301e1 NL   3   21:00:00:20:37:73:13:69 20:00:00:20:37:73:13:69

  2   19 (0x13) 1301e2 NL   3   21:00:00:20:37:73:12:9b 20:00:00:20:37:73:12:9b

  3   19 (0x13) 1301e4 NL   3   21:00:00:20:37:73:05:26 20:00:00:20:37:73:05:26

  4   19 (0x13) 130d00 N    3   21:01:00:e0:8b:27:a7:bc 20:01:00:e0:8b:27:a7:bc
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The following is an example of the Show NS [domain_ID] command:
SANbox2 #> show ns 18

    Seq Domain    Port   Port

  No  ID        ID     Type COS PortWWN                 NodeWWN

  --- ------    ------ ---- --- -------                 -------

  1   18 (0x12) 120700 N    3   21:00:00:e0:8b:07:a7:bc 20:00:00:e0:8b:07:a7:bc

The following is an example of the Show NS [port_ID] command:
SANbox2 #> show ns 1301e1

  Port ID: 1301e1

  --------

  PortType          NL

  PortWWN           21:00:00:20:37:73:13:69

  SymbolicPortName

  NodeWWN           20:00:00:20:37:73:13:69

  SymbolicNodeName

  NodeIPAddress     0.0.0.0

  ClassOfService    3

  PortIPAddress     0.0.0.0

  FabricPortName    20:01:00:c0:dd:00:bc:56

  FC4Type           FCP

  FC4Desc           (NULL)

The following is an example of the Show Interface command:
SANbox2 #> show interface

eth0      Link encap:Ethernet  HWaddr 00:C0:DD:00:BD:ED

          inet addr:10.20.68.107  Bcast:10.20.68.255  Mask:255.255.255.0

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:4712 errors:0 dropped:0 overruns:0 frame:0

          TX packets:3000 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:100

          RX bytes:415313 (405.5 Kb)  TX bytes:716751 (699.9 Kb)

          Interrupt:11 Base address:0xfcc0

lo        Link encap:Local Loopback

          inet addr:127.0.0.1  Mask:255.0.0.0

          UP LOOPBACK RUNNING  MTU:16436  Metric:1

          RX packets:304 errors:0 dropped:0 overruns:0 frame:0

          TX packets:304 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:0

          RX bytes:20116 (19.6 Kb)  TX bytes:20116 (19.6 Kb)
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The following is an example of the Show Port command:
SANbox2 #> show port 1

    Port Number: 1

  ------------

  AdminState       Online              PortID           150100

  AsicNumber       0                   PortWWN          20:01:00:c0:dd:00:bc:b8

  AsicPort         1                   RunningType      Unknown

  ConfigType       G                   SFPPartNumber    Unknown

  DiagStatus       Passed              SFPRevision      0

  EpConnState      None                SFPType          NotInstalled

  EpIsoReason      NotApplicable       SFPVendor        Unknown

  LinkSpeed        2Gb/s               SFPVendorID      00000000

  LinkState        Inactive            SymbolicName     Port1

  LoginStatus      NotLoggedIn         SyncStatus       SyncLost

  MaxCredit        12                  XmitterEnabled   True

  OperationalState Offline

  ALInit          0                      LIP_F8_AL_PS    0

  ALInitError     0                      LIP_F8_F7       0

  BadFrames       0                      LinkFailures    26

  Class2FramesIn  0                      Login           25

  Class2FramesOut 0                      Logout          24

  Class2WordsIn   0                      LoopTimeouts    0

  Class2WordsOut  0                      LossOfSync      1

  Class3FramesIn  0                      PrimSeqErrors   0

  Class3FramesOut 0                      RxLinkResets    23

  Class3Toss      0                      RxOfflineSeq    45

  Class3WordsIn   0                      TotalErrors     26

  Class3WordsOut  0                      TotalLIPsRecvd  0

  DecodeErrors    0                      TotalLIPsXmitd  0

  EpConnects      25                     TotalLinkResets 77

  FBusy           0                      TotalOfflineSeq 59

  FlowErrors      0                      TotalRxFrames   0

  FReject         0                      TotalRxWords    0

  InvalidCRC      0                      TotalTxFrames   0

  InvalidDestAddr 0                      TotalTxWords    0

  LIP_AL_PD_AL_PS 0                      TxLinkResets    54

  LIP_F7_AL_PS    0                      TxOfflineSeq    14

  LIP_F7_F7       0                      TxWaits         222649090
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The following is an example of the Show Slot command:
SANbox2 #> show slot

  Slot   Blade  Port  Blade        Diag          Temp        Credit

  Number Type   Range Status       Status        Status      Pool

  ------ -----  ----- ------       ------        ------      ------

  0      PS-0     *   NotInstalled Passed        Normal      *

  1      IO-0    0-7  Good         Compromised   Normal      0

  2      IO-1    8-15 Good         Passed        Normal      0

  3      IO-2     -   NotInstalled NotInstalled  Normal      0

  4      IO-3     -   NotInstalled NotInstalled  Normal      0

  5      CPU-0    *   Good         Passed        Normal      *

  6      IO-4   32-39 Good         Compromised   Normal      0

  7      IO-5   40-47 Good         Passed        Normal      0

  8      IO-6     -   NotInstalled NotInstalled  Normal      0

  9      IO-7     -   NotInstalled NotInstalled  Normal      0

  10     PS-1     *   NotInstalled Passed        Normal      *

  11     CC-0     *   Good         Passed        Normal      *

  12     CC-1     *   Good         Passed        Normal      *
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The following is an example of the Show Switch command:
  SANbox2 #> show switch

  Switch Information

  ------------------

  SymbolicName                      sw .108

  SwitchWWN                         100000c0dd00bc56

  SwitchType                        SANbox2-64

  PROMVersion                       V2.0.0.0-0 (day month date time year)

  CreditPool                        0

  DomainID                          19 (0x13)

  FirstPortAddress                  130000

  FlashSize - MBytes                128

  LogLevel                          Critical

  MaxPorts                          16

  NumberOfResets                    224

  ReasonForLastReset                PowerUp

  SWImageVersion (1) - build date   V2.0.0.0-17 (day month date time year)

  SWImageVersion (2) - build date   V2.0.0.0-17 (day month date time year)

  ActiveImageVersion - build date   V2.0.0.0-2 (day month date time year)

  PendingImageVersion - build date  V2.0.0.0-17 (day month date time year)

  ActiveConfiguration               default

  AdminState                        Online

  AdminModeActive                   False

  BeaconOnStatus                    False

  OperationalState                  Online

  PrincipalSwitchRole               False

  SwitchDiagnosticsStatus           Passed

The following is an example of the Show Topology command:
SANbox2 #> show topology

Unique ID Key

-------------

A = ALPA,  D = Domain ID,  P = Port ID

Port   Local Local                    Remote  Remote                    Unique

Number Type  PortWWN                  Type    NodeWWN                   ID

------ ----- -------                  ------  -------                   ------

5      F     20:05:00:c0:dd:00:bd:ec   N      20:00:00:00:c9:22:1e:93   010500 P

10     E     20:0a:00:c0:dd:00:bd:ec   E      10:00:00:c0:dd:00:80:21   4(0x4) D 
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The following is an example of the Show Topology command for port 1:
SANbox2  #> show topology 1

  Local Link Information

  ----------------------

  PortNumber 1

  PortID     650100

  PortWWN    20:01:00:c0:dd:00:91:11

  PortType   F

Remote Link Information

----------------------- 

Device 0 

NodeWWN 50:80:02:00:00:06:d5:38

PortType NL

Description (NULL)

IPAddress 0.0.0.0 

Device 1 

NodeWWN 20:00:00:20:37:2b:08:c9

PortType NL

Description (NULL)

IPAddress 0.0.0.0 

Device 2 

Description (NULL)

IPAddress 0.0.0.0

Device 3

NodeWWN 20:00:00:20:37:2b:05:c9

PortType NL

Description (NULL)

IPAddress 0.0.0.0
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The following is an example of the Show Version command:
SANbox2 #> show version

       *****************************************************

       *                                                   *

       *       Command Line Interface SHell  (CLISH)       *

       *                                                   *

       *****************************************************

       SystemDescription  QLogic SANbox2 FC Switch

       Eth0NetworkAddress 10.20.11.192 (use 'set setup system' to update)

       FCNetworkAddress   0.0.0.0 (use 'set setup system' to update)

       MACAddress         00:c0:dd:00:71:ee

       WorldWideName      10:00:00:c0:dd:00:71:ed

       SymbolicName       SB211.192

       ActiveSWVersion    V2.0.0.0-26

       ActiveTimestamp    day month date time year

       DiagnosticsStatus  Passed

       SecurityEnabled    True
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Show Config Command
Displays switch, I/O blade, port, alarm threshold, and zoning attributes for the 
current configuration.

Authority User
Syntax show config

blade [slot_number]
port [port_number]
switch
threshold
zoning

Keywords blade [slot_number]
Displays configuration parameters for the I/O blade or cross-connect blade that 
occupies the slot given by [slot_number]. If you omit [slot_number], the 
configuration parameters for all I/O and cross-connect blades are displayed.
port [port_number]
Displays configuration parameters for the port number given by [port_number]. 
Ports are numbered beginning with 0. If [port_number] is omitted, all ports are 
specified.
switch
Displays configuration parameters for the switch.
threshold
Displays alarm threshold parameters for the switch.
zoning
Displays zoning configuration parameters for the switch.

Examples The following is an example of the Show Config Port command:
SANbox2 #> show config port 3

    Port Number: 3

  ------------

  AdminState         Offline

  LinkSpeed          Auto

  PortType           GL

  ISLSecurity        Any

  SymbolicName       Port3

  ALFairness         False

  DeviceScanEnabled  True

  ForceOfflineRSCN   False

  ARB_FF             False

  InteropCredit      0

  ExtCredit          0

  FANEnabled         True

  LCFEnabled         False
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  MFSEnabled         True

  MSEnabled          True

  NoClose            False

  IOStreamGuard      Disabled

  VIEnabled          False

  CheckAlps          False

The following is an example of the Show Config Switch command:
SANbox2 #> show config switch

  Switch Configuration Information

  --------------------------------

  AdminState            Online

  BroadcastEnabled      False

  InbandEnabled         True

  DomainID              19 (0x13)

  DomainIDLock          True

  SymbolicName          sw108

  R_A_TOV               10000

  E_D_TOV               2000

  PrincipalPriority     254

  ConfigDescription     QLogic SANbox2 FC Switch

  ConfigLastSavedBy     admin@OB-session5

  ConfigLastSavedOn     day month date time year

  FC-SW-2 Compliant     True

  Legacy Address Format False1

The following is an example of the Show Config Threshold command:
  SANbox2 #> show config threshold

  Configuration Name: default

  ------------

  

  Threshold Configuration Information

  -----------------------------------

  ThresholdMonitoringEnabled    False

  CRCErrorsMonitoringEnabled    True

  RisingTrigger                 25

  FallingTrigger                1

  SampleWindow                  10

  DecodeErrorsMonitoringEnabled True

  RisingTrigger                 25

1 Appears only if FC-SW-2 Compliant is False.
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  FallingTrigger                0

  SampleWindow                  10

  ISLMonitoringEnabled          True

  RisingTrigger                 2

  FallingTrigger                0

  SampleWindow                  10

  LoginMonitoringEnabled        True

  RisingTrigger                 5

  FallingTrigger                1

  SampleWindow                  10

  LogoutMonitoringEnabled       True

  RisingTrigger                 5

  FallingTrigger                1

  SampleWindow                  10

  LOSMonitoringEnabled          True

  RisingTrigger                 100

  FallingTrigger                5

  SampleWindow                  10

The following is an example of the Show Config Zoning command:
SANbox2 #> show config zoning

 Configuration Name: default

  -------------------

  Zoning Configuration Information

  --------------------------------

  FC-SW-2 AutoSave      True

  Default               All
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Show Log Command
Displays the contents of the log or the parameters used to create entries in the 
log. The log contains a maximum of 200 entries. When the log reaches its entry 
capacity, subsequent entries overwrite the existing entries, beginning with the 
oldest.

Authority User
Syntax show log

component
level
options
port
settings

Keywords component
Displays the components currently being monitored for events.
level
Displays the event severity level needed to create an entry in the log. If the 
severity level occurs on a port or on a component which is not defined, no entry is 
made in the log.
options
Displays the options used to set the component and log level attributes.
port
Displays the ports being monitored for events. If an event occurs which is of the 
defined level and on a defined component, but not on a defined port, no entry is 
made in the log.
settings
Displays the current settings for component, level and port. This command is 
equivalent to executing the following commands separately: Show Log 
Component, Show Log Level, and Show Log Port.

Examples The following is an example of the Show Log Component command:
SANbox2 #> show log component

  Current setting(s) for log component: NameServer

The following is an example of the Show Log Level command:
SANbox2 #> show log level

  Current settings for log

  ------------------------

  level      Critical
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The following is an example of the Show Log Options command:
SANbox2 #> show log options

  Allowed options for log

  -----------------------

  component  All, None, NameServer, MgmtServer, Zoning, Switch, Chassis, Blade,
              Port, Eport, Snmp, Other,CimServer

  level       Critical,Warn,Info,None

The following is an example of the Show Log command:
   [327][day month date time year][I][Eport Port:0/8][Eport State=
   E_A0_GET_DOMAIN_ID]

   [328][day month date time year][I][Eport Port: 0/8][FSPF PortUp state=0]

   [329][day month date time year][I][Eport Port: 0/8][Sending init hello]

   [330][day month date time year][I][Eport Port: 0/8][Processing EFP, oxid= 0x8]

   [331][day month date time year][I][Eport Port: 0/8][Eport State = E_A2_IDLE]

   [332][day month date time year][I][Eport Port: 0/8][EFP,WWN= 0x100000c0dd00b845,
   len= 0x30]

   [333][day month date time year][I][Eport Port: 0/8][Sending LSU oxid=0xc:type=1]

   [334][day month date time year][I][Eport Port: 0/8][Send Zone Merge Request]

   [335][day month date time year][I][Eport Port: 0/8][LSDB Xchg timer set]

   [336][day month date time year][I][Eport Port: 0/8][Setting attribute
   Oper.UserPort.0.8.EpConnState Connected]
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Show Perf Command
Displays port performance in frames/second and bytes/second. If you omit the 
keyword, the command displays data transmitted (out), data received (in), and 
total data transmitted and received in frames/second and bytes per second.

Authority User
Syntax show perf

byte
inbyte
outbyte [port_number]
frame
inframe
outframe
errors

Keywords byte
Displays continuous performance data in total bytes/second transmitted and 
received for all ports. Type “q” and press the Enter key to stop the display.
inbyte
Displays continuous performance data in bytes/second received for all ports. Type 
“q” and press the Enter key to stop the display.
outbyte [port_number]
Displays continuous performance data in bytes/second transmitted for the set of 
16 ports (0–15, 16–31, ...) that include [port_number]. Type “q” and press the 
Enter key to stop the display.
frame [port_number]
Displays continuous performance data in total frames/second transmitted and 
received for the set of 16 ports that include [port_number]. Type “q” and press the 
Enter key to stop the display.
inframe [port_number]
Displays continuous performance data in frames/second received for the set of 16 
ports that include [port_number]. Type “q” and press the Enter key to stop the 
display.
outframe [port_number]
Displays continuous performance data in frames/second transmitted for the set of 
16 ports that include [port_number]. Type “q” and press the Enter key to stop the 
display.
errors [port_number]
Displays continuous error counts for the set of 16 ports that include [port_number]. 
Type “q” and press the Enter key to stop the display.
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Examples The following is an example of the Show Perf command:
SANbox2 #> show perf 63

  Port   Bytes/s    Bytes/s    Bytes/s    Frames/s   Frames/s   Frames/s

  Number   (in)       (out)    (total)      (in)       (out)    (total)

  ------ -------    -------    -------    --------   --------   --------

  48     0          0          0          0          0          0

  49     0          0          0          0          0          0

  50     0          0          0          0          0          0

  51     0          0          0          0          0          0

  52     0          0          0          0          0          0

  53     0          0          0          0          0          0

  54     0          0          0          0          0          0

  55     0          0          0          0          0          0

  56     0          0          0          0          0          0

  57     0          0          0          0          0          0

  58     0          0          0          0          0          0

  59     0          0          0          0          0          0

  60     47M        23K        47M        23K        726        24K

  61     0          0          0          0          0          0

  62     23K        47M        47M        726        23K        24K

  63     0          0          0          0          0          0

The following is an example of the Show Perf Byte command:
SANbox2 #> show perf byte 63

  Displaying bytes/sec (total)...  (Press 'q' and the ENTER key to stop display)

  48   49   50   51   52   53   54   55   56   57   58   59   60   61   62   63

  --------------------------------------------------------------------------------

  0    0    0    0    0    0    0    0    31M  0    31M  0    46M  0    46M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    46M  0    46M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    46M  0    46M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

  0    0    0    0    0    0    0    0    31M  0    31M  0    47M  0    47M  0

q
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Show Setup Command
Displays the current SNMP and system settings.

Authority User

Syntax show setup
mfg
snmp
system

Keywords mfg
Displays manufacturing information about the switch.
snmp
Displays the current SNMP settings.
system
Displays the current system settings.

Examples The following is an example of the Show Setup Mfg command:
SANbox2 #> show setup mfg

    Manufacturing Information

  -------------------------

  BrandName                QLogic

  BuildDate                Unknown

  ChassisPartNumber        Unknown

  ChassisSerialNumber      022412352

  CPUBoardSerialNumber     022312348

  Slot1BoardSerialNumber   1419000

  Slot2BoardSerialNumber   1419001

  Slot3BoardSerialNumber   1419002

  Slot4BoardSerialNumber   1419003

  Slot6BoardSerialNumber   1419004

  Slot7BoardSerialNumber   1419005

  Slot8BoardSerialNumber   1419006

  Slot9BoardSerialNumber   1419007

  Slot11BoardSerialNumber  1419008

  Slot12BoardSerialNumber  1419009

  MACAddress               00:c0:dd:00:90:e8

  PlanarPartNumber         Unknown

  SwitchSymbolicName       QLogic SANbox2 FC Switch

  SwitchWWN                10:00:00:c0:dd:00:90:e9

  SystemDescription        QLogic SANbox2 FC Switch

  SystemObjectID           1.3.6.1.4.1.1663.1.1.1.1.12
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The following is an example of the Show Setup Snmp command:
SANbox2 #> show setup snmp

  SNMP Information

  ----------------

  Contact               <sysContact undefined>

  Location              N_107 System Test Lab

  Description           QLogic SANbox2 FC Switch

  Trap1Address          10.0.0.254

  Trap1Port             162

  Trap1Severity         warning

  Trap1Version          2

  Trap1Enabled          False

  Trap2Address          0.0.0.0

  Trap2Port             162

  Trap2Severity         warning

  Trap2Version          2

  Trap2Enabled          False

  Trap3Address          0.0.0.0

  Trap3Port             162

  Trap3Severity         warning

  Trap3Version          2

  Trap3Enabled          False

  Trap4Address          0.0.0.0

  Trap4Port             162

  Trap4Severity         warning

  Trap4Version          2

  Trap4Enabled          False

  Trap5Address          0.0.0.0

  Trap5Port             162

  Trap5Severity         warning

  Trap5Version          2

  Trap5Enabled          False

  ObjectID              1.3.6.1.4.1.1663.1.1.1.1.12

  AuthFailureTrap       True

  ProxyEnabled          True
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The following is an example of the Show Setup System command:
SANbox2 #> show setup system

  System Information

  ------------------

  Eth0NetworkDiscovery     Static

  Eth0NetworkAddress       10.20.11.32

  Eth0NetworkMask          255.255.252.0

  Eth0GatewayAddress       10.20.8.254

  FCNetworkDiscovery       Static

  FCNetworkAddress         0.0.0.0

  FCNetworkMask            255.0.0.0

  FCGatewayAddress         10.0.0.254

  AdminTimeout             30

  SecurityEnabled          False

  LocalLogEnabled          True

  RemoteLogEnabled         False

  RemoteLogHostAddress     10.0.0.254
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Shutdown Command
Terminates all data transfers on the switch at convenient points and closes the 
Telnet session. Always power cycle the switch after entering this command.

Authority Admin
Syntax shutdown
Notes Always use this command to perform an orderly shut down before removing 

power from the switch.

When the shutdown is complete, the Heartbeat LED is extinguished.
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Test Command
Tests I/O blades and ports using internal (SerDes level), external (SFP), and 
online loopback tests. Internal and external tests require that the port be placed in 
diagnostic mode. Refer to the ”Set Command” on page A-30 for information about 
changing the I/O blade or port administrative state. While the test is running, the 
remaining ports on the switch remain fully operational.

Authority Admin
Syntax test

blade [slot_number]
port [port_number] [test_type]
cancel
status

Keywords blade [slot_number]
Tests the ASIC registers and performs an internal SerDes test on all ports on the I/
O blade that occupies the slot given by [slot_number]. I/O blade slot numbers are 
1–4 and 6–9. The I/O blade must be in diagnostics mode to perform this test.
port [port_number] [test_type]
Tests the port given by [port_number] using the test given by [test_type]. If you 
omit [test_type], Internal is used. [test_type] can have the following values:

internal 
Tests the SerDes. This is the default. The port must be in diagnostics mode 
to perform this test.
external
Tests both the SerDes and SFP. The port must be in diagnostics mode to 
perform this test, and a loopback plug must be installed in the SFP.
online
Tests one online port.

cancel
Cancels the online test in progress.
status
Displays the status of a test in progress, or if there is no test in progress, the 
status of the test that was executed last.

Examples To run an internal (SerDes) or external (SFP) port test, do the following:

1. To start an admin session, enter the following command and press the Enter 
key.

admin start

2. Place the port in Diagnostics mode, enter the following command (x = port 
number) and press the Enter key.

set port x state diagnostics
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3. Insert the loopback plug into the SFP on the selected port.
4. Choose the type of port loopback test to run:

To run an internal loopback test, enter the following:
test port x internal

To run an external loopback test, enter the following command. A 
loopback plug must be installed for this test to pass. 

test port x external

5. A series of test parameters are displayed on the screen. Press the Enter key 
to accept each default parameter value, or type a new value for each 
parameter and press the Enter key. The TestLength parameter is the 
number of frames sent, the FrameSize (256 byte maximum in some cases) 
parameter is the number of bytes in each frame, and the DataPattern 
parameter is the pattern in the payload.

6. After the test type has been chosen and the command executed, a message 
on the screen will appear detailing the test results.

7. After the test is run, put the port back into online state by entering the 
following command (x = port number) and pressing the Enter key. 

set port x state online

8. To verify port is back online, enter the following command and press the 
Enter key. The contents of the AdminState field should display be “Online”.

show port x

The online loopback (node-to-node) test can test only one port at a time, and that 
port must be online and connected to a remote device. To run the online loopback 
test, do the following:

1. To start an admin session, enter the following command and press the Enter 
key.

admin start

2. To run the online loopback test, enter the following command and press the 
Enter key. 

test port x online
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3. A series of test parameters are displayed on the screen. Press the Enter key 
to accept each default parameter value, or type a new value for each 
parameter and press the Enter key. The TestLength parameter is the 
number of frames sent, the FrameSize (256 byte maximum in some cases) 
parameter is the number of bytes in each frame, and the DataPattern 
parameter is the pattern in the payload. Before running the test, make sure 
that the device attached to the port can handle the test parameters.
SANbox2 (admin) #> test port x online

A list of attributes with formatting and current values will 
follow. Enter a new value or simply press the ENTER key to 
accept the default value. If you wish to terminate this 
process before reaching the end of the list press 'q' or 'Q' 
and the ENTER key to do so.

  TestLength    (decimal value, 1-4294967295)   [100    ]

  FrameSize     (decimal value, 36-2148)        [256    ]

  DataPattern   (32-bit hex value or 'Default') [Default]

  StopOnError   (True/False)                    [False  ]

  Do you want to start the test? (y/n) [n]

4. After all parameter values are defined, press the Y key to start the test. 
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Uptime Command
Displays the elapsed up time since the switch was last reset and reset method. A 
hot reset or non-disruptive firmware activation does not reset the elapsed up time 
reported by this command.

Authority User
Syntax uptime
Examples The following is an example of the Uptime command:

SANbox2 #> uptime

  Elapsed up time  : 0 day(s), 2 hour(s), 28 min(s), 44 sec(s)

  Reason last reset: NormalReset
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User Command
Administers or displays user accounts.

Authority Admin. The List keyword is available with User authority.

Syntax user
accounts
add
delete [account_name]
list

Keywords accounts
Displays all user accounts that exist on the switch.
add
Add a user account to the switch. You will be prompted for an account name, a 
password, authority, and an expiration date.

A switch can have a maximum of 15 user accounts.
Account names are limited to 15 characters; passwords must be 4–20 
characters.
Admin authority grants permission to use the Admin command to open an 
admin session, from which all commands can be entered. Without Admin 
authority, you are limited to view-only commands.
The expiration date is expressed in the number of days until the account 
expires (2000 maximum). The switch will issue an expiration alarm every 
day for seven days prior to expiration.

delete [account_name]
Deletes the account name given by [account_name] from the switch.
list
Displays the list of users currently logged in and their session numbers. Provides 
the same function as the Show Users command. This keyword is valid for User 
authority and does not require an admin session.

Examples The following is an example of the User Accounts command:
SANbox2 (admin) #> user accounts

    Current list of user accounts

  -----------------------------

  images       (admin authority = False, never expires)

  admin        (admin authority = True , never expires)

  chuckca      (admin authority = False, never expires)

  gregj        (admin authority = True , never expires)

  fred         (admin authority = True , never expires)
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The following is an example of the User Add command:
SANbox2 (admin) #> user add

    Press 'q' and the ENTER key to abort this command.

account name (1-15 chars)      : user1

account password (4-20 chars)  :

please confirm account password:

set account expiration in days (0-2000, 0=never): [0] 100

should this account have admin authority? (y/n): [n] y

OK to add user account 'user1' with admin authority

and to expire in 100 days?

Please confirm (y/n): [n] y

The following is an example of the User Delete command:
SANbox2 (admin) #> user del user3

  The user account will be deleted.  Please confirm (y/n): [n] y

The following is an example of the User List command:
SANbox2 (admin) #> user list

    User                           Ethernet Addr-Port    Logged in Since

    ----                           ------------------    ---------------

  admin@OB-session1              10.20.68.108-1031     day month date time year

  admin@OB-session2              10.20.68.108-1034     day month date time year

  snmp@OB-session3               Unknown               day month date time year

  snmp@IB-session4               Unknown               day month date time year

  admin@OB-session5              Unknown               day month date time year



A – Command Line Interface
Whoami Command

59048-02 A A-81

Q

Whoami Command
Displays the account name, session number, and switch domain ID for the Telnet 
session.

Authority User
Syntax whoami
Examples The following is an example of the Whoami command:

SANbox2 #> whoami

User name       : admin@session2

Switch name     : SANbox2

Switch domain ID: 21 (0x15)
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Zone Command
Manages zones and zone membership on a switch. The Zone command defines 
members (ports/devices) for a single switch. Zones are members of zone sets.

Authority Admin authority and a Zoning Edit session. Refer to the ”Zoning Command” on 
page A-89 for information about starting a Zoning Edit session. The List, 
Members, and Zonesets keywords are available with User authority and do not 
require a Zoning Edit session.

Syntax zone
add [zone] [members]
copy [zone_source] [zone_destination]
create [zone]
delete [zone]
list
members [zone]
remove [zone] [members]
rename [zone_old [zone_new]
type [zone] [zone_type]
zonesets [zone]

Keywords add [zone] [members]
Specifies one or more ports/devices given by [members] to add to the zone 
named [zone]. A zone can have a maximum of 256 members. [members] can 
have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.
Alias name

The application verifies that the [members] format is correct, but does not validate 
that such a port exists.
copy [zone_source] [zone_destination]
Creates a new zone named [zone_destination] and copies the membership into it 
from the zone given by [zone_source].
create [zone]
Creates a zone with the name given by [zone]. An zone name must begin with a 
letter and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, $, 
^, and -. The zoning database supports a maximum of 1000 zones.
delete [zone]
Deletes the specified zone given by [zone] from the zoning database. If the zone 
is a member of the active zone set, the zone will not be removed from the active 
zone set until the active zone set is deactivated.
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list
Displays a list of all zones and the zone sets of which they are members. This 
keyword is valid for User authority and does not require a zoning edit session.
members [zone]
Displays all members of the zone given by [zone]. This keyword is available with 
User authority and does not require a Zoning Edit session.
remove [zone] [members]
Removes the ports/devices given by [members] from the zone given by [zone]. 
[members] can have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.
Alias name

rename [zone_old] [zone_new]
Renames the zone given by [zone_old] to the zone given by [zone_new].
type [zone] [zone_type]
Specifies the zone type given by [zone_type] to be assigned to the zone name 
given by [zone]. If you omit the [zone_type], the system displays the zone type for 
the zone given by [zone]. [zone_type] can be one of the following:

soft
Name server zone
hardACL
Access control list hard zone. This keyword is case sensitive.
hardVPF
Virtual private fabric hard zone. This keyword is case sensitive.

zonesets [zone]
Displays all zone sets of which the zone given by [zone] is a member. This 
keyword is available with User authority and does not require a Zoning Edit 
session.
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Examples The following is an example of the Zone List command:
SANbox2 #> zone list

 

  Zone        ZoneSet

  -------------------

  wwn_b0241f

              zone_set_1

 

  wwn_23bd31

              zone_set_1

 

  wwn_221416

              zone_set_1

 

  wwn_2215c3

              zone_set_1

 

  wwn_0160ed

              zone_set_1

 

  wwn_c001b0

              zone_set_1

 

  wwn_401248

              zone_set_1

 

  wwn_02402f

              zone_set_1

 

  wwn_22412f

              zone_set_1

The following is an example of the Zone Members command:
SANbox2 #> zone members wwn_b0241f

  Current List of Members for Zone: wwn_b0241f

  ---------------------------------

  50:06:04:82:bf:d2:18:c2

  50:06:04:82:bf:d2:18:d2

  21:00:00:e0:8b:02:41:2f
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The following is an example of the Zone Zonesets command:
SANbox2 #> zone zonesets zone1

  Current List of ZoneSets for Zone: wwn_b0241f

  ----------------------------------

  zone_set_1 
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Zoneset Command
Manages zone sets and zone set membership across the fabric.

Authority Admin authority and a Zoning Edit session. Refer to the ”Zoning Command” on 
page A-89 for information about starting a Zoning Edit session. The Active, List, 
and Zones keywords are available with User authority. You must close the Zoning 
Edit session before using the Activate and Deactivate keywords.

Syntax zoneset
activate [zone_set]
active
add [zone_set] [zone_list]
copy [zone_set_source] [zone_set_destination]
create [zone_set]
deactivate
delete [zone_set]
list
remove [zone_set] [zone_list]
rename [zone_set_old] [zone_set_new]
zones [zone_set]

Keywords activate [zone_set]
Activates the zone set given by [zone_set]. This keyword deactivates the active 
zone set. Close the Zoning Edit session before using this keyword.
active
Displays the name of the active zone set. This keyword is available with User 
authority and does not require a Zoning Edit session.
add [zone_set] [zone_list]
Adds a list of zones and aliases given by [zone_list] to the zone set given by 
[zone_set]. Zone and alias names are delimited by spaces in [zone_list]. This 
keyword requires a Zoning Edit session.
copy [zone_set_source] [zone_set_destination]
Creates a new zone set named [zone_set_destination] and copies into it the 
membership from the zone set given by [zone_set_source]. This keyword requires 
a Zoning Edit session.
create [zone_set]
Creates the zone set with the name given by [zone_set]. A zone set name must 
begin with a letter and be no longer than 64 characters. Valid characters are 0-9, 
A-Z, a-z, _, $, ^, and -. This keyword requires a Zoning Edit session. The zoning 
database supports a maximum of 256 zone sets.
deactivate
Deactivates the active zone set. Close the Zoning Edit session before using this 
keyword.
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delete [zone_set]
Deletes the zone set given by [zone_set]. If the specified zone set is active, the 
command is suspended until the zone set is deactivated. This keyword requires a 
Zoning Edit session.
list
Displays a list of all zone sets. This keyword is available with User authority and 
does not require a Zoning Edit session.
remove [zone_set] [zone_list]
Removes a list of zones given by [zone_list] from the zone set given by 
[zone_set]. Zone names are delimited by spaces in [zone_list]. If [zone_set] is the 
active zone set, the zone will not be removed until the zone set has been 
deactivated. This keyword requires a Zoning Edit session.
rename [zone_set_old] [zone_set_new]
Renames the zone set given by [zone_set_old] to the name given by 
[zone_set_new]. You can rename the active zone set. This keyword requires a 
Zoning Edit session.
zones [zone_set]
Displays all zones that are members of the zone set given by [zone_set]. This 
keyword is available with User authority and does not need a Zoning Edit session.

Notes A zone set must be active for its definitions to be applied to the fabric.
Only one zone set can be active at one time.
A zone can be a member of more than one zone set.

Examples The following is an example of the Zoneset Active command:
SANbox2 #> zoneset active

  ActiveZoneSet    Bets

  LastActivatedBy  admin@OB-session6

  LastActivatedOn  day month date time year

The following is an example of the Zoneset List command:
SANbox2 #> zoneset list

  Current List of ZoneSets

  ------------------------

  alpha

  beta



A – Command Line Interface
Zoneset Command

A-88 59048-02 A

Q

The following is an example of the Zoneset Zones command:
SANbox2 #> zoneset zones ssss

  Current List of Zones for ZoneSet: ssss

  ----------------------------------

  zone1

  zone2

  zone3
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Zoning Command
Opens a Zoning Edit session in which to create and manage zone sets and zones. 
Refer to the ”Zone Command” on page A-82 and the ”Zoneset Command” on 
page A-86.

Authority Admin. The List keyword is available with User authority.
Syntax zoning

active
cancel
clear
edit
history
limits
list
restore
save

Keywords active
Displays membership information for the active zone set including member zones 
and zone members.
cancel
Closes the current Zoning Edit session. Any unsaved changes are lost.
clear
Clears all inactive zone sets from the volatile edit copy of the zoning database. 
This keyword does not affect the non-volatile zoning database. However, if you 
enter the Zoning Clear command followed by the Zoning Save command, the non-
volatile zoning database will be cleared from the switch.

edit
Opens a Zoning Edit session.
history
Displays a history of zoning modifications including the following:

Time of the most recent zone set activation or deactivation and the user who 
performed it
Time of the most recent modifications to the zoning database and the user 
who made them.
Checksum for the zoning database

Note: The preferred method for clearing the zoning database from the switch 
is the Reset Zoning command.
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limits
Displays the number of zone sets, zones, aliases, members per zone, members 
per alias, and total members in the zoning database. This keyword also displays 
the zoning database limits.
list
Lists all fabric zoning definitions. This keyword is available with User authority.
restore
Reverts the changes to the zoning database that have been made during the 
current Zoning Edit session since the last Zoning Save command was entered.
save
Saves changes made during the current Zoning Edit session. The system will 
inform you that the zone set must be activated to implement any changes. This 
does not apply if you entered the Zoning Clear command during the Zoning Edit 
session.

Examples The following is an example of the Zoning Edit command:
SANbox2 #> admin start

SANbox2  (admin) #> zoning edit

SANbox2  (admin-zoning) #>

.

.

SANbox2  (admin-zoning) #> zoning cancel

  Zoning edit mode will be canceled.  Please confirm (y/n): [n]   y

SANbox2  (admin) #> admin end

The following is an example of the Zoning Limits command:

SANbox2 #> zoning limits

  Zoning Attribute     Maximum   Current   [Name]

  ----------------     -------   -------   ------

  MaxZoneSets          256       6

  MaxZones             256       19

  MaxAliases           256       1

  MaxTotalMembers      6000      166

  MaxZonesInZoneSets   1000      19

  MaxMembersPerZone    2000

                                 10        D_1_JBOD_1

                                 23        D_1_Photons

                                 9         D_2_JBOD1
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                                 16        D_2_NewJBOD_2

                                 5         E1JBOD1

                                 5         E2JBOD2

                                 3         LinkResetZone

                                 3         LinkResetZone2

                                 8         NewJBOD1

                                 8         NewJBOD2

                                 12        Q_1Photon1

                                 12        Q_2Photon2

                                 8         Q_1_NewJBOD1

                                 13        Q_1_Photon_1

                                 8         Q_2_NewJBOD2

                                 13        Q_2_Photon_2

                                 3         ZoneAlias

                                 3         ZoneDomainPort

                                 4         ZoneFCAddr

  MaxMembersPerAlias   2000

                                 2         AliasInAZone

The following is an example of the Zoning List command:
SANbox2 #> zoning list

 

  Active ZoneSet Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3
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                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:c3 

 

  Configured Zoning Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:
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Appendix B
Graphing Port Performance

SANsurfer Fabric View is an optional application that displays port performance 
using graphs. SANsurfer Fabric View plots data communication rates and total 
errors for selected ports as shown in Figure B-1. When graphing data 
communication rates, you can choose either frames/second or KB/second.

Figure B-1.  Fabric View Graphs

This appendix describes how to do the following:

Start SANsurfer Fabric View
Exit SANsurfer Fabric View
Save and Open SANsurfer Fabric View Default Fabric View Files
Change the SANsurfer Fabric View Default Fabric File Password
Set SANsurfer Fabric View preferences
Set the polling frequency
Display graphs
Print graphs
Save graph statistics to a file
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B.1
Starting SANsurfer Fabric View

To start SANsurfer Fabric View from within SANbox Manager, open the topology 
display and select Start Fabric View from the Fabric menu.

B.2
Exiting SANsurfer Fabric View

To exit a SANsurfer Fabric View session, open the File menu and select Exit. If 
you have made changes to the view, the Save Default Fabric File dialog, shown in 
Figure B-2, prompts you to save the view as the default fabric view file. A fabric 
view file contains the set of fabrics that have been added and the graphs that have 
been opened during a SANsurfer Fabric View session. You may also enter a 
password with which to protect the default fabric view file, but a password is not 
required. Refer to ”Changing the SANsurfer Fabric View Default Fabric File 
Password” on page B-4 for information about changing this password. Choose 
one of the following:

Enter a password in the Default File Password field or leave it blank and 
choose the Save View File button. This saves the default fabric view file in 
the working directory.
Choose the Exit Without Saving button to exit the application without 
saving the current fabrics to the default fabric view file.
Choose the Cancel Exit button to cancel the exit operation.

Figure B-2.  Save Default Fabric File – SANsurfer Fabric View
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In your next SANsurfer Fabric View session, the Load Default Fabric File dialog 
shown in Figure B-3 prompts you to load the default fabric view file and to specify 
its password if there is one.

Figure B-3.  Load Default Fabric File – SANsurfer Fabric View

To prevent SANsurfer Fabric View from prompting you to load and save the 
default fabric view file between sessions, set the Auto Load and Save Graphing 
Options setting to Disable (Enable is the default). Refer to ”Setting SANsurfer 
Fabric View Preferences” on page B-4 for more information.

B.3
Saving and Opening SANsurfer Fabric View Fabric View Files

In addition to the SANsurfer Fabric View default fabric view file, you can save and 
open your own fabric view files. The fabric view file contains the set of fabrics, 
graphs, and graphing options. To save a fabric view file, do the following:

1. Open the File menu and select Save View As to open the Save View dialog.
2. Enter a name for the fabric file or choose the Browse button to select an 

existing file. Files are saved in the working directory.
3. Enter a password. When you attempt to open this fabric file, you will be 

prompted for this password. If you leave the File Password field blank, no 
password is required.

To open a fabric view file, do the following:

1. Open the File menu and select Open View File to open the Open View 
dialog.

2. Enter a name for the fabric file or choose the Browse button to select an 
existing file.
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B.4
Changing the SANsurfer Fabric View Default Fabric File Password

To change the password for the default fabric file, do the following:

1. Open the File menu and select Change Default File Password to open the 
Set New Password dialog as shown in Figure B-4.

Figure B-4.  Set New Password – SANsurfer Fabric View Fabric File

2. Enter the new password in the Default File Password field.
3. Re-enter the same password in the Re-enter Password to Confirm field.
4. Choose the OK button to save the changes.

B.5
Setting SANsurfer Fabric View Preferences

To set preferences, open the File menu and select Preferences to open the 
Preferences dialog shown in Figure B-5. Set the following preferences and 
choose the OK button to save the changes:

Change the location of the working directory in which to save files
Change the location of the browser used to view the online help.
Enable or disable the Auto Load and Auto Save Graphing Options 
preference. When enabled, SANsurfer Fabric View prompts you to save and 
load the default fabric file between sessions. Refer to ”Exiting SANsurfer 
Fabric View” on page B-2 for more information on the default fabric view file.

Figure B-5.  Preferences – SANsurfer Fabric View
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B.6
Setting the Polling Frequency

Fabric View updates the graphs once per second by default. To change this 
polling frequency, do the following:

1. Open the Graph menu, and select Set Polling Frequency to open the Set 
Graph Polling Frequency dialog.

2. Enter the new polling interval in seconds [1–60]. Fabric View will update the 
graphs once during the interval.

3. Choose the OK button to save the changes.

B.7
Displaying Graphs

To display graphs, do the following:

1. Open the Fabric menu and select Add Fabric or click the Add button. Enter 
a fabric name and an IP address in the Add a New Fabric window. Include 
an account name and a password if required.

2. Set the graphing options and polling frequency. By default, SANsurfer Fabric 
View plots total bytes transmitted and received at a polling frequency of once 
per second. Refer to ”Customizing Graphs” on page B-6 for information 
about changing what is plotted and how it is plotted.

3. You can display graphs in the following ways:
Click on a switch entry handle and select one or more ports.
Right click on a switch icon in the fabric tree and select Open Graph 
for All Ports on Switch or Open Graph for All Logged-In Ports on 
Switch from the pull-down menu.

4. You can move graphs around individually by clicking and dragging, or you 
can arrange them as a group. Refer to ”Arranging Graphs in the Display” on 
page B-6 for more information.

To remove a graph, click the graph Close button. To remove all graphs, open the 
View menu and select Close All Graphs.

To remove a fabric and its graphs, select the fabric in the fabric tree, then select 
Remove Fabric from the Fabric menu. You can also right click on a fabric and 
select Remove Fabric for the popup menu.

Right clicking on a graph opens a popup menu from which you can change graph 
options, print a graph, or save the graph statistics to a file.
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B.7.1
Arranging Graphs in the Display

To arrange and size graphs in the display, open the Window menu and select 
Cascade, Tile, or Close All.

Cascade overlaps the graphs so that all graphs are at least partially visible.
Tile arranges the graphs in non-overlapping rows and columns.
Close All closes all graphs.

You can also click a graph on the Window menu to bring that graph to the front.

B.7.2
Customizing Graphs

You can customize the graph polling frequency, what is plotted in the graphs, and 
the graph color scheme. To set the polling frequency for all graphs, open the 
Graph menu and select Set Polling Frequency.... Enter an interval in seconds 
(0–60) in the dialog box and choose the OK button.

To choose what is to be plotted, open the Graph menu and select Modify Graph 
Options.... You can also right click on a graph and select Change Graph 
Options. This opens the Default Graph Options dialog shown in Figure B-6.

Figure B-6.  Default Graph Options Dialog
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To modify the graph options, do the following:

1. Choose the units for the graph:
Select the Show Bytes Data on Graph check box to plot data in 
KBytes/second
Select the Show Frames Data on Graph check box to plot data in 
frames/second.

2. Choose what data type to plot. For example, if you selected Show Frames 
Data on Graph in step 1, you can plot one or all of the following:

Total frames transmitted and received (Total Frames)
Total frames transmitted (Total Tx Frames)
Total frames received (Total Rx Frames)

In addition to these, you can also plot total errors by selecting the Total 
Errors check box.

3. Display or hide the unit grid. Select the Display Grid on Graph check box to 
display the unit grid.

4. Choose the color scheme for the graph. You can select the color for each 
data type, the unit grid, and the background by clicking the corresponding 
color field or button. In each case, you can choose a color using the 
swatches, Red-Green-Blue (RGB), or Hue-Saturation-Brightness (HSB) 
method.

Swatches – Click the Swatches tab. Select a swatch from the palette.
HSB – Click the HSB tab. Select a color using any of the following 
methods:

Click in the color palette.
Select the H, S, or B button and use the slide to vary the selected 
value.
Enter values in the H, S, or B input fields.

RGB – Click the RGB tab. Select a color by moving the slides to adjust 
the values for red, blue, and green; or enter values in the input fields.

5. Specify the scope for which the changes are to apply. Choose the 
corresponding radio button to apply changes to all graphs, selected graphs, 
or new graphs.

6. Choose the OK button.

B.8
Printing Graphs

To print a graph, select a graph, then open the File menu and select Print Graph 
Window. You can also right click on a graph and select Print Graph Window 
from the popup menu.
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B.9
Saving Graph Statistics to a File

Statistics for one or all graphs can be saved to a file that can be opened with a 
spreadsheet application. To save a graph statistics file, do the following:

1. Select a graph.
2. Open the File menu, and select Save Current Graph Statistics to a File to 

save the selected graph or select Save All Graph Statistics to a File. You 
can also right click on a graph and select Save Statistics to File.

3. In the Save window, enter a path name for the file. By default, the file is 
saved in the working directory.

4. Choose the Save button.
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Access Control List Zone
Access Control List zoning divides the 
fabric for purposes of controlling discovery 
and inbound traffic.

Active Zone Set
The zone set that defines the current 
zoning for the fabric.

Active Firmware
The firmware image on the switch that is in 
use.

Activity LED
A port LED that indicates when frames are 
entering or leaving the port.

Administrative State
State that determines the operating state 
of the port, I/O blade, or switch. The 
configured administrative state is stored in 
the switch configuration. The configured 
administrative state can be temporarily 
overridden using the command line 
interface.

Alarm
A message generated by the switch that 
specifically requests attention. Alarms are 
generated by several switch processes. 
Some alarms can be configured.

Alias
A named set of ports or devices. An alias 
is not a zone, and can not have a zone or 
another alias as a member.

AL_PA
Arbitrated Loop Physical Address

Arbitrated Loop
A Fibre Channel topology where ports use 
arbitration to establish a point-to-point 
circuit.

Arbitrated Loop Physical Address (AL_PA)
A unique one-byte value assigned during 
loop initialization to each NL_Port on a 
loop.

ASIC
Application Specific Integrated Circuit

Auto Save
Zoning parameter that determines whether 
changes to the active zone set that a 
switch receives from other switches in the 
fabric will be saved to permanent memory 
on that switch.

BootP
A type of network server.

Buffer Credit
A measure of port buffer capacity equal to 
one frame.

Cascade Topology
A fabric in which the switches are 
connected in series. If you connect the last 
switch back to the first switch, you create a 
cascade-with-a-loop topology.

Class 2 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports wit h acknowledgment provided.
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Class 3 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports without acknowledgment.

Configured Zone Sets
The zone sets stored on a switch 
excluding the active zone set.

Default Visibility
Zoning parameter that determines the 
level of communication among ports/
devices when there is no active zone set.

Domain ID
User defined number that identifies the 
switch in the fabric.

Event Log
Log of messages describing events that 
occur in the fabric.

Expansion Port
E_Port that connects to another FC-SW-2 
compliant switch.

Fabric Database
The set of fabrics that have been opened 
during a SANbox Manager session.

Fabric Management Switch
The switch through which the fabric is 
managed.

Fabric Name
User defined name associated with the file 
that contains user list data for the fabric.

Fabric Port
An F_Port or FL_Port.

Fabric View File
A file containing a set of fabrics that were 
opened and saved during a previous 
SANbox Manager session.

Fan Fail LED
An LED that indicates that a cooling fan in 
the switch is operating below standard.

FC-PLDA
Fibre Channel Private Loop Direct Attach

Flash Memory
Memory on the switch that contains the 
chassis control firmware.

Frame
Data unit consisting of a start-of-frame 
(SOF) delimiter, header, data payload, 
CRC, and an end-of-frame (EOF) 
delimiter.

FRU
Field Replaceable Unit

Heartbeat LED
A chassis LED that indicates the status of 
the internal switch processor and the 
results of the Power-On Self-Test.

Inactive Firmware
The firmware image on the switch that is 
not in use.

Inband Management
The ability to manage a switch through 
another switch over an inter-switch link.

Initiator
The device that initiates a data exchange 
with a target device.
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In-Order-Delivery
A feature that requires that frames be 
received in the same order in which they 
were sent.

Input Power LED
A chassis LED that indicates that the 
switch logic circuitry is receiving proper DC 
voltages.

Inter-Switch Link
The connection between two switches 
using E_Ports.

I/O Blade
Fibre Channel component of the 
SANbox2-64 switch.

IP
Internet Protocol

LIP
Loop Initialization Primitive sequence

Logged-In LED
A port LED on SANbox2-8c and SANbox2-
16 switches that indicates device login or 
loop initialization status.

Maintenance Mode
Maintenance mode sets the IP address to 
10.0.0.1 and provides access to the switch 
for maintenance purposes.

Management Information Base
A set of guidelines and definitions for 
SNMP functions.

Management Workstation
PC workstation that manages the fabric 
through the fabric management switch.

Mesh Topology
A fabric in which each chassis has at least 
one port directly connected to each other 
chassis in the fabric.

MIB
Management Information Base

Multistage Topology
A fabric in which two or more edge 
switches connect to one or more core 
switches.

NL_Port
Node Loop Port. A Fibre Channel device 
port that supports arbitrated loop protocol.

N_Port
Node Port. A Fibre Channel device port in 
a point-to-point or fabric connection.

Output Power LED
A power supply LED that indicates that the 
power supply is providing DC voltage to 
the switch. Applies only to SANbox2-16 
and SANbox2-64 switches.

Over Temperature LED
A chassis LED or a power supply LED that 
indicates that the switch or power supply is 
overheating.

Pending Firmware
The firmware image that will be activated 
upon the next switch reset.

Port Status LED
A dual-function port LED on a SANbox2-
64 switch that indicates device login or 
loop initialization status, and port activity.

POST
Power On Self Test



Glossary-4 59048-02 A

SANbox2-64 Switch Management
User’s GuideQ

Power On Self Test (POST)
Diagnostics that the switch chassis 
performs at start up.

Principal Switch
The switch in the fabric that manages 
domain ID assignments.

Private Device
A device that can communicate only with 
other devices on the same loop.

Private Loop
A loop of private devices connected to a 
single switch port.

SANbox Manager
Switch management application.

SFP
Small Form-Factor Pluggable.

Small Form-Factor Pluggable
A transceiver device, smaller than a 
GigaBit Interface Converter, that plugs into 
the Fibre Channel port.

SNMP
Simple Network Management Protocol

Soft Zone
Soft zoning divides the fabric for purposes 
of controlling discovery. Members of the 
same soft zone automatically discover and 
communicate freely with all other 
members of the same zone.

Target
A storage device that responds to an 
initiator device.

Translated Loop Port
A TL_Port supports a loop of up 124 
private target devices with the ability to 
communicate with up to 63 “off-loop” 
public devices.

User Account
An object stored on a switch that consists 
of an account name, password, authority 
level, and expiration date.

VCCI
Voluntary Control Council for Interference

Virtual Private Fabric Zone
Virtual Private Fabric zoning divides the 
fabric for purposes of controlling discovery 
and both inbound and outbound traffic.

Worldwide Name (WWN)
A unique 64-bit address assigned to a 
device by the device manufacturer.

WWN
Worldwide Name

Zone
A set of ports or devices grouped together 
to control the exchange of information.

Zone Set
A set of zones grouped together. The 
active zone set defines the zoning for a 
fabric.

Zoning Database
The set of zone sets, zones, and aliases 
stored on a switch.
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access control list zone 3-15, 3-28
account name 3-1, 3-3, A-1, A-81
active

firmware 4-26
zone set 3-12, 3-16, 4-17

Active Zoneset data window 3-12
Admin authority 3-1, A-3
Admin command A-4
administrative state

blade 5-2, A-30
configured 4-16, 5-2, 6-10
current 4-16, 5-2, 6-10
I/O blade 5-2
port 6-10, A-45
switch 4-16, A-31

alarm
configuration 4-11, A-36
configuration display A-64
log A-30, A-50

alias
add members 3-29, A-5
copy A-5
create 3-28, A-5
delete A-5
delete members A-6
description 3-16
display list A-5
display members A-6
remove 3-29
rename A-6

Alias command A-5
Arbitrated Loop Physical Address A-45
archive configuration 4-23
authentication

trap 4-21
user 3-1

auto save
default fabric view file 2-11
graphing options B-4

zoning configuration 3-17

B
beacon A-30
blade

administrative state 5-2, A-30
configuration A-32
configuration display A-64
description 5-1
display A-50
insert 5-3
numbering 2-22
remove 5-4
replace 5-3
reset 5-3, A-25
selecting 2-23
test A-75

Blade Information data window 5-1
BootP boot method 4-20
broadcast 4-17, A-50
browser

location 2-11, B-4
requirement 2-1

C
CD-ROM drive 2-1
chassis status A-50, A-51
Command Line Interface A-1
command syntax A-2
commands A-3
Config command A-7
configuration

activate A-7
archive 4-23
backup A-7
copy A-7
delete A-7
edit A-7
list A-7
reset A-25
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restore 4-24, A-8
save A-8

configured administrative state 4-16
contact 4-21
CRC error 4-11
credits 6-13
current administrative state 4-16

D
data window

Active Zoneset 3-12
Blade Information 5-1
Configured Zonesets 4-10
description 2-18, 2-21, 2-24
Name Server 4-6, 6-8
port information 6-7
port statistics 6-4
switch 4-6

database
fabric 3-3
zoning 3-20

date 4-13
Date command A-11
Decode error 4-11
default

configuration 4-27
user account 3-1
visibility 3-18, 3-23
zoning 3-18

default fabric view file
auto save 2-11
SANbox Manager 2-11

device
login monitoring 4-11
logout monitoring 4-11
scan 6-13

disk space 2-1
distance 6-13
domain ID

conflict 3-15
description 4-16
lock 4-16

domains A-51

donor port 6-2, 6-12, 6-13, A-51
Dynamic Host Configuration Protocol 4-20

E
E_Port

isolation 3-19, 4-16
self-discovery 6-12

Error Detect Timeout 4-18
Ethernet port 2-1
event browser

display 3-9
filter 3-11
preference 2-11
save to file 3-12
sort 3-12

event logging
by component A-42, A-67
by port A-43, A-67
by severity level A-67
display A-67
restore defaults A-43
save settings A-44
settings A-67
severity level A-43
start A-44
stop A-44

event severity 3-10
expansion port 6-2
external test 6-15, A-75

F
F_Port 6-2, 6-12
fabric

add 3-3
add a switch 3-5
database 3-3
delete 3-4
discovery interval 2-11
displaying information 3-7
loop port 6-2, 6-12
management 3-1
merge 3-18
port 6-2, 6-12



59048-02 A  Index-3

SANbox2-64 Switch Management
User’s Guide Q

rediscovery 3-5
security 3-1
status 3-7
tree 2-17
zoning 3-13

Fabric View
arrange graphs B-6
customize graphs B-6
display graphs B-5
preferences B-4
start B-2

fabric view file B-3
auto save B-4
open 3-4, B-3
password B-2
save 2-10, 3-4

faceplate display
data window 2-24
description 2-12, 2-22
open 2-21
popup menu 2-24

factory defaults 4-27, A-25
Fallback command A-12
FC-4 descriptor 6-13
FC-SW-2 compliance 4-17
firmware

activate pending 4-27
active 4-26
change pending 4-27
fallback 4-27
image file 4-26, A-19
inactive 4-26
install with SANbox Manager 4-26
list image files A-19
non-disruptive activation 4-26, A-16
pending 4-26, A-12
remove image files A-19
retrieve image file A-19
unpack image A-19
version A-55

FL_Port 6-2, 6-12

G
G_Port 6-2
gateway address 4-20
generic

loop port 6-2, 6-12
port 6-2, 6-12

GL_Port 6-2
graphic window 2-18

H
hard reset 4-14
Hardreset command A-13
help 2-12
Help command A-14
History command A-15
hot reset 4-14
Hot Swap Wizard 5-3
Hotreset command A-16
Hotswap command A-17

I
I/O blade

change state 5-2
configuration A-32
description 5-1
display information 5-1
insert 5-3
numbering 2-22
remove 5-4
replace 5-3
reset 5-3, A-25
selecting 2-23
testing 5-2

I/O Steam Guard 6-13
Image command A-19
inactive firmware 4-26
inband management 3-2, 4-17
Initial Start Dialog 2-11
internal test 6-15, A-75
inter-switch link security 3-2
IP

address 4-20
configuration 4-20
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ISL monitoring 4-11

L
layout 2-20
legacy address format 4-18
link

delete 3-7
selecting 2-20
state database A-51
status 2-19

Link data window 4-9
Lip command A-20
log

archive A-42
clear A-42
event A-42, A-67
power-on self test A-54

logged in users A-55
login limit 3-4, A-1
loop port A-20

fabric 6-12
generic 6-2, 6-12
translated 6-12

Loop Port Bypass A-45
Loop Port Enable A-45
loopback test 6-15
loss of signal monitoring 4-11

M
management workstation 2-1
manufacturer information A-71
media status 6-4
memory

activity A-51
workstation 2-1

menu structure 2-13

N
name server

display A-51
export 4-13
zone 3-14

Name Server data window 4-6, 6-8

network
configuration reset A-26
discovery 4-20
interfaces A-51
properties 4-19

node-to-node test 6-16
non-disruptive activation 4-26, 4-27, A-16

O
online

help 2-12
test 6-16

online test A-75
operating systems 2-1
orphan zone set 3-16

P
page break A-31
Passwd command A-21
password

change A-21
default fabric view file 2-10, B-4
switch 3-1, 3-3, A-21
user account 4-4, A-1

pending firmware 4-26, 4-27
performance graphs B-5
Ping command A-22
popup menu 2-21, 2-24
port

administrative state 6-10, A-45
buffer credits 6-12, 6-13
configuration 6-9, A-32
configuration display A-64
counters A-45
displaying information 6-1
donor 6-13
extending credits 6-13
external test A-75
initialize A-25
internal test A-75
loopback test A-75
mode 6-2, 6-11
numbering 2-22
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online test A-75
operational information A-52
operational state 6-3
performance A-52, A-69, B-1
recipient 6-13
reset 6-14
selecting 2-23
speed 6-3, 6-11, A-45
status 2-23
test 6-15
view 2-11, 2-23

Port Information data window 4-9, 6-7
Port Statistics data window 4-9, 6-4
port/device tree 3-20
power on self test log A-54
preferences

Fabric View B-4
SANbox Manager 2-11

principal switch 4-16
processor 2-1
properties

network 4-19
port 6-9

Ps command A-23

Q
Quit command A-24

R
read community 4-21
receive buffer 6-12
recipient port 6-13
refresh 3-7, 4-5
Registered State Control Notification 6-13
remote logging 4-22
reset

with POST 4-14
without POST 4-14

Reset command A-25
Resource Allocation Timeout 4-18
restore configuration 4-24
Reverse Address Resolution Protocol 4-20

S
SANbox Manager

default fabric file 2-8
exit 2-8
preferences 2-11, B-4
starting 2-6
uninstall 2-9
user interface 2-12
version 2-12

SANbox Manager installation
Linux 2-3, 2-5
Solaris 2-4, 2-5
Windows 2-2, 2-5

SANbox2-16 switch 3-8
SANbox2-64 switch 3-8
SANbox2-8c switch 3-8
scan device 6-13
security

fabric 3-1
inband management 3-2
inter-switch link 3-2

SerDes level test 6-15
serial port 2-1
Set command A-30
Set Config command A-32
Set Log command A-42
Set Port command A-45
Set Setup command A-46
severity levels 3-10
SFP level test 6-15
shortcut keys 2-15
Show command A-50
Show Config command A-64
Show Log command A-67
Show Perf command A-69
Show Setup command A-71
Shutdown command A-74
Simple Network Management Protocol

configuration 4-21, A-46
configuration display A-71
proxy 4-21
reset A-25
trap configuration 4-22
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slot number 2-22, A-54
soft zone 3-14, 3-28
static boot method 4-20
status icon color 2-17
steering A-54
subnet mask address 4-20
switch

add 3-5
administrative state 4-16, A-31
configuration 4-14, A-35
configuration display A-64
delete 3-7
displaying information 4-5
hard reset 4-14, A-13
hot reset 4-14
icons 3-8
location 4-21
manufacturer information A-71
operational information A-55
paging 4-13
properties 4-15
replace 3-6
reset A-78
reset without POST 4-14, A-25
restore factory defaults 4-27
selecting 2-20
status 2-19

Switch data window 4-6
symbolic name 4-16
syslog 4-22
system configuration

change A-47
display A-71

T
temperature A-50
Test command A-75
testing

I/O blade 5-2
port loopback 6-15

time 4-13, A-11
timeout values 4-18
TL_Port 6-2, 6-12

tool bar
standard 2-16
zoning 3-21

topology display
arrange icons 2-20
data windows 2-21
description 2-12, 2-19

transceiver status 6-4
translated loop port 6-2, 6-12
transmission speed 6-11
trap

authentication 4-21
community 4-21
configuration 4-22
SNMP version 4-22

U
Uptime command A-78
user

authentication 3-1
authority A-3
logged in A-55

user account
create 4-2
default 4-1
description A-1
password 4-4
remove 4-3

User command A-79

V
version 2-12
View File Auto Save and Load 2-8
virtual private fabric zone 3-15, 3-28

W
Whoami command A-81
working

directory 2-11, B-4
status indicator 2-18

write community 4-21
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Z
zone

access control list 3-15
add member port 3-26, A-82
copy 3-23, A-82
create 3-25, A-82
definition 3-14
delete A-82
delete member port A-83
list A-83
list members A-83
name server 3-14
remove 3-23, 3-27
remove all 3-27
remove member port 3-27
rename 3-27, A-83
soft 3-14
type 3-28, A-83
virtual private fabric 3-15

Zone command A-82
zone merge

description 3-18
failure 3-19
failure recovery 3-19

zone set
activate 3-23, A-86
active 3-12, 3-16, A-89
add member zone A-86
copy A-86
create 3-22, A-86
deactivate 3-23, A-26, A-86
definition 3-16
delete A-87
delete member zone 3-23, A-87
display A-87
display active A-86
display members A-87
display zones A-83
management 3-22
orphan 3-16
remove 3-24
rename 3-27, A-87
tree 3-20

Zoneset command A-86
zoning

configuration 3-17, A-37
configuration display A-64
database 3-16, 3-20, 4-17, A-26
default 3-18
edit A-89
history A-89
limits A-90
list definitions A-90
remove all 3-24
revert changes A-90
save edits A-90

Zoning command A-89
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